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Product notice
This guide describes features that are
common to most models. Some features may
not be available on your computer.
Not all features are available in all editions
of Windows 8. This computer may require
upgraded and/or separately purchased
hardware, drivers, and/or software to take
full advantage of Windows 8 functionality.
See http://www.microsoft.com for details.
Software terms
By installing, copying, downloading, or
otherwise using any software product
preinstalled on this computer, you agree to
be bound by the terms of the HP End User
License Agreement (EULA). If you do not
accept these license terms, your sole remedy
is to return the entire unused product
(hardware and software) within 14 days for
a refund subject to the refund policy of your
place of purchase.
For any further information or to request a
full refund of the computer, please contact
your local point of sale (the seller).

Safety warning notice
WARNING! To reduce the possibility of heat-related injuries or of overheating the device, do not
place the device directly on your lap or obstruct the device air vents. Use the device only on a hard, flat
surface. Do not allow another hard surface, such as an adjoining optional printer, or a soft surface,
such as pillows or rugs or clothing, to block airflow. Also, do not allow the AC adapter to contact
the skin or a soft surface, such as pillows or rugs or clothing, during operation. The device and the AC
adapter comply with the user-accessible surface temperature limits defined by the International
Standard for Safety of Information Technology Equipment (IEC 60950).
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Product description

Product Name
Description

HP EliteBook 725 G2 Notebook PC

HP EliteBook 725 G2
Notebook PC

HP EliteBook 820 G1
Notebook PC

×

HP EliteBook 820 G1 Notebook PC

×

Chipset
Description

AMD® A76M fusion controller hub (FCH)
Intel® processor controller hub (PCH), soldered on circuit
(SoC)

ENWW

HP EliteBook 725 G2
Notebook PC

HP EliteBook 820 G1
Notebook PC

×
×

Product Name

1

Processor
Description

2

●

AMD A10 Pro-7350B 2.10-GHz (SC turbo up to 3.30GHz) quad core processor (4.00-MB L2 cache, 19 W)

●

AMD A8 Pro-7150B 2.00-GHz (SC turbo up to 3.20GHz) quad core processor (4.00-MB L2 cache, 19 W)

●

AMD A6 Pro-7050B 2.20-GHz (SC turbo up to 3.00GHz) dual core processor (1.00-MB L2 cache, 17 W)

●

Intel Core® i7-4600U 2.10-GHz (SC turbo up to 3.30GHz) processor (4.00-MB L3 cache, 15 W)

●

Intel Core i7-4510U 2.00-GHz (SC turbo up to 3.10GHz) processor (4.00-MB L3 cache, 15 W)

●

Intel Core i7-4500U 1.80-GHz (SC turbo up to 3.00GHz) processor (4.00-MB L3 cache, 15 W)

●

Intel Core i5-4310U 2.00-GHz (SC turbo up to 3.00GHz) processor (3.00-MB L3 cache, 15 W

●

Intel Core i5-4300U 1.90-GHz (SC turbo up to 2.90GHz) processor (3.00-MB L3 cache, 15 W)

●

Intel Core i5-4210U 1.70-GHz (SC turbo up to 2.70GHz) processor (3.00-MB L3 cache, 15 W)

●

Intel Core i5-4200U 1.60-GHz (SC turbo up to 2.60GHz) processor (3.00-MB L3 cache, 15 W)

●

Intel Core i3-4030U 1.90-GHz processor (3.00-MB
L3 cache, 15 W)

●

Intel Core i3-4010U 1.70-GHz processor (3.00-MB
L3 cache, 15 W)
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HP EliteBook 725 G2
Notebook PC

HP EliteBook 820 G1
Notebook PC

×

×
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Panel
Description

●

12.5-in, Premium AntiGlare (AG), full high-definition
(FHD), light-emitting diode (LED), 1920×1080, UWVA,
typical brightness: 300 nits, ultraslim (1.2-mm), 50% CG,
eDP display panel with and without webcam

●

12.5-in, AG, HD, LED, 1366×768, SVA, typical
brightness: 200 nits, ultraslim (1.2-mm), 45% CG, eDP
display panel with and without webcam

●

12.5-in, Premium AntiGlare (AG), high-definition HD,
light-emitting diode (LED), 1366×768, UWVA, typical
brightness: 300 nits, ultraslim (1.2-mm), 50% CG, eDP
display panel with and without webcam

●

12.5-in, AG, HD, LED, 1366×768, SVA, typical
brightness: 200 nits, ultraslim (1.2-mm), 45% CG, eDP
display panel with and without webcam

HP EliteBook 725 G2
Notebook PC

HP EliteBook 820 G1
Notebook PC

×

×

Graphics
Description

AMD Graphics: Radeon® R6 Graphics on computer models
equipped with an A10 Pro-7350B processor; Radeon R5
Graphics on computer models equipped with an
A8 Pro-7150B processor; Radeon R4 Graphics on computer
models equipped with an A6 Pro-7050B processor

HP EliteBook 725 G2
Notebook PC

HP EliteBook 820 G1
Notebook PC

×

Universal memory architecture (UMA) graphics
Support for dual-display ports through the HP 2013 UltraSlim
Docking Station
Support for up to 3 displays through the HP 2013 UltraSlim
Docking Station
Intel Graphics: Intel HD Graphics 4400

×

UMA graphics
Support for up to 3 displays through the HP 2013 UltraSlim
Docking Station
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Memory
Description

Two customer-accessible/upgradable memory module slots

HP EliteBook 725 G2
Notebook PC

HP EliteBook 820 G1
Notebook PC

×

×

HP EliteBook 725 G2
Notebook PC

HP EliteBook 820 G1
Notebook PC

Support for DDR3L 1600-MHz PCL3-12800 dual
channel memory
Support for 16384-MB of system memory in the
following configurations:
●

16384-MB total system memory (8192 MB × 2; not
available with Windows 7 32-bit operating system,
available with Windows 7 downgrade)

●

12288-MB total system memory (8192 MB + 4096 MB)

●

8192-MB total system memory (4096 MB × 2 or 8192
MB × 1; not available with Windows 7 32-bit
operating system, available with Windows 7 downgrade)

●

6144-MB total system memory (4096 MB + 2048 MB)

●

4096-MB total system memory (4096 MB × 1 or
2048 MB × 2)

●

2048-MB total system memory (2048 MB × 1)

Flash cache
Description

Support for 32-GB solid-state drive (2242/DS M.2 form factor)

×

Intel SRT (Smart Response Technology)
Not supported with solid-state drive or self-encrypted drive
(SED) hard drive

MiniCard solid-state drive
Description

120-GB solid-state drive (2242/DS M.2 form factor)

HP EliteBook 725 G2
Notebook PC

HP EliteBook 820 G1
Notebook PC
×

Not supported if 32-GB flash cache is selected
Set as primary storage if selected

4
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Primary storage
Description

Support for 6.35-cm (2.5-in) hard drives in 7.0-mm (.28-in)
and 9.5-mm (.37-in) thickness

HP EliteBook 725 G2
Notebook PC

HP EliteBook 820 G1
Notebook PC

×

×

Support for Serial ATA Support for 3D DriveGuard
hard drive protection
Support toolless removal
Support for the following hard drive:
●

×

1-TB, 5400-rpm, SATA, 7.0-mm hard drive
×

Support for the following hard drives:
●

500-GB, 5400-rpm, SATA, 7.0-mm hard drive

●

500-GB, 5400-rpm, SATA, locked, 7.0-mm hard drive

Support for the following hard drives:

ENWW

●

500-GB, 7200-rpm, SATA, 7.0-mm hard drive

●

500-GB, 7200-rpm, SED, 7.0-mm hard drive

●

500-GB, 5400-rpm, SATA, FIPS, 7.0-mm hard drive

●

320-GB, 7200-rpm, SATA, 7.0-mm hard drive

×

×

Primary storage

5

Description

Support for the following 6.35-cm (2.5-in) solid-state drives:
●

256-GB, SATA-3, SED, Opal 2, solid-state drive

●

256-GB, SATA-3, SED, Opal 1, solid-state drive

●

240-GB, SATA-3, solid-state drive

●

180-GB, SATA-3, SED, Opal 1, solid-state drive

●

180-GB, SATA-3, solid-state drive

●

128-GB, SATA-3, solid-state drive

HP EliteBook 725 G2
Notebook PC
×

Support for the following 6.35-cm (2.5-in) solid-state drives:
●

512-GB, SATA-3, solid-state drive

●

256-GB, SATA-3, SED, Opal 2, solid-state drive

●

256-GB, SATA-3, Opal 2, locked, solid-state drive

●

256-GB, SATA-3, SED solid-state drive

●

240-GB, SATA-3, solid-state drive

●

180-GB, SATA-3, SED, Opal 1, solid-state drive

●

180-GB, SATA-3, solid-state drive

●

128-GB, SATA-3, locked, Opal 2, solid-state drive

●

128-GB, SATA-3, locked, solid-state drive

●

128-GB, SATA-3, solid-state drive

●

120-GB, mSATA-3, SED solid-state drive

●

32-GB, SATA-3, solid-state drive

HP EliteBook 820 G1
Notebook PC

×

Audio and video
Description

Webcam, 720p

HP EliteBook 725 G2
Notebook PC

HP EliteBook 820 G1
Notebook PC

×

×

Dual array microphones
Stereo speakers
HD audio with DTS Studio sound

6

Chapter 1 Product description

ENWW

Ethernet
Description

Realtek RTL8111EP 10/100/1000 Ethernet with
DASH support

HP EliteBook 725 G2
Notebook PC

HP EliteBook 820 G1
Notebook PC

×

S3/S4/S5 wake on LAN
Intel I218LM 10/100/1000 Ethernet with iAMT

×

Intel I218LM Gigabit Network Connection
S3/S4/S5 wake on LAN

Wireless networking
Description

Integrated wireless local area network (WLAN) options by way
of wireless module

HP EliteBook 725 G2
Notebook PC

HP EliteBook 820 G1
Notebook PC

×

×

Two WLAN antennas built into display assembly
Support for the following WLAN formats:
●

Atheros AR9485 802.11 b/g/n WiFi Adapter

●

Broadcom BCM943228HMB 802.11 abgn 2×2 Wi-Fi
Adapter, Broadcom Bluetooth 4.0 Adapter

●

Broadcom BCM4352 802.11 ac 2×2 Wi-Fi + Bluetooth
4.0 Combo Adapter

×

Support for the following WLAN formats:
●

Broadcom BCM943228HMB 802.11 a/b/g/n 2×2 WiFi + Bluetooth 4.0 Combo Adapter

●

Intel Dual Band Wireless-AC 7260 802.11 ac 2×2 WiFi
+ Bluetooth 4.0 WLAN module

●

Intel Dual Band Wireless-N 7260AN 802.11 a/b/g/n
2×2 WiFi + Bluetooth 4.0 Combo Adapter

●

Intel Dual Band Wireless-N 7260AN 802.11 a/b/g/n
2×2 WiFi + Bluetooth 4.0 Combo Adapter

●

Intel Dual Band Wireless-N 7260NB 802.11 a/b/g/n
2×2 WiFi Adapter

Integrated wireless wide area network (WWAN) options by
way of wireless module (select models only)

×

×

×

Two WWAN antennas built into display assembly
(select models only)

ENWW

Ethernet
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Description

Support for the following WWAN formats:
●

HP hs3110 HSPA+ Mobile Broadband Module

●

HP lt4112 LTE/HPSA+ Mobile Broadband Module

●

HP lt4111 LTE/EV-DO/HSPA+ Mobile
Broadband Module

HP EliteBook 725 G2
Notebook PC
×

Support for the following WWAN formats:
●

HP hs3110 HSPA+ Mobile Broadband Module

●

HP lt4226 LTE/HSPA+4G Module

●

HP lt4225 LTE/EV-DO 4G Module

●

HP lt4112 LTE/HSPA+ Mobile Broadband Module

●

HP lt4111 LTE/EV-DO/HSPA+ Mobile
Broadband Module

HP EliteBook 820 G1
Notebook PC

×

External expansion
Description

SD media reader slot

HP EliteBook 725 G2
Notebook PC

HP EliteBook 820 G1
Notebook PC

×

×

Support for SD, SDHC, SDXC
Push-push insertion/removal
SIM slot (populated with WWAN; tool-less user-accessible)

8
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Ports
Description

●

AC adapter, HP Smart (4.5-mm barrel)

●

Audio-in (mono microphone)/audio-out (stereo
headphone) combo jack

●

DisplayPort 1.2

●

Docking

●

RJ45 (Ethernet)

●

USB 3.0 charging (1)

●

USB 3.0 (2)

●

VGA (Dsub 15 pin) supporting: 1920×1200 external
resolution @ 75 Hz, hot plug and unplug and
autodetection for correct output to wide-aspect vs.
standard aspect video

HP EliteBook 725 G2
Notebook PC

HP EliteBook 820 G1
Notebook PC

×

×

HP EliteBook 725 G2
Notebook PC

HP EliteBook 820 G1
Notebook PC

×

×

HP EliteBook 725 G2
Notebook PC

HP EliteBook 820 G1
Notebook PC

×

×

Docking
Description

HP 2013 UltraSlim Docking Station

Keyboard/pointing devices
Description

Dual point, spill-resistant (with drain) keyboard with DuraKeys,
function keys and optional backlightFunction Keys:
Touchpad Requirements: Glass with chemical etched
surface, on/off button, support for 2-way scroll, Taps enabled
as default, Gestures enabled by default (2-finger scrolling, 2finger zoom (pinch)

ENWW
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Power requirements
Description

Support for removable 3-cell, 46-WHr, 4.15-AHr, Li-ion battery
and 3-cell, 26-WHr, 2.50-AHr, Li-ion battery

HP EliteBook 725 G2
Notebook PC

HP EliteBook 820 G1
Notebook PC

×

×

HP EliteBook 725 G2
Notebook PC

HP EliteBook 820 G1
Notebook PC

×

×

Support for the following AC adapters:
●

65-W HP Smart adapter (EM, RC/V, 3-wire, 4.5-mm)

●

65-W HP Smart adapter (non-PFC, 3-wire, 4.5-mm)

●

45-W HP Smart adapter (non-PFC, RC/V, 3-wire, 4.5mm)

Security
Description

Support for the following:

10

●

Fingerprint reader

●

Full-volume encryption

●

Integrated Smart Card reader (active)

●

Preboot authentication (password, Smart Card)

●

Support Security Lock

●

Trusted Platform Module (TPM) 1.2 (Infineon;
soldered down)

●

Trusted Platform Module (TPM) 1.2 (Infineon;
soldered down)
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Operating system
Description

Preinstalled:
●

Microsoft® Windows® 8.1 Chinese Market 64-bit
(available only with People's Republic of China
country localization)

●

Microsoft Windows 8.1 Emerging Market 64-bit

●

Microsoft Windows 8.1 Multi-language 64-bit

●

Microsoft Windows 8.1 Professional 64-bit DPK with
Windows 7 Professional 64-bit Image

●

Microsoft Windows 8.1 Professional 64-bit DPK with
Windows 7 Professional 64-bit–MSNA

●

Microsoft Windows 8.1 Professional 64-bit DPK with
Windows 7 Professional 32-bit image

●

Microsoft Windows 8.1 Professional 64-bit DPK with
Windows 7 Professional 32-bit–MSNA

●

Microsoft Windows 7 Home Basic 32-bit, Service Pack 1
(available only if 4096-MB of total system memory
[4096-MB × 1] or less is selected)

●

Microsoft Windows 7 Home Premium 64-bit,
Service Pack 1

●

Microsoft Windows 7 Professional 32-bit, Service Pack 1
(available only if 4096-MB of total system memory
[4096-MB × 1] or less is selected)

●

Microsoft Windows 7 Professional 64-bit, Service Pack 1

●

Microsoft Windows 7 Professional 32-bit, Service Pack 1
(available only if 4096-MB of total system memory
[4096-MB × 1] or less is selected)

●

Ubuntu Linux

●

FreeDOS 2.0

HP EliteBook 725 G2
Notebook PC

HP EliteBook 820 G1
Notebook PC

×

Restore Media–DRDVD:

ENWW

●

Microsoft Windows 8.1 (available with any Windows
8.1 operating system, required with any Windows 8.1
Professional downgrade operating system)

●

Microsoft Windows 7 (available with any Windows 7 or
Windows 8 Professional downgrade operating system)

Operating system
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Description

Restore Media–SRDVD: Ubuntu Linux

HP EliteBook 725 G2
Notebook PC

HP EliteBook 820 G1
Notebook PC

×

OSDVD:
●

Microsoft Windows 8.1 64-bit (for service only)

●

Microsoft Windows 8.1 CS 64-Bit (for service only)

●

Microsoft Windows 8.1 Emerging Markets 64-Bit
(for service only)

●

Microsoft Windows 8.1 Professional 64-bit (include in
Windows 8.1 downgrade operating system AVs only; do
not include for Asia/Pacific countries or regions or the
People's Republic of China)

●

Microsoft Windows 7 Home Basic 32-bit (available with
any Windows 7 Home Basic localization except Asia/
Pacific countries/regions or the People's Republic of
China)

●

Microsoft Windows 7 Home Premium 64-bit (available
with any Windows 7 HP operating system except Asia/
Pacific countries/regions or the People's Republic of
China)

●

Microsoft Windows 7 Home Premium 32-bit (available
with any Windows 7 HP operating system except Asia/
Pacific countries/regions or the People's Republic of
China)

●

Microsoft Windows 7 Professional 64-bit (available with
any Windows 7 Professional or Windows 8.1
Professional downgrade localization except Asia/Pacific
countries or regions or the People's Republic of China)

●

Microsoft Windows 7 Professional 32-bit (available with
any Windows 7 Professional or Windows 8.1
Professional downgrade localization except Asia/Pacific
countries/regions or the People's Republic of China)

Certified: Microsoft WHQL
Web-only Support:

12

●

Microsoft Windows 8.1 Enterprise 64-bit

●

Microsoft Windows 7 Enterprise 64-bit

●

Microsoft Windows 7 Enterprise 32-bit

Chapter 1 Product description
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Description

Preinstalled:
●

Microsoft Windows 8.1 and 8 Chinese Market 64-bit
(only available with People's Republic of China
country localization)

●

Microsoft Windows 8.1 and 8 Emerging Market 64-bit

●

Microsoft Windows 8.1 and 8 Multi-language 64-bit

●

Microsoft Windows 8.1 and 8 Professional 64-bit

●

Microsoft Windows 8.1 and 8 Professional 64-bit DPK
with Microsoft Windows 7 Professional 64- and 32bit image

●

Microsoft Windows 8 Professional 64-bit DPK with
Microsoft Windows 7 Professional 64- and 32-bit image–
MSNA

●

Microsoft Windows 8 Professional 64-bit–MSNA

●

Microsoft Windows 7 Home Basic 32-bit

●

Microsoft Windows 7 Home Premium 64- and 32-bit

●

Microsoft Windows 7 Professional 64- and 32-bit

●

Microsoft Windows 7 Professional 64- and 32-bit–MSNA
(only in Asia/Pacific countries and regions and
the People's Republic of China)

●

FreeDOS 2.0

●

SuSE Linux Enterprise (SLED 11, Service Pack 2, 64-bit;
not available on computer models equipped with
WWAN capability)

HP EliteBook 725 G2
Notebook PC

HP EliteBook 820 G1
Notebook PC
×

Restore Media–DRDVD:

ENWW

●

DRDVD Microsoft Windows 8.1 (available with any
Windows 8.1 operating system; required with any
Windows 8.1 downgrade operating system)

●

DRDVD Microsoft Windows 8 (available with any
Windows 8 operating system; required with any
Windows 8 downgrade operating system)

●

Microsoft Windows 7 (available with any Windows 7 or
Windows 8 downgrade operating system)

●

SRDVD SuSE Linux Enterprise (SLED, service pack 2, 64bit; available only with FreeDOS 2.0 and SuSE)

Operating system

13

Description

Restore Media–OSDVD:
●

Microsoft Windows 8.1 and 8 Professional 64-bit
(include in Windows 8.1 and 8 downgrade
operating system AV only; do not include for Asia/Pacific
countries or regions or the People's Republic of China)

●

Microsoft Windows 8 64-bit (for service only)

●

Microsoft Windows 8 Country Specific 64-bit
(for service only)

●

Microsoft Windows 8 Emerging Market 64-bit
(for service only)

●

Microsoft Windows 7 Home Basic 32-bit (available with
any Microsoft Windows 7 Home Basic localization
except for Asia/Pacific countries or regions or
the People's Republic of China)

●

Microsoft Windows 7 Home Premium 64- and 32-bit
(available with any Microsoft Windows 7 Professional or
Microsoft Windows 8 downgrade localization except for
Asia/Pacific countries or regions or
the People's Republic of China)

●

Microsoft Windows 7 Professional 64- and 32-bit
(available with any Microsoft Windows 7 Professional or
Microsoft Windows 8 downgrade localization except for
Asia/Pacific countries or regions or
the People's Republic of China)

HP EliteBook 725 G2
Notebook PC

HP EliteBook 820 G1
Notebook PC
×

Certified:
●

Microsoft WHQL

●

SuSE Linux Enterprise (SLED, service pack 2, 64-bit

Web-only Support:
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●

Microsoft Windows 8.1 Chinese market 64-bit

●

Microsoft Windows 8.1 Emerging market 64-bit

●

Microsoft Windows 8.1 Multi-Language 64-bit

●

Microsoft Windows 8.1 Enterprise 64-bit

●

Microsoft Windows 8.1 Pro 64-bit

●

Microsoft Windows 7 Ultimate 64- and 32-bit

●

Microsoft Windows 7 Enterprise 64- and 32-bit
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Serviceability
Description

End user replaceable parts:

ENWW

●

AC adapter

●

Battery (system)

●

Hard drive

●

Keyboard

●

Memory module

●

Solid-state drive

●

WLAN module

●

WWAN module

HP EliteBook 725 G2
Notebook PC

HP EliteBook 820 G1
Notebook PC

×

×

Serviceability
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2

External component identification

Display

Item

Component

Description

(1)

WLAN antennas (2)*

Send and receive wireless signals to communicate with wireless local
area networks.
NOTE: To set up a WLAN and connect to the Internet, you need a broadband
modem (either DSL or cable) (purchased separately), high-speed Internet service,
purchased from an Internet service provider, and a wireless router (purchased
separately).

ENWW

(2)

WWAN antennas (2)*

Send and receive wireless signals to communicate with wireless wide
area networks.

(3)

Internal microphones

Record sound.

(4)

Webcam light
(select models only)

On: The webcam is in use.

Display
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Item

Component

Description

(5)

Webcam
(select models only)

Records video and captures still photographs.

Internal display switch

Turns off the display and initiates Sleep if the display is closed while the power
is on.

(6)

To use the webcam, select Start > All Programs > Communication and
Chat > HP Webcam.

NOTE: The internal display switch is not visible from the outside of
the computer.
*The antennas are not visible from the outside of the computer. For optimal transmission, keep the areas immediately around
the antennas free from obstructions. To see wireless regulatory notices, see the section of the Regulatory, Safety, and
Environmental Notices that applies to your country or region. These notices are located in Help and Support.
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Buttons and fingerprint reader (select models only)

Item

Component

Description

(1)

Power button

●

When the computer is off, press the button to turn on the computer.

●

When the computer is on, press the button briefly to initiate Sleep.

●

When the computer is in the Sleep state, press the button briefly to
exit Sleep.

●

When the computer is in Hibernation, press the button briefly to
exit Hibernation.

If the computer has stopped responding and Microsoft Windows shutdown
procedures are ineffective, press and hold the power button for at least 5 seconds
to turn off the computer.
To learn more about your power settings:

ENWW

●

Select Start > Control Panel > System and Security >
Power Options.

●

For more information, see the HP Notebook Reference Guide.

(2)

Speakers

Produce sound.

(3)

Wireless button

Turns the wireless feature on or off but does not establish a wireless connection.

(4)

Volume mute button

Mutes and restores speaker sound.

(5)

Fingerprint reader
(select models only)

Allows a fingerprint logon to Windows, instead of a password logon.

Buttons and fingerprint reader (select models only)
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Keys
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Item

Component

Description

(1)

esc key

Displays system information when pressed in combination with the fn key.

(2)

fn key

Executes frequently used system functions when pressed in combination with a
function key, the num lk key, the esc key, or other keys.

(3)

Windows logo key

Displays the Windows Start menu.

(4)

Function keys

Execute frequently used system functions when pressed in combination with the
fn key.

(5)

Embedded numeric
keypad

When the keypad is turned on, it can be used like an external numeric keypad.
Each key on the keypad performs the function indicated by the icon in the upperright corner of the key.

(6)

num lk key

Turns the embedded numeric keypad on and off when pressed in combination
with the fn key. Alternates between the navigational and numeric functions on the
integrated numeric keypad.

Chapter 2 External component identification
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Lights

Item

Component

Description

(1)

Power light

●

On: The computer is on.

●

Blinking: The computer is in the Sleep state.

●

Off: The computer is off or in Hibernation.

(2)

Caps lock light

On: Caps lock is on.

(3)

Microphone mute light

On: Microphone is muted.

(4)

Num lock light

On: Num lock is on.

(5)

Wireless light

●

White: An integrated wireless device, such as a wireless local area network
(WLAN) device, is on.

●

Amber: All wireless devices are off.

●

Off: Computer sound is on.

●

Amber: Computer sound is off.

(6)

ENWW

Mute light

Lights
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TouchPad
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Item

Component

Description

(1)

Pointing stick

Moves the pointer and selects or activates items on the screen.

(2)

Left pointing stick button

Functions like the left button on an external mouse.

(3)

TouchPad on/off button

Turns the TouchPad on and off.

(4)

TouchPad zone

Moves the pointer and selects or activates items on the screen.

(5)

Left TouchPad button

Functions like the left button on an external mouse.

(6)

Right pointing stick button

Functions like the right button on an external mouse.

(7)

Right TouchPad button

Functions like the right button on an external mouse.

Chapter 2 External component identification
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Front

Item

Component

Description

(1)

Wireless light

The wireless connection is on.

(2)

Power light

●

On: The computer is on.

●

Blinking: The computer is in the Sleep state.

●

Off: The computer is off or in Hibernation.

●

Amber: The computer is connected to external power and the battery is
charged from 0 to 90 percent.

●

White: The computer is connected to external power and the battery is
charged from 90 to 99 percent.

●

Blinking amber: A battery that is the only available power source has
reached a low battery level. When the battery reaches a critical battery
level, the battery light begins blinking rapidly.

●

Off: The battery is fully charged.

●

Blinking white: The hard drive is being accessed.

●

Amber: HP 3D DriveGuard has temporarily parked the hard drive.

(3)

(4)

AC adapter/battery light

Hard drive light

NOTE: For information on HP 3D DriveGuard, see the HP Notebook
Reference Guide.

ENWW

Front
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Left side

Item

Component

Description

(1)

Security cable slot

Attaches an optional security cable to the computer.
NOTE: The security cable is designed to act as a deterrent, but it may not
prevent the computer from being mishandled or stolen.

(2)

Vents (2)

Enable airflow to cool internal components.
NOTE: The computer fan starts up automatically to cool internal components
and prevent overheating. It is normal for the internal fan to cycle on and off
during routine operation.

(3)

External VGA
monitor port

Connects an external VGA monitor or projector.

(4)

USB 3.0 charging port

Connects an optional USB device. The USB charging port can also charge select
models of cell phones and MP3 players, even when the computer is off.
NOTE: A USB charging port (also referred to as a powered USB port) allows
you to charge connected USB devices. Standard USB ports will not charge all
USB devices or will charge using a low current. Some USB devices require power
and require you to use a powered port.

(5)

24

Smart card reader

Supports optional smart cards.
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Right side

Item

Component

Description

(1)

Audio-out (headphone)
jack/Audio-in
(microphone) combo jack

Produces sound when connected to optional powered stereo speakers,
headphones, earbuds, a headset, or television audio. Also connects an optional
headset microphone.
WARNING! To reduce the risk of personal injury, adjust the volume before
putting on headphones, earbuds, or a headset. For additional safety information,
see the Regulatory, Safety, and Environmental Notices.
NOTE: When a device is connected to the jack, the computer speakers
are disabled.
NOTE: Be sure that the device cable has a 4-conductor connector that supports
both audio-out (headphone) and audio-in (microphone).

ENWW

(2)

DisplayPort

Connects an optional digital display device, such as a highperformance monitor
or projector.

(3)

USB 3.0 ports (2)

Connect optional USB 3.0 devices and provide enhanced USB power
performance.

(4)

Memory card reader

Reads data from and writes data to memory cards such as Secure Digital (SD).

(5)

RJ-45 (network) jack

Connects a network cable.

(6)

Docking port

Connects an optional docking device.

(7)

Power connector

Connects an AC adapter.

Right side
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Bottom

Item

Component

Description

(1)

Service cover

Provides access to the hard drive bay, the WLAN module slot, the WWAN
module slot, and the memory module slots.
CAUTION: To prevent an unresponsive system, replace the wireless module
only with a wireless module authorized for use in the computer by the
governmental agency that regulates wireless devices in your country or region.
If you replace the module and then receive a warning message, remove the
module to restore computer functionality, and then contact support through Help
and Support.

(2)

Service cover
release latch

Releases the service cover from the computer. A security screw is available to
prevent the service cover from being accidentally removed.

(3)

Vents (2)

Enable airflow to cool internal components.
NOTE: The computer fan starts up automatically to cool internal components
and prevent overheating. It is normal for the internal fan to cycle on and off
during routine operation.
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Illustrated parts catalog

NOTE: HP continually improves and changes product parts. For complete and current information on
supported parts for your computer, go to http://partsurfer.hp.com, select your country or region, and
then follow the on-screen instructions.

Locating the serial number, product number, and
model number
The serial number and product number of your tablet are located on the left edge of the tablet. The
model number of your tablet is located on the back of your tablet. You may need the information when
you travel internationally or when you contact support.

ENWW

Locating the serial number, product number, and model number
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Computer major components
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Item

Component

Spare part number

(1)

Display assembly: The TouchScreen display assembly is spared as a whole unit replacement.
12.5-in, AntiGlare, FHD, LED, UWVA, TouchScreen display assembly for use only on
computer models equipped with an AMD processor

765606-001

12.5-in, AntiGlare, HD, LED, UWVA, TouchScreen display assembly for use only on
computer models equipped with an Intel processor

761781-001

The non-TouchScreen display assembly is spared at the subcomponent level only. For more display assembly spare
part information, see Display assembly components on page 41.
(2)

Keyboard with backlight (includes backlight cable and keyboard cable):
For use only on computer models equipped with an AMD processor:
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For use in Belgium

776452-A41

For use in Brazil

776452-201

For use in Bulgaria

776452-BA1

For use in Canada

776452-DB1

For use in the Czech Republic and Slovakia

776452-FL1

For use in Denmark

776452-081

For use in France

776452-051

For use in Germany

776452-041

For use in Greece

776452-151

For use in Hungary

776452-211

For use in Iceland

776452-DD1

For use in India

776452-D61

For use in Israel

776452-BB1

For use in Italy

776452-061

For use in Japan

776452-291

For use in Latin America

776452-161

For use in the Netherlands

776452-B31

For use in Northwest Africa

776452-FP1

For use in Norway

776452-091

For use in Portugal

776452-131

For use in Romania

776452-271

For use in Russia

776452-251

For use in Saudi Arabia

776452-171

For use in Slovenia

776452-BA1
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Item

Component

Spare part number

For use in South Korea

776452-AD1

For use in Spain

776452-071

For use in Sweden and Finland

776452-B71

For use in Switzerland

776452-BG1

For use in Taiwan

776452-AB1

For use in Thailand

776452-281

For use in Turkey

776452-141

For use in the United Kingdom

776452-031

For use in the United States

776452-001

Keyboard with backlight for use only on computer models equipped with an Intel processor:

ENWW

For use in Belgium

730541-A41

For use in Brazil

730541-201

For use in Bulgaria

730541-261

For use in Canada

730541-DB1

For use in the Czech Republic and Slovakia

730541-FL1

For use in Denmark

730541-081

For use in France

730541-051

For use in Germany

730541-041

For use in Greece

730541-151

For use in Hungary

730541-211

For use in Iceland

730541-DD1

For use in India

730541-D61

For use in Israel

730541-BB1

For use in Italy

730541-061

For use in Japan

730541-291

For use in Latin America

730541-161

For use in the Netherlands

730541-B31

For use in Northwest Africa

730541-FP1

For use in Norway

730541-091

For use in Portugal

730541-131

For use in Romania

730541-271

For use in Russia

730541-251

Computer major components
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Item

Component

Spare part number

For use in Saudi Arabia

730541-171

For use in Slovenia

730541-BA1

For use in South Korea

730541-AD1

For use in Spain

730541-071

For use in Sweden and Finland

730541-B71

For use in Switzerland

730541-BG1

For use in Taiwan

730541-AB1

For use in Thailand

730541-281

For use in Turkey

730541-141

For use in the United Kingdom and Singapore

730541-031

For use in the United States

730541-001

Keyboard without backlight (includes keyboard cable):
For use only on computer models equipped with an AMD processor:
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For use in Belgium

776451-A41

For use in Brazil

776451-201

For use in Bulgaria

776451-261

For use in Canada

776451-DB1

For use in the Czech Republic and Slovakia

776451-FL1

For use in Denmark

776451-081

For use in France

776451-051

For use in Germany

776451-041

For use in Greece

776451-151

For use in Hungary

776451-211

For use in Iceland

776451-DD1

For use in India

776451-D61

For use in Israel

776451-BB1

For use in Italy

776451-061

For use in Japan

776451-291

For use in Latin America

776451-161

For use in the Netherlands

776451-B31

For use in Northwest Africa

776451-FP1

For use in Norway

776451-091
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Item

Component

Spare part number

For use in Portugal

776451-131

For use in Romania

776451-271

For use in Russia

776451-251

For use in Saudi Arabia

776451-171

For use in Slovenia

776451-BA1

For use in South Korea

776451-AD1

For use in Spain

776451-071

For use in Sweden and Finland

776451-B71

For use in Switzerland

776451-BG1

For use in Taiwan

776451-AB1

For use in Thailand

776451-281

For use in Turkey

776451-141

For use in the United Kingdom

776451-031

For use in the United States

776451-001

Keyboard without backlight for use only on computer models equipped with an Intel processor
(includes keyboard cable):

ENWW

For use in Belgium

730540-A41

For use in Brazil

730540-201

For use in Bulgaria

730540-261

For use in Canada

730540-DB1

For use in the Czech Republic and Slovakia

730540-FL1

For use in Denmark

730540-081

For use in France

730540-051

For use in Germany

730540-041

For use in Greece

730540-151

For use in Hungary

730540-211

For use in Iceland

730540-DD1

For use in India

730540-D61

For use in Israel

730540-BB1

For use in Italy

730540-061

For use in Japan

730540-291

For use in Latin America

730540-161

For use in the Netherlands

730540-B31

Computer major components
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Item

Component

Spare part number

For use in Northwest Africa

730540-FP1

For use in Norway

730540-091

For use in Portugal

730540-131

For use in Romania

730540-271

For use in Russia

730540-251

For use in Saudi Arabia

730540-171

For use in Slovenia

730540-BA1

For use in South Korea

730540-AD1

For use in Spain

730540-071

For use in Sweden and Finland

730540-B71

For use in Switzerland

730540-BG1

For use in Taiwan

730540-AB1

For use in Thailand

730540-281

For use in Turkey

730540-141

For use in the United Kingdom and Singapore

730540-031

For use in the United States

730540-001

(3)

RTC battery (includes cable and double-sided adhesive)

702853-001

(4)

Top cover:
For use only on computer models equipped with an AMD processor

783215-001

For use only on computer models equipped with an Intel processor

730548-001

(5)

Power button board (includes cable)

730552-001

(6)

Speaker assembly (includes left and right speakers and cables)

730555-001

(7)

Fingerprint reader board (includes bracket and cable)

730554-001

(8)

Card reader board (includes cable)

730563-001

(9)

System board (includes a graphics subsystem with UMA memory and replacement thermal material):
For use only on computer models equipped with an AMD processor:
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Equipped with an AMD A10 Pro-7350B 2.10-GHz (SC turbo up to 3.30-GHz) quad
core processor (4.00-MB L2 cache, 19 W), a graphics subsystem with UMA memory,
and the Windows 8 Professional operating system

765617-601

Equipped with an AMD A10 Pro-7350B 2.10-GHz (SC turbo up to 3.30-GHz) quad
core processor (4.00-MB L2 cache, 19 W), a graphics subsystem with UMA memory,
and the Windows 8 Standard operating system

765617-501

Equipped with an AMD A10 Pro-7350B 2.10-GHz (SC turbo up to 3.30-GHz) quad
core processor (4.00-MB L2 cache, 19 W), a graphics subsystem with UMA memory,
and a non-Windows 8 operating system

765617-001
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Item

Component

Spare part number

Equipped with an AMD A8 Pro-7150B 2.00-GHz (SC turbo up to 3.20-GHz) quad
core processor (4.00-MB L2 cache, 19 W), a graphics subsystem with UMA memory,
and the Windows 8 Professional operating system

765616-601

Equipped with an AMD A8 Pro-7150B 2.00-GHz (SC turbo up to 3.20-GHz) quad
core processor (4.00-MB L2 cache, 19 W), a graphics subsystem with UMA memory,
and the Windows 8 Standard operating system

765616-501

Equipped with an AMD A8 Pro-7150B 2.00-GHz (SC turbo up to 3.20-GHz) quad
core processor (4.00-MB L2 cache, 19 W), a graphics subsystem with UMA memory,
and a non-Windows 8 operating system

765616-001

Equipped with an AMD A6 Pro-7050B 2.20-GHz (SC turbo up to 3.00-GHz) dual
core processor (1.00-MB L2 cache, 17 W), a graphics subsystem with UMA memory,
and the Windows 8 Professional operating system

765615-601

Equipped with an AMD A6 Pro-7050B 2.20-GHz (SC turbo up to 3.00-GHz) dual
core processor (1.00-MB L2 cache, 17 W), a graphics subsystem with UMA memory,
and the Windows 8 Standard operating system

765615-501

Equipped with an AMD A6 Pro-7050B 2.20-GHz (SC turbo up to 3.00-GHz) dual
core processor (1.00-MB L2 cache, 17 W), a graphics subsystem with UMA memory,
and a non-Windows 8 operating system

765615-001

For use only on computer models equipped with an Intel processor and a TouchScreen display assembly:
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Equipped with an Intel Core i7-4600U 2.10-GHz (SC turbo up to 3.10-GHz)
processor (4.00-MB L3 cache, 15 W) and the Windows 8 Professional
operating system

761778-601

Equipped with an Intel Core i7-4600U 2.10-GHz (SC turbo up to 3.10-GHz)
processor (4.00-MB L3 cache, 15 W) and the Windows 8 Standard operating system

761778-501

Equipped with an Intel Core i7-4600U 2.10-GHz (SC turbo up to 3.10-GHz)
processor (4.00-MB L3 cache, 15 W) and a non-Windows 8 operating system

761778-001

Equipped with an Intel Core i7-4510U 2.00-GHz (SC turbo up to 3.10GHz) processor (4.00-MB L3 cache, 15 W), a graphics subsystem with UMA memory,
and the Windows 8 Professional operating system

778831-601

Equipped with an Intel Core i7-4510U 2.00-GHz (SC turbo up to 3.10GHz) processor (4.00-MB L3 cache, 15 W), a graphics subsystem with UMA memory,
and the Windows 8 Professional operating system

778831-501

Equipped with an Intel Core i7-4510U 2.00-GHz (SC turbo up to 3.10GHz) processor (4.00-MB L3 cache, 15 W), a graphics subsystem with UMA memory,
and a non-Windows 8 operating system

778831-001

Equipped with an Intel Core i7-4500U 1.80-GHz (SC turbo up to 3.00-GHz)
processor (4.00-MB L3 cache, 15 W) and the Windows 8 Professional
operating system

761777-601

Equipped with an Intel Core i7-4500U 1.80-GHz (SC turbo up to 3.00-GHz)
processor (4.00-MB L3 cache, 15 W) and the Windows 8 Standard operating system

761777-501

Equipped with an Intel Core i7-4500U 1.80-GHz (SC turbo up to 3.00-GHz)
processor (4.00-MB L3 cache, 15 W) and a non-Windows 8 operating system

761777-001

Computer major components
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36

Component

Spare part number

Equipped with an Intel Core i5-4310U 2.00-GHz (SC turbo up to 3.00GHz) processor (3.00-MB L3 cache, 15 W), a graphics subsystem with UMA memory,
and the Windows 8 Professional operating system

778830-601

Equipped with an Intel Core i5-4310U 2.00-GHz (SC turbo up to 3.00GHz) processor (3.00-MB L3 cache, 15 W), a graphics subsystem with UMA memory,
and the Windows 8 Standard operating system

778830-501

Equipped with an Intel Core i5-4310U 2.00-GHz (SC turbo up to 3.00GHz) processor (3.00-MB L3 cache, 15 W), a graphics subsystem with UMA memory,
and a non-Windows 8 operating system

778830-001

Equipped with an Intel Core i5-4300U 1.90-GHz (SC turbo up to 2.90-GHz)
processor (3.00-MB L3 cache, 15 W) and the Windows 8 Professional
operating system

761776-601

Equipped with an Intel Core i5-4300U 1.90-GHz (SC turbo up to 2.90-GHz)
processor (3.00-MB L3 cache, 15 W) and the Windows 8 Standard operating system

761776-501

Equipped with an Intel Core i5-4300U 1.90-GHz (SC turbo up to 2.90-GHz)
processor (3.00-MB L3 cache, 15 W) and a non-Windows 8 operating system

761776-001

Equipped with an Intel Core i5-4210U 1.70-GHz (SC turbo up to 2.70GHz) processor (3.00-MB L3 cache, 15 W), a graphics subsystem with UMA memory,
and the Windows 8 Professional operating system

778829-601

Equipped with an Intel Core i5-4210U 1.70-GHz (SC turbo up to 2.70GHz) processor (3.00-MB L3 cache, 15 W), a graphics subsystem with UMA memory,
and the Windows 8 Standard operating system

778829-501

Equipped with an Intel Core i5-4210U 1.70-GHz (SC turbo up to 2.70GHz) processor (3.00-MB L3 cache, 15 W), a graphics subsystem with UMA memory,
and a non-Windows 8 operating system

778829-001

Equipped with an Intel Core i5-4200U 1.60-GHz (SC turbo up to 2.60-GHz)
processor (3.00-MB L3 cache, 15 W) and the Windows 8 Professional
operating system

761775-601

Equipped with an Intel Core i5-4200U 1.60-GHz (SC turbo up to 2.60-GHz)
processor (3.00-MB L3 cache, 15 W) and the Windows 8 Standard operating system

761775-501

Equipped with an Intel Core i5-4200U 1.60-GHz (SC turbo up to 2.60-GHz)
processor (3.00-MB L3 cache, 15 W) and a non-Windows 8 operating system

761775-001

Equipped with an Intel Core i3-4030U 1.90-GHz processor (3.00-MB L3 cache,
15 W), a graphics subsystem with UMA memory, and the Windows 8 Professional
operating system

778828-601

Equipped with an Intel Core i3-4030U 1.90-GHz processor (3.00-MB L3 cache,
15 W), a graphics subsystem with UMA memory, and the Windows 8 Standard
operating system

778828-501

Equipped with an Intel Core i3-4030U 1.90-GHz processor (3.00-MB L3 cache,
15 W), a graphics subsystem with UMA memory, and a non-Windows 8
operating system

778828-001

Equipped with an Intel Core i3-4010U 1.70-GHz processor (3.00-MB L3 cache,
15 W), a graphics subsystem with UMA memory, and the Windows 8 Professional
operating system

761774-601
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Spare part number

Equipped with an Intel Core i3-4010U 1.70-GHz processor (3.00-MB L3 cache,
15 W), a graphics subsystem with UMA memory, and the Windows 8 Standard
operating system

761774-501

Equipped with an Intel Core i3-4010U 1.70-GHz processor (3.00-MB L3 cache,
15 W), a graphics subsystem with UMA memory, and a non-Windows 8
operating system

761774-001

For use only on computer models equipped with an Intel processor and a non-TouchScreen display assembly:

(10)

ENWW

Equipped with an Intel Core i7-4600U 2.10-GHz (SC turbo up to 3.30-GHz)
processor (4.00-MB L3 cache, 15 W) and the Windows 8 Professional
operating system

730559-601

Equipped with an Intel Core i7-4600U 2.10-GHz (SC turbo up to 3.30-GHz)
processor (4.00-MB L3 cache, 15 W) and the Windows 8 Standard operating system

730559-501

Equipped with an Intel Core i7-4600U 2.10-GHz (SC turbo up to 3.30-GHz)
processor (4.00-MB L3 cache, 15 W) and a non-Windows 8 operating system

730559-001

Equipped with an Intel Core i7-4500U 1.80-GHz (SC turbo up to 3.00-GHz)
processor (4.00-MB L3 cache, 15 W) and the Windows 8 Professional
operating system

753071-601

Equipped with an Intel Core i7-4500U 1.80-GHz (SC turbo up to 3.00-GHz)
processor (4.00-MB L3 cache, 15 W) and the Windows 8 Standard operating system

753071-501

Equipped with an Intel Core i7-4500U 1.80-GHz (SC turbo up to 3.00-GHz)
processor (4.00-MB L3 cache, 15 W) and a non-Windows 8 operating system

753071-001

Equipped with an Intel Core i5-4300U 1.90-GHz (SC turbo up to 2.90-GHz)
processor (3.00-MB L3 cache, 15 W) and the Windows 8 Professional
operating system

731066-601

Equipped with an Intel Core i5-4300U 1.90-GHz (SC turbo up to 2.90-GHz)
processor (3.00-MB L3 cache, 15 W) and the Windows 8 Standard operating system

731066-501

Equipped with an Intel Core i5-4300U 1.90-GHz (SC turbo up to 2.90-GHz)
processor (3.00-MB L3 cache, 15 W) and a non-Windows 8 operating system

731066-001

Equipped with an Intel Core i5-4200U 1.60-GHz (SC turbo up to 2.60-GHz)
processor (3.00-MB L3 cache, 15 W) and the Windows 8 Professional
operating system

730558-601

Equipped with an Intel Core i5-4200U 1.60-GHz (SC turbo up to 2.60-GHz)
processor (3.00-MB L3 cache, 15 W) and the Windows 8 Standard operating system

730558-501

Equipped with an Intel Core i5-4200U 1.60-GHz (SC turbo up to 2.60-GHz)
processor (3.00-MB L3 cache, 15 W) and a non-Windows 8 operating system

730558-001

Equipped with an Intel Core i3-4010U 1.70-GHz processor (3.00-MB L3 cache,
15 W) and the Windows 8 Professional operating system

730557-601

Equipped with an Intel Core i3-4010U 1.70-GHz processor (3.00-MB L3 cache,
15 W) and the Windows 8 Standard operating system

730557-501

Equipped with an Intel Core i3-4010U 1.70-GHz processor (3.00-MB L3 cache,
15 W) and a non-Windows 8 operating system

730557-001

TouchPad (includes cable)

730549-001

Computer major components
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Item

Component

(11)

Heat sink (includes replacement thermal material):

(12)

(13)

(14)

Spare part number

For use only on computer models equipped with an AMD processor

765605-001

For use only on computer models equipped with an Intel processor

730556-001

Fan (includes cable):
For use only on computer models equipped with an AMD processor

780895-001

For use only on computer models equipped with an Intel processor

730547-001

Base enclosure (includes RJ-45 cover, rubber feet, and service cover eject latch assembly):
For use only on computer models equipped with an AMD processor

765603-001

For use only on computer models equipped with an Intel processor

730551-001

Rubber Kit (not illustrated, includes base enclosure rubber screw covers)

730550-001

Hard drive (does not include hard drive bracket, hard drive connector adapter, or screws):
NOTE: The hard drive bracket, hard drive connector adapter, and screws are included in the Hard Drive
Hardware Kit, spare part number 730539-001. Seefor more information on the Hard Drive Hardware Kit.
For use on all computer models:
500-GB, 7200-rpm, SATA, 7.0-mm hard drive

703267-001

500-GB, 7200-rpm, SED, 7.0-mm hard drive

703268-001

500-GB, 5400-rpm, SATA, FIPS, 7.0-mm hard drive

730946-001

320-GB, 7200-rpm, SATA, 7.0-mm hard drive

634862-001

For use only on computer models equipped with an AMD processor:
1-TB, 5400-rpm, SATA, 7.0-mm hard drive

762990-001

For use only on computer models equipped with an Intel processor:

(15)

(16)

500-GB, 5400-rpm, SATA, 7.0-mm hard drive

683802-001

500-GB, 5400-rpm, SATA, locked, 7.0-mm hard drive

763522-001

500-GB, 5400-rpm, SATA, locked, 7.0-mm hard drive

776626-001

Battery:
3-cell, 46-WHr, 4.15-AHr, Li-ion battery

717378-001

3-cell, 26-WHr, 2.50-AHr, Li-ion battery

717377-001

WWAN module:
For use only on computer models equipped with an AMD processor:
HP hs3110 HSPA+ Mobile Broadband Module

748599-001

HP lt4112 LTE/HPSA+ Mobile Broadband Module

740011-001

HP lt4111 LTE/EV-DO/HSPA+ Mobile Broadband Module

748021-001

For use only on computer models equipped with an Intel processor:
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Item

(17)

Component

Spare part number

HP hs3110 HSPA+ Mobile Broadband Module

723895-001

HP lt4226 LTE/HSPA+4G Module

736675-001

HP lt4225 LTE/EV-DO 4G Module

736676-001

HP lt4112 LTE/HSPA+ Mobile Broadband Module

704031-001

HP lt4111 LTE/EV-DO/HSPA+ Mobile Broadband Module

704030-001

Solid-state drive:
For use only on computer models equipped with an AMD processor:
256-GB, SATA-3, SED, Opal 2, solid-state drive

765614-001

256-GB, SATA-3, SED, Opal 1, solid-state drive

765613-001

240-GB, SATA-3, solid-state drive

765612-001

180-GB, SATA-3, SED, Opal 1, solid-state drive

765611-001

180-GB, SATA-3, solid-state drive

765610-001

128-GB, SATA-3, solid-state drive

765609-001

For use only on computer models equipped with an Intel processor:

(18)

(19)

512-GB, SATA-3, solid-state drive

752103-001

256-GB, SATA-3, SED, Opal 2, solid-state drive

761906-001

256-GB, SATA-3, SATA-3, Opal 2, locked, solid-state drive

777832-001

256-GB, SATA-3, SED solid-state drive

730567-001

240-GB, SATA-3, solid-state drive

730566-001

180-GB, SATA-3, SED, Opal 1, solid-state drive

775247-001

180-GB, SATA-3, solid-state drive

730565-001

128-GB, SATA-3, locked, Opal 2, solid-state drive

764507-001

128-GB, SATA-3, locked, solid-state drive

766679-001

128-GB, SATA-3, solid-state drive

744716-001

120-GB, mSATA-3, SED solid-state drive

730568-001

32-GB, SATA-3, solid-state drive

743008-001

Memory module (PCL3, 12800, 1600-MHz):
8 GB

693374-001

4 GB

691740-001

WLAN module:
For use only on computer models equipped with an AMD processor:
Atheros AR9485 802.11 b/g/n WiFi Adapter

ENWW

675794-001

Computer major components
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Item

Component

Spare part number

Broadcom BCM943228HMB 802.11 abgn 2×2 Wi-Fi Adapter, Broadcom Bluetooth
4.0 Adapter

730668-001

Broadcom BCM4352 802.11 ac 2×2 Wi-Fi + Bluetooth 4.0 Combo Adapter

724935-001

For use only on computer models equipped with an Intel processor:

(20)

Broadcom BCM943228HMB 802.11 a/b/g/n 2×2 Wi-Fi + Bluetooth 4.0 Combo
Adapter

697316-001

Intel Dual Band Wireless-AC 7260 802.11 ac 2×2 WiFi + Bluetooth
4.0 WLAN module

710661-001

Intel Dual Band Wireless-N 7260AN 802.11 a/b/g/n 2×2 WiFi + Bluetooth 4.0
Combo Adapter

717381-001

Intel Dual Band Wireless-N 7260AN 802.11 a/b/g/n 2×2 WiFi + Bluetooth 4.0
Combo Adapter

747832-001

Intel Dual Band Wireless-N 7260NB 802.11 a/b/g/n 2×2 WiFi Adapter

717382-001

Service cover (includes rubber feet):
For use only on computer models equipped with an AMD processor

766018-001

For use only on computer models equipped with an Intel processor:
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For use only on computer models equipped with a TouchScreen display assembly

761780-001

For use only on computer models equipped with a non-TouchScreen display assembly
with a CCCO mark

730564-001

For use only on computer models equipped with a non-TouchScreen display assembly
and with RCTO

745308-001
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Display assembly components
NOTE: The display assembly components listed in this section are for use only on computer models
equipped with a non-TouchScreen display assembly.
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Item

Component

(1)

Display bezel:

Spare part number

For use only on computer models equipped with an AMD processor and an AntiGlare,
FHD, LED, UWVA display panel

775896-001

For use only on computer models equipped with an AMD processor and an AntiGlare,
HD, LED, SVA display panel

766012-001

Display assembly components
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Item

(2)

(3)

Component

Spare part number

For use only on computer models equipped with an Intel processor and an AntiGlare,
HD, LED, SVA display panel

730544-001

Webcam/microphone module (includes double-sided adhesive):
For use only on computer models equipped with an AMD processor

780112-001

For use only on computer models equipped with an Intel processor

730542-001

Microphone module (includes double-sided adhesive)

730795-001

Display panel:
For use only on computer models equipped with an AMD processor:
12.5-in, AG, FHD, LED, UWVA display panel

776930-001

12.5-in, AG, HD, LED, SVA display panel

765607-001

For use only on computer models equipped with an Intel processor:

(4)

(5)

12.5-in, AG, HD, LED, UWVA display panel

730536-001

12.5-in, AG, HD, LED, SVA display panel

730535-001

Display Hinge Kit (includes left and right display hinges):
For use only on computer models equipped with an AMD processor

775895-001

For use only on computer models equipped with an Intel processor

730543-001

Display Cable Kit (includes display panel cable and webcam/microphone
module cable)

730537-001

Antenna Kit, includes:
(6)

WLAN antenna cables and transceivers

(7)

WWAN antenna cables and transceivers

(8)

For use only on computer models equipped with an AMD processor

775894-001

For use only on computer models equipped with an Intel processor

730560-001

Display enclosure:
For use only on computer models equipped with an AMD processor

775893-001

For use only on computer models equipped with an Intel processor

730561-001

Display Panel Support Kit (not illustrated, includes display enclosure, WLAN antenna cables and transceivers,
and WWAN antenna cables and transceivers):
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For use only on computer models equipped with an AMD processor

775897-001

For use only on computer models equipped with an Intel processor

730538-001
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Plastics Kit

Item

Component

Spare part number

Plastics Kit, includes:

730562-001

(1)

Card reader bezel

(2)

Display cable connector bracket

(3)

Fingerprint reader cover

(4)

RJ-45 cover

(5a)

Service cover release latch actuator

(5b)

Service cover release latch arm
Service cover release latch spring (not illustrated)

ENWW

Plastics Kit
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Mass storage devices

Item

Component

Spare part number

(1)

Hard drive (does not include hard drive bracket, hard drive connector adapter, or screws):
NOTE: The hard drive bracket, hard drive connector adapter, and screws are included in the Hard Drive
Hardware Kit.
For use on all computer models:
500-GB, 7200-rpm, SATA, 7.0-mm hard drive

703267-001

500-GB, 7200-rpm, SED, 7.0-mm hard drive

703268-001

500-GB, 5400-rpm, SATA, FIPS, 7.0-mm hard drive

730946-001

320-GB, 7200-rpm, SATA, 7.0-mm hard drive

634862-001

For use only on computer models equipped with an AMD processor:
1-TB, 5400-rpm, SATA, 7.0-mm hard drive

762990-001

For use only on computer models equipped with an Intel processor:
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500-GB, 5400-rpm, SATA, 7.0-mm hard drive

683802-001

500-GB, 5400-rpm, SATA, locked, 7.0-mm hard drive

763522-001
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Item

Component

Spare part number

500-GB, 5400-rpm, SATA, locked, 7.0-mm hard drive

776626-001

Hard Drive Hardware Kit, includes:

734280-001

(2a)

Hard drive bracket

(2b)

Hard drive connector adapter
Screws (not illustrated)

(3)

Solid-state drive:
For use only on computer models equipped with an AMD processor:
256-GB, SATA-3, SED, Opal 2, solid-state drive

765614-001

256-GB, SATA-3, SED, Opal 1, solid-state drive

765613-001

240-GB, SATA-3, solid-state drive

765612-001

180-GB, SATA-3, SED, Opal 1, solid-state drive

765611-001

180-GB, SATA-3, solid-state drive

765610-001

128-GB, SATA-3, solid-state drive

765609-001

For use only on computer models equipped with an Intel processor:
512-GB, SATA-3, solid-state drive

752103-001

256-GB, SATA-3, SED, Opal 2, solid-state drive

761906-001

256-GB, SATA-3, SATA-3, Opal 2, locked, solid-state drive

777832-001

256-GB, SATA-3, SED solid-state drive

730567-001

240-GB, SATA-3, solid-state drive

730566-001

180-GB, SATA-3, SED, Opal 1, solid-state drive

775247-001

180-GB, SATA-3, solid-state drive

730565-001

128-GB, SATA-3, locked, Opal 2, solid-state drive

764507-001

128-GB, SATA-3, locked, solid-state drive

766679-001

128-GB, SATA-3, solid-state drive

744716-001

120-GB, mSATA-3, SED solid-state drive

730568-001

32-GB, SATA-3, solid-state drive

743008-001

Miscellaneous parts
Component

Spare part number

AC adapter:
65-W HP Smart adapter (EM, RC/V, 3-wire, 4.5-mm)

ENWW

693710-001

Miscellaneous parts
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Component

Spare part number

65-W HP Smart adapter (non-PFC, 3-wire, 4.5-mm)

693711-001

65-W HP Smart travel adapter (non-PFC)

693716-001

45-W HP Smart adapter (non-PFC, RC, 7.4-mm)

744893-001

45-W HP Smart adapter (non-PFC, RC, 3-wire, 4.5-mm)

721092-001

45-W HP Smart adapter (non-PFC, RC, 2-wire, 4.5-mm)

742437-001

Carrying case:
HP Essential backpack carrying case

679923-001

HP Essential messenger bag style carrying case

679922-001

HP Essential top-load carrying case

679921-001

HP professional top-load carrying case

705621-001

HP business slim top-load carrying case

718549-001

HP business top-load carrying case

718550-001

HP Travel Smart 3-W DC Cable

630380-001

HP DisplayPort-to-HDMI 1.4 adapter

749288-001

HP 2013 UltraSlim Docking Station

732252-001

HP DisplayPort-to-HDMI cable

617450-001

HP Mobile Connect SIM module

714749-001

Lock:
HP docking station cable lock

575921-001

HP notebook combination lock

591699-001

HP ultraslim keyed cable lock

703372-001

Mouse:
HP comfort-grip wireless mouse

691922-001

HP USB laser mouse

674318-001

HP USB optical travel mouse

434594-001

Power cord (3-pin, black, 1.83-m):
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For use in Argentina

490371-D01

For use in Australia

490371-011

For use in Brazil

490371-202

For use in Denmark

490371-081

For use in Europe

490371-021

For use in India

490371-D61
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Component

Spare part number

For use in Israel

490371-BB1

For use in Italy

490371-061

For use in Japan

490371-291

For use in North America

490371-001

For use in the People's Republic of China

490371-AA1

For use in South Africa

490371-AR1

For use in South Korea

490371-AD1

For use in Switzerland

490371-111

For use in Taiwan

490371-AB1

For use in Thailand

490371-201

For use in the United Kingdom and Singapore

490371-031

Power cord (3-pin, black, 1.00-m):

ENWW

For use in Argentina

755530-D01

For use in Australia

755530-011

For use in Brazil

755530-202

For use in Denmark

755530-081

For use in Europe

755530-021

For use in India

755530-D61

For use in Israel

755530-BB1

For use in Italy

755530-061

For use in Japan

762689-291 and
755530-291

For use in North America

755530-001

For use in the People's Republic of China

755530-AA1

For use in South Africa

755530-AR1

For use in South Korea

755530-AD1

For use in Switzerland

755530-111

For use in Taiwan

755530-AB1

For use in Thailand

755530-201

For use in the United Kingdom and Singapore

755530-031

Screw Kit

730553-001

HP USB 3.0 port replicator

690650-001

Miscellaneous parts
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Sequential part number listing
Spare part number

Description

434594-001

HP USB optical travel mouse

490371-001

Power cord for use in North America (3-pin, black, 1.83-m)

490371-011

Power cord for use in Australia (3-pin, black, 1.83-m)

490371-021

Power cord for use in Europe (3-pin, black, 1.83-m)

490371-031

Power cord for use in the United Kingdom and Singapore (3-pin, black, 1.83-m)

490371-061

Power cord for use in Italy (3-pin, black, 1.83-m)

490371-081

Power cord for use in Denmark (3-pin, black, 1.83-m)

490371-111

Power cord for use in Australia (3-pin, black, 1.83-m)

490371-201

Power cord for use in Thailand (3-pin, black, 1.83-m)

490371-202

Power cord for use in Brazil (3-pin, black, 1.83-m)

490371-291

Power cord for use in Japan (3-pin, black, 1.83-m)

490371-AA1

Power cord for use in the People's Repubic of China (3-pin, black, 1.83-m)

490371-AB1

Power cord for use in Taiwan (3-pin, black, 1.83-m)

490371-AD1

Power cord for use in South Korea (3-pin, black, 1.83-m)

490371-AR1

Power cord for use in South Africa (3-pin, black, 1.83-m)

490371-BB1

Power cord for use in Israel (3-pin, black, 1.83-m)

490371-D01

Power cord for use in Argentina (3-pin, black, 1.83-m)

490371-D61

Power cord for use in India (3-pin, black, 1.83-m)

575921-001

HP docking station cable lock

591699-001

HP notebook combination lock

617450-001

HP DisplayPort-to-HDMI cable

630380-001

HP Travel Smart 3-W DC Cable

634862-001

320-GB, 7200-rpm, SATA, 7.0-mm hard drive for use on all computer models (does not include
hard drive bracket, hard drive connector adapter, or screws)
NOTE: The hard drive bracket, hard drive connector adapter, and screws are included in
the Hard Drive Hardware Kit, spare part number 730539-001.
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674318-001

HP USB laser mouse

675794-001

Atheros AR9485 802.11 b/g/n WiFi Adapter for use only on computer models equipped with an
AMD processor

679921-001

HP Essential top-load carrying case

679922-001

HP Essential messenger bag style carrying case

679923-001

HP Essential backpack carrying case
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Spare part number

Description

683802-001

500-GB, 5400-rpm, SATA, 7.0-mm hard drive for use only on computer models equipped with an
Intel processor (does not include hard drive bracket, hard drive connector adapter, or screws)
NOTE: The hard drive bracket, hard drive connector adapter, and screws are included in
the Hard Drive Hardware Kit, spare part number 730539-001.

690650-001

HP USB 3.0 port replicator

690652-001

USB 3.0 type A connector to type B connector cable (0.5-m long)

691740-001

4-GB memory module (PCL3, 12800, 1600-MHz)

691922-001

HP comfort-grip wireless mouse

693374-001

4-GB memory module (PCL3, 12800, 1600-MHz)

693710-001

65-W HP Smart adapter (EM, RC/V, 3-wire, 4.5-mm)

693711-001

65-W HP Smart adapter (non-PFC, 3-wire, 4.5-mm)

693716-001

65-W HP Smart travel adapter (non-PFC)

697316-001

Broadcom BCM943228HMB 802.11 a/b/g/n 2×2 Wi-Fi + Bluetooth 4.0 Combo Adapter for use
only on computer models equipped with an Intel processor

702853-001

RTC battery (includes cable and double-sided adhesive)

703267-001

500-GB, 7200-rpm, SATA, 7.0-mm hard drive for use on all computer models (does not include
hard drive bracket, hard drive connector adapter, or screws)
NOTE: The hard drive bracket, hard drive connector adapter, and screws are included in
the Hard Drive Hardware Kit, spare part number 730539-001.

703268-001

500-GB, 7200-rpm, SED, 7.0-mm hard drive for use on all computer models (does not include hard
drive bracket, hard drive connector adapter, or screws)
NOTE: The hard drive bracket, hard drive connector adapter, and screws are included in
the Hard Drive Hardware Kit, spare part number 730539-001.

ENWW

703372-001

HP ultraslim keyed cable lock

704030-001

HP lt4111 LTE/EV-DO/HSPA+ Mobile Broadband Module for use only on computer models
equipped with an Intel processor

704031-001

HP lt4112 LTE/HSPA+ Mobile Broadband Module for use only on computer models equipped with
an Intel processor

705621-001

HP professional top-load carrying case

710661-001

Intel Dual Band Wireless-AC 7260 802.11 ac 2×2 WiFi + Bluetooth 4.0 WLAN module for use
only on computer models equipped with an Intel processor

714749-001

HP Mobile Connect SIM module

717377-001

3-cell, 26-WHr, 2.50-AHr, Li-ion battery

717378-001

3-cell, 46-WHr, 4.15-AHr, Li-ion battery

717381-001

Intel Dual Band Wireless-N 7260AN 802.11 a/b/g/n 2×2 WiFi + Bluetooth 4.0 Combo Adapter
for use only on computer models equipped with an Intel processor

Sequential part number listing
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50

Spare part number

Description

717382-001

Intel Dual Band Wireless-N 7260NB 802.11 a/b/g/n 2×2 WiFi adapter for use only on computer
models equipped with an Intel processor

718549-001

HP business slim top-load carrying case

718550-001

HP business top-load carrying case

721092-001

45-W HP Smart adapter (non-PFC, RC, 3-wire, 4.5-mm)

723895-001

HP hs3110 HSPA+ Mobile Broadband Module

724935-001

Broadcom BCM4352 802.11 ac 2×2 Wi-Fi + Bluetooth 4.0 Combo Adapter for use only on
computer models equipped with an AMD processor

730535-001

12.5-in, AG, HD, LED, SVA non-TouchScreen display panel for use only on computer models
equipped with an Intel processor

730536-001

12.5-in, AG, HD, LED, UWVA non-TouchScreen display panel for use only on computer models
equipped with an Intel processor

730537-001

Display Cable Kit (includes display panel cable and webcam/microphone module cable)

730538-001

Display Panel Support Kit for use only on computer models equipped with an Intel processor
(includes display enclosure, WLAN antenna cables and transceivers, and WWAN antenna cables
and transceivers)

730539-001

Hard Drive Hardware Kit (includes hard drive bracket, hard drive connector adapter, and screws)

730540-001

Keyboard with pointing stick for use only on computer models equipped with an Intel processor in
the United States (includes keyboard cable)

730540-031

Keyboard with pointing stick for use only on computer models equipped with an Intel processor in
the United Kingdom and Singapore (includes keyboard cable)

730540-041

Keyboard with pointing stick for use only on computer models equipped with an Intel processor in
France (includes keyboard cable)

730540-051

Keyboard with pointing stick for use only on computer models equipped with an Intel processor in
Germany (includes keyboard cable)

730540-061

Keyboard with pointing stick for use only on computer models equipped with an Intel processor in
Italy (includes keyboard cable)

730540-071

Keyboard with pointing stick for use only on computer models equipped with an Intel processor in
Spain (includes keyboard cable)

730540-081

Keyboard with pointing stick for use only on computer models equipped with an Intel processor in
Denmark (includes keyboard cable)

730540-091

Keyboard with pointing stick for use only on computer models equipped with an Intel processor in
Norway (includes keyboard cable)

730540-131

Keyboard with pointing stick for use only on computer models equipped with an Intel processor in
Portugal (includes keyboard cable)

730540-141

Keyboard with pointing stick for use only on computer models equipped with an Intel processor in
Turkey (includes keyboard cable)

730540-151

Keyboard with pointing stick for use only on computer models equipped with an Intel processor in
Greece (includes keyboard cable)
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Spare part number

Description

730540-161

Keyboard with pointing stick for use only on computer models equipped with an Intel processor in
Latin America (includes keyboard cable)

730540-171

Keyboard with pointing stick for use only on computer models equipped with an Intel processor in
Saudi Arabia (includes keyboard cable)

730540-201

Keyboard with pointing stick for use only on computer models equipped with an Intel processor in
Brazil (includes keyboard cable)

730540-211

Keyboard with pointing stick for use only on computer models equipped with an Intel processor in
Hungary (includes keyboard cable)

730540-251

Keyboard with pointing stick for use only on computer models equipped with an Intel processor in
Russia (includes keyboard cable)

730540-261

Keyboard with pointing stick for use only on computer models equipped with an Intel processor in
Bulgaria (includes keyboard cable)

730540-271

Keyboard with pointing stick for use only on computer models equipped with an Intel processor in
Romania (includes keyboard cable)

730540-281

Keyboard with pointing stick for use only on computer models equipped with an Intel processor in
Thailand (includes keyboard cable)

730540-291

Keyboard with pointing stick for use only on computer models equipped with an Intel processor in
Japan (includes keyboard cable)

730540-A41

Keyboard with pointing stick for use only on computer models equipped with an Intel processor in
Belgium (includes keyboard cable)

730540-AB1

Keyboard with pointing stick for use only on computer models equipped with an Intel processor in
Taiwan (includes keyboard cable)

730540-AD1

Keyboard with pointing stick for use only on computer models equipped with an Intel processor in
South Korea (includes keyboard cable)

730540-B31

Keyboard with pointing stick for use only on computer models equipped with an Intel processor in
the Netherlands (includes keyboard cable)

730540-B71

Keyboard with pointing stick for use only on computer models equipped with an Intel processor in
Sweden and Finland (includes keyboard cable)

730540-BA1

Keyboard with pointing stick for use only on computer models equipped with an Intel processor in
Slovenia (includes keyboard cable)

730540-BB1

Keyboard with pointing stick for use only on computer models equipped with an Intel processor in
Israel (includes keyboard cable)

730540-BG1

Keyboard with pointing stick for use only on computer models equipped with an Intel processor in
Switzerland (includes keyboard cable)

730540-D61

Keyboard with pointing stick for use only on computer models equipped with an Intel processor in
India (includes keyboard cable)

730540-DB1

Keyboard with pointing stick for use only on computer models equipped with an Intel processor in
Canada (includes keyboard cable)

730540-DD1

Keyboard with pointing stick for use only on computer models equipped with an Intel processor in
Iceland (includes keyboard cable)
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730540-FL1

Keyboard with pointing stick for use only on computer models equipped with an Intel processor
in the Czech Republic and Slovakia (includes keyboard cable)

730540-FP1

Keyboard with pointing stick for use only on computer models equipped with an Intel processor
in Northwest Africa (includes keyboard cable)

730541-001

Keyboard with backlight and pointing stick for use only on computer models equipped with an
Intel processor in the United States (includes backlight cable and keyboard cable)

730541-031

Keyboard with backlight and pointing stick for use only on computer models equipped with an
Intel processor in the United Kingdom and Singapore (includes backlight cable and
keyboard cable)

730541-041

Keyboard with backlight and pointing stick for use only on computer models equipped with an
Intel processor in France (includes backlight cable and keyboard cable)

730541-051

Keyboard with backlight and pointing stick for use only on computer models equipped with an
Intel processor in Germany (includes backlight cable and keyboard cable)

730541-061

Keyboard with backlight and pointing stick for use only on computer models equipped with an
Intel processor in Italy (includes backlight cable and keyboard cable)

730541-071

Keyboard with backlight and pointing stick for use only on computer models equipped with an
Intel processor in Spain (includes backlight cable and keyboard cable)

730541-081

Keyboard with backlight and pointing stick for use only on computer models equipped with an
Intel processor in Denmark (includes backlight cable and keyboard cable)

730541-091

Keyboard with backlight and pointing stick for use only on computer models equipped with an
Intel processor in Norway (includes backlight cable and keyboard cable)

730541-131

Keyboard with backlight and pointing stick for use only on computer models equipped with an
Intel processor in Portugal (includes backlight cable and keyboard cable)

730541-141

Keyboard with backlight and pointing stick for use only on computer models equipped with an
Intel processor in Turkey (includes backlight cable and keyboard cable)

730541-151

Keyboard with backlight and pointing stick for use only on computer models equipped with an
Intel processor in Greece (includes backlight cable and keyboard cable)

730541-161

Keyboard with backlight and pointing stick for use only on computer models equipped with an
Intel processor in Latin America (includes backlight cable and keyboard cable)

730541-171

Keyboard with backlight and pointing stick for use only on computer models equipped with an
Intel processor in Saudi Arabia (includes backlight cable and keyboard cable)

730541-201

Keyboard with backlight and pointing stick for use only on computer models equipped with an
Intel processor in Brazil (includes backlight cable and keyboard cable)

730541-211

Keyboard with backlight and pointing stick for use only on computer models equipped with an
Intel processor in Hungary (includes backlight cable and keyboard cable)

730541-251

Keyboard with backlight and pointing stick for use only on computer models equipped with an
Intel processor in Russia (includes backlight cable and keyboard cable)

730541-261

Keyboard with backlight and pointing stick for use only on computer models equipped with an
Intel processor in Bulgaria (includes backlight cable and keyboard cable)

730541-271

Keyboard with backlight and pointing stick for use only on computer models equipped with an
Intel processor in Romania (includes backlight cable and keyboard cable)
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730541-281

Keyboard with backlight and pointing stick for use only on computer models equipped with an
Intel processor in Thailand (includes backlight cable and keyboard cable)

730541-291

Keyboard with backlight and pointing stick for use only on computer models equipped with an
Intel processor in Japan (includes backlight cable and keyboard cable)

730541-A41

Keyboard with backlight and pointing stick for use only on computer models equipped with an
Intel processor in Belgium (includes backlight cable and keyboard cable)

730541-AB1

Keyboard with backlight and pointing stick for use only on computer models equipped with an
Intel processor in Taiwan (includes backlight cable and keyboard cable)

730541-AD1

Keyboard with backlight and pointing stick for use only on computer models equipped with an
Intel processor in South Korea (includes backlight cable and keyboard cable)

730541-B31

Keyboard with backlight and pointing stick for use only on computer models equipped with an
Intel processor in the Netherlands (includes backlight cable and keyboard cable)

730541-B71

Keyboard with backlight and pointing stick for use only on computer models equipped with an
Intel processor in Sweden and Finland (includes backlight cable and keyboard cable)

730541-BA1

Keyboard with backlight and pointing stick for use only on computer models equipped with an
Intel processor in Slovenia (includes backlight cable and keyboard cable)

730541-BB1

Keyboard with backlight and pointing stick for use only on computer models equipped with an
Intel processor in Israel (includes backlight cable and keyboard cable)

730541-BG1

Keyboard with backlight and pointing stick for use only on computer models equipped with an
Intel processor in Switzerland (includes backlight cable and keyboard cable)

730541-D61

Keyboard with backlight and pointing stick for use only on computer models equipped with an
Intel processor in India (includes backlight cable and keyboard cable)

730541-DB1

Keyboard with backlight and pointing stick for use only on computer models equipped with an
Intel processor in Canada (includes backlight cable and keyboard cable)

730541-DD1

Keyboard with backlight and pointing stick for use only on computer models equipped with an
Intel processor in Iceland (includes backlight cable and keyboard cable)

730541-FL1

Keyboard with backlight and pointing stick for use only on computer models equipped with an
Intel processor in the Czech Republic and Slovakia (includes backlight cable and keyboard cable)

730541-FP1

Keyboard with backlight and pointing stick for use only on computer models equipped with an
Intel processor in Northwest Africa (includes backlight cable and keyboard cable)

730542-001

Webcam/microphone module for use only on computer models equipped with an Intel processor
(includes double-sided adhesive)

730543-001

Display Hinge Kit for use only on computer models equipped with an Intel processor (includes left
and right hinges and hinge brackets)

730544-001

Display bezel for use only on computer models equipped with an Intel processor

730547-001

Fan for use only on computer models equipped with an Intel processor (includes cable)

730548-001

Top cover for use only on computer models equipped with an Intel processor

730549-001

TouchPad (includes cable)

730550-001

Rubber Kit (includes base enclosure rubber screw covers)
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730551-001

Base enclosure for use only on computer models equipped with an Intel processor (includes RJ-45
cover, rubber feet, and service cover eject latch assembly)

730552-001

Power button board (includes cable)

730553-001

Screw Kit

730554-001

Fingerprint reader board (includes bracket and cable)

730555-001

Speaker assembly (includes left and right speakers and cables)

730556-001

Heat sink for use only on computer models equipped with an Intel processor (includes replacement
thermal material)

730557-001

System board equipped with an Intel Core i3-4010U 1.70-GHz processor (3.00-MB L3 cache,
15 W), a graphics subsystem with UMA memory, and a non-Windows 8 operating system for use
only on computer models equipped with a non-TouchScreen display assembly(includes replacement
thermal material)

730557-501

System board equipped with an Intel Core i3-4010U 1.70-GHz processor (3.00-MB L3 cache,
15 W), a graphics subsystem with UMA memory, and the Windows 8 Standard operating system
for use only on computer models equipped with a non-TouchScreen display assembly
(includes replacement thermal material)

730557-601

System board equipped with an Intel Core i3-4010U 1.70-GHz processor (3.00-MB L3 cache,
15 W), a graphics subsystem with UMA memory, and the Windows 8 Professional
operating system for use only on computer models equipped with a non-TouchScreen display
assembly (includes replacement thermal material)

730558-001

System board equipped with an Intel Core i5-4200U 1.60-GHz (SC turbo up to 2.60GHz) processor (3.00-MB L3 cache, 15 W), a graphics subsystem with UMA memory, and a nonWindows 8 operating system for use only on computer models equipped with a non-TouchScreen
display assembly (includes replacement thermal material)

730558-501

System board equipped with an Intel Core i5-4200U 1.60-GHz (SC turbo up to 2.60GHz) processor (3.00-MB L3 cache, 15 W), a graphics subsystem with UMA memory, and
the Windows 8 Standard operating system for use only on computer models equipped with a nonTouchScreen display assembly (includes replacement thermal material)

730558-601

System board equipped with an Intel Core i5-4200U 1.60-GHz (SC turbo up to 2.60GHz) processor (3.00-MB L3 cache, 15 W), a graphics subsystem with UMA memory, and
the Windows 8 Professional operating system for use only on computer models equipped with a
non-TouchScreen display assembly (includes replacement thermal material)

730559-001

System board equipped with an Intel Core i7-4600U 2.10-GHz (SC turbo up to 3.30GHz) processor (4.00-MB L3 cache, 15 W), a graphics subsystem with UMA memory, and a nonWindows 8 operating system for use only on computer models equipped with a non-TouchScreen
display assembly (includes replacement thermal material)

730559-501

System board equipped with an Intel Core i7-4600U 2.10-GHz (SC turbo up to 3.30GHz) processor (4.00-MB L3 cache, 15 W), a graphics subsystem with UMA memory, and
the Windows 8 Standard operating system for use only on computer models equipped with a nonTouchScreen display assembly (includes replacement thermal material)

730559-601

System board equipped with an Intel Core i7-4600U 2.10-GHz (SC turbo up to 3.30GHz) processor (4.00-MB L3 cache, 15 W), a graphics subsystem with UMA memory, and
the Windows 8 Professional operating system for use only on computer models equipped with a
non-TouchScreen display assembly (includes replacement thermal material)
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730560-001

Antenna Kit for use only on computer models equipped with an Intel processor (includes WLAN
antenna cables and transceivers and WWAN antenna cables and transceivers)

730561-001

Display enclosure for use only on computer models equipped with an Intel processor

730562-001

Plastics Kit

730563-001

Card reader board (includes cable)

730564-001

Service cover with CCCO mark for use only on computer models equipped with an Intel processor
(includes rubber feet)

730565-001

180-GB, SATA-3 solid-state drive for use only on computer models equipped with an Intel processor

730566-001

240-GB, SATA-3 solid-state drive for use only on computer models equipped with an Intel processor

730567-001

256-GB, SATA-3, SED solid-state drive for use only on computer models equipped with an
Intel processor

730568-001

120-GB, mSATA-3 solid-state drive for use only on computer models equipped with an
Intel processor

730668-001

Broadcom BCM943228HMB 802.11 abgn 2×2 Wi-Fi Adapter, Broadcom Bluetooth 4.0 Adapter
for use only on computer models equipped with an AMD processor

730795-001

Microphone module

730946-001

500-GB, 5400-rpm, SATA, FIPS 7.0-mm hard drive for use on all computer models (does not
include hard drive bracket, hard drive connector adapter, or screws)
NOTE: The hard drive bracket, hard drive connector adapter, and screws are included in
the Hard Drive Hardware Kit, spare part number 730539-001.
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731066-001

System board equipped with an Intel Core i5-4300U 1.90-GHz (SC turbo up to 2.90GHz) processor (3.00-MB L3 cache, 15 W), a graphics subsystem with UMA memory, and a nonWindows 8 operating system for use only on computer models equipped with a non-TouchScreen
display assembly (includes replacement thermal material)

731066-501

System board equipped with an Intel Core i5-4300U 1.90-GHz (SC turbo up to 2.90GHz) processor (3.00-MB L3 cache, 15 W), a graphics subsystem with UMA memory, and
the Windows 8 Standard operating system for use only on computer models equipped with a nonTouchScreen display assembly (includes replacement thermal material)

731066-601

System board equipped with an Intel Core i5-4300U 1.90-GHz (SC turbo up to 2.90GHz) processor (3.00-MB L3 cache, 15 W), a graphics subsystem with UMA memory, and
the Windows 8 Professional operating system for use only on computer models equipped with a
non-TouchScreen display assembly (includes replacement thermal material)

732252-001

HP 2013 UltraSlim Docking Station

736675-001

HP lt4226 LTE/HSPA+4G Module for use only on computer models equipped with an
Intel processor

736676-001

HP lt4225 LTE/EV-DO4G Module for use only on computer models equipped with an
Intel processor

740011-001

HP lt4112 LTE/HPSA+ Mobile Broadband Module for use only on computer models equipped with
an AMD processor

742437-001

45-W HP Smart adapter (non-PFC, RC, 2-wire, 4.5-mm)

743008-001

32-GB, SATA-3 solid-state drive for use only on computer models equipped with an Intel processor
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744716-001

128-GB, SATA-3 solid-state drive for use only on computer models equipped with an Intel processor

744893-001

45-W HP Smart adapter (non-PFC, RC, 7.4-mm)

745308-001

Service cover for use only on computer models equipped with an Intel processor and nonTouchScreen display assembly (includes rubber feet)

747832-001

Intel Dual Band Wireless-N 7260AN 802.11 a/b/g/n 2×2 WiFi + Bluetooth 4.0 Combo Adapter
for use only on computer models equipped with an Intel processor

748021-001

HP lt4111 LTE/EV-DO/HSPA+ Mobile Broadband Module for use only on computer models
equipped with an AMD processor

748599-001

HP hs3110 HSPA+ Mobile Broadband Module for use only on computer models equipped with an
AMD processor

749288-001

HP DisplayPort-to-HDMI 1.4 adapter

752103-001

512-GB, SATA-3 solid-state drive for use only on computer models equipped with an Intel processor

753071-001

System board equipped with an Intel Core i7-4500U 1.80-GHz (SC turbo up to 3.00GHz) processor (4.00-MB L3 cache, 15 W), a graphics subsystem with UMA memory, and a nonWindows 8 Professional operating system for use only on computer models equipped with a nonTouchScreen display assembly (includes replacement thermal material)

753071-501

System board equipped with an Intel Core i7-4500U 1.80-GHz (SC turbo up to 3.00GHz) processor (4.00-MB L3 cache, 15 W), a graphics subsystem with UMA memory, and the
Windows 8 Standard operating system for use only on computer models equipped with a nonTouchScreen display assembly (includes replacement thermal material)

753071-601

System board equipped with an Intel Core i7-4500U 1.80-GHz (SC turbo up to 3.00GHz) processor (4.00-MB L3 cache, 15 W), a graphics subsystem with UMA memory, and the
Windows 8 Professional operating system for use only on computer models equipped with a nonTouchScreen display assembly (includes replacement thermal material)

755530-001

Power cord for use in North America (3-pin, black, 1.00-m)

755530-011

Power cord for use in Australia (3-pin, black, 1.00-m)

755530-021

Power cord for use in Europe (3-pin, black, 1.00-m)

755530-031

Power cord for use in the United Kingdom and Singapore (3-pin, black, 1.00-m)

755530-061

Power cord for use in Italy (3-pin, black, 1.00-m)

755530-081

Power cord for use in Denmark (3-pin, black, 1.00-m)

755530-111

Power cord for use in Switzerland (3-pin, black, 1.00-m)

755530-201

Power cord for use in Thailand (3-pin, black, 1.00-m)

755530-202

Power cord for use in Brazil (3-pin, black, 1.00-m)

755530-291

Power cord for use in Japan (3-pin, black, 1.00-m)

755530-AA1

Power cord for use in the People's Republic of China (3-pin, black, 1.00-m)

755530-AB1

Power cord for use in Taiwan (3-pin, black, 1.00-m)

755530-AD1

Power cord for use in South Korea (3-pin, black, 1.00-m)

755530-AR1

Power cord for use in South Africa (3-pin, black, 1.00-m)
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755530-BB1

Power cord for use in Israel (3-pin, black, 1.00-m)

755530-D01

Power cord for use in Argentina (3-pin, black, 1.00-m)

755530-D61

Power cord for use in India (3-pin, black, 1.00-m)

761774-001

System board equipped with an Intel Core i3-4010U 1.70-GHz processor (3.00-MB L3 cache,
15 W), a graphics subsystem with UMA memory, and a non-Windows 8 operating system for use
only on computer models equipped with a TouchScreen display assembly (includes replacement
thermal material)

761774-501

System board equipped with an Intel Core i3-4010U 1.70-GHz processor (3.00-MB L3 cache,
15 W), a graphics subsystem with UMA memory, and the Windows 8 Standard operating system
for use only on computer models equipped with a TouchScreen display assembly
(includes replacement thermal material)

761774-601

System board equipped with an Intel Core i3-4010U 1.70-GHz processor (3.00-MB L3 cache,
15 W), a graphics subsystem with UMA memory, and the Windows 8 Professional
operating system for use only on computer models equipped with a TouchScreen display assembly
(includes replacement thermal material)

761775-001

System board equipped with an Intel Core i5-4200U 1.60-GHz (SC turbo up to 2.60GHz) processor (3.00-MB L3 cache, 15 W), a graphics subsystem with UMA memory, and a nonWindows 8 operating system for use only on computer models equipped with a TouchScreen
display assembly (includes replacement thermal material)

761775-501

System board equipped with an Intel Core i5-4200U 1.60-GHz (SC turbo up to 2.60GHz) processor (3.00-MB L3 cache, 15 W), a graphics subsystem with UMA memory, and the
Windows 8 Standard operating system for use only on computer models equipped with a
TouchScreen display assembly (includes replacement thermal material)

761775-601

System board equipped with an Intel Core i5-4200U 1.60-GHz (SC turbo up to 2.60GHz) processor (3.00-MB L3 cache, 15 W), a graphics subsystem with UMA memory, and the
Windows 8 Professional operating system for use only on computer models equipped with a
TouchScreen display assembly (includes replacement thermal material)

761776-001

System board equipped with an Intel Core i5-4300U 1.90-GHz (SC turbo up to 2.90GHz) processor (3.00-MB L3 cache, 15 W), a graphics subsystem with UMA memory, and a nonWindows 8 operating system for use only on computer models equipped with a TouchScreen
display assembly (includes replacement thermal material)

761776-501

System board equipped with an Intel Core i5-4300U 1.90-GHz (SC turbo up to 2.90GHz) processor (3.00-MB L3 cache, 15 W), a graphics subsystem with UMA memory, and the
Windows 8 Standard operating system for use only on computer models equipped with a
TouchScreen display assembly (includes replacement thermal material)

761776-601

System board equipped with an Intel Core i5-4300U 1.90-GHz (SC turbo up to 2.90GHz) processor (3.00-MB L3 cache, 15 W), a graphics subsystem with UMA memory, and the
Windows 8 Professional operating system for use only on computer models equipped with a
TouchScreen display assembly (includes replacement thermal material)

761777-001

System board equipped with an Intel Core i7-4500U 1.80-GHz (SC turbo up to 3.00GHz) processor (4.00-MB L3 cache, 15 W), a graphics subsystem with UMA memory, and a nonWindows 8 operating system for use only on computer models equipped with a TouchScreen
display assembly (includes replacement thermal material)

761777-501

System board equipped with an Intel Core i7-4500U 1.80-GHz (SC turbo up to 3.00GHz) processor (4.00-MB L3 cache, 15 W), a graphics subsystem with UMA memory, and the
Windows 8 Standard operating system for use only on computer models equipped with a
TouchScreen display assembly (includes replacement thermal material)
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761777-601

System board equipped with an Intel Core i7-4500U 1.80-GHz (SC turbo up to 3.00GHz) processor (4.00-MB L3 cache, 15 W), a graphics subsystem with UMA memory, and the
Windows 8 Professional operating system for use only on computer models equipped with a
TouchScreen display assembly (includes replacement thermal material)

761778-001

System board equipped with an Intel Core i7-4600U 2.10-GHz (SC turbo up to 3.10GHz) processor (4.00-MB L3 cache, 15 W), a graphics subsystem with UMA memory, and a nonWindows 8 operating system for use only on computer models equipped with a TouchScreen
display assembly (includes replacement thermal material)

761778-501

System board equipped with an Intel Core i7-4600U 2.10-GHz (SC turbo up to 3.10GHz) processor (4.00-MB L3 cache, 15 W), a graphics subsystem with UMA memory, and the
Windows 8 Standard operating system for use only on computer models equipped with a
TouchScreen display assembly (includes replacement thermal material)

761778-601

System board equipped with an Intel Core i7-4600U 2.10-GHz (SC turbo up to 3.10GHz) processor (4.00-MB L3 cache, 15 W), a graphics subsystem with UMA memory, and the
Windows 8 Professional operating system for use only on computer models equipped with a
TouchScreen display assembly (includes replacement thermal material)

761780-001

Service cover for use only on computer models equipped with an Intel processor and TouchScreen
display assembly (includes rubber feet)

761781-001

12.5-in, AG, HD, LED, UWVA, TouchScreen display assembly for use only on computer models
equipped with an Intel processor

761906-001

256-GB, SATA-3, SED, Opal 2, solid-state drive for use only on computer models equipped with an
Intel processor

762689-291

Power cord for use in Japan (2-pin, black, 1.00-m)

762990-001

1-TB, 5400-rpm, 7.0-mm hard drive for use only on computer models equipped with an
AMD processor (does not include hard drive bracket, hard drive connector adapter, or screws)
NOTE: The hard drive bracket, hard drive connector adapter, and screws are included in
the Hard Drive Hardware Kit, spare part number 730539-001.

763522-001

500-GB, 5400-rpm, SATA, locked, 7.0-mm hard drive for use only on computer models equipped
with an Intel processor (does not include hard drive bracket, hard drive connector adapter,
or screws)
NOTE: The hard drive bracket, hard drive connector adapter, and screws are included in
the Hard Drive Hardware Kit, spare part number 730539-001.

58

764507-001

128-GB, SATA-3, locked, Opal 2, solid-state drive for use only on computer models equipped with
an Intel processor

765603-001

Base enclosure for use only on computer models equipped with an AMD processor (includes RJ-45
cover, rubber feet, and service cover eject latch assembly)

765605-001

Heat sink for use only on computer models equipped with an AMD processor (includes replacement
thermal material)

765606-001

12.5-in, AG, FHD, LED, UWVA, TouchScreen display assembly for use only on computer models
equipped with an AMD processor

765607-001

12.5-in, AG, FHD, LED, SVA non-TouchScreen display panel for use only on computer models
equipped with an AMD processor

765609-001

128-GB, SATA-3 solid-state drive for use only on computer models equipped with an
AMD processor
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765610-001

180-GB, SATA-3 solid-state drive for use only on computer models equipped with an
AMD processor

765611-001

180-GB, SATA-3, SED, OPAL-1 solid-state drive for use only on computer models equipped with an
AMD processor

765612-001

240-GB, SATA-3 solid-state drive for use only on computer models equipped with an
AMD processor

765613-001

256-GB, SATA-3, SED, OPAL-1 solid-state drive for use only on computer models equipped with an
AMD processor

765614-001

256-GB, SATA-3, SED, OPAL-2 solid-state drive for use only on computer models equipped with an
AMD processor

765615-001

System board equipped with an AMD A6 Pro-7050B 2.20-GHz (SC turbo up to 3.00-GHz) dual
core processor (1.00-MB L2 cache, 17 W), a graphics subsystem with UMA memory, and a nonWindows 8 operating system (includes replacement thermal material)

765615-501

System board equipped with an AMD A6 Pro-7050B 2.20-GHz (SC turbo up to 3.00-GHz) dual
core processor (1.00-MB L2 cache, 17 W), a graphics subsystem with UMA memory, and the
Windows 8 Standard operating system (includes replacement thermal material)

765615-601

System board equipped with an AMD A6 Pro-7050B 2.20-GHz (SC turbo up to 3.00-GHz) dual
core processor (1.00-MB L2 cache, 17 W), a graphics subsystem with UMA memory, and the
Windows 8 Professional operating system (includes replacement thermal material)

765616-001

System board equipped with an AMD A8 Pro-7150B 2.00-GHz (SC turbo up to 3.20-GHz) quad
core processor (4.00-MB L2 cache, 19 W), a graphics subsystem with UMA memory, and a nonWindows 8 operating system (includes replacement thermal material)

765616-501

System board equipped with an AMD A8 Pro-7150B 2.00-GHz (SC turbo up to 3.20-GHz) quad
core processor (4.00-MB L2 cache, 19 W), a graphics subsystem with UMA memory, and the
Windows 8 Standard operating system (includes replacement thermal material)

765616-601

System board equipped with an AMD A8 Pro-7150B 2.00-GHz (SC turbo up to 3.20-GHz) quad
core processor (4.00-MB L2 cache, 19 W), a graphics subsystem with UMA memory, and the
Windows 8 Professional operating system (includes replacement thermal material)

765617-001

System board equipped with an AMD A10 Pro-7350B 2.10-GHz (SC turbo up to 3.30-GHz) quad
core processor (4.00-MB L2 cache, 19 W), a graphics subsystem with UMA memory, and a nonWindows 8 operating system (includes replacement thermal material)

765617-501

System board equipped with an AMD A10 Pro-7350B 2.10-GHz (SC turbo up to 3.30-GHz) quad
core processor (4.00-MB L2 cache, 19 W), a graphics subsystem with UMA memory, and the
Windows 8 Standard operating system (includes replacement thermal material)

765617-601

System board equipped with an AMD A10 Pro-7350B 2.10-GHz (SC turbo up to 3.30-GHz) quad
core processor (4.00-MB L2 cache, 19 W), a graphics subsystem with UMA memory, and the
Windows 8 Professional operating system (includes replacement thermal material)

766012-001

Display bezel for use only on computer models equipped with an AMD processor

766018-001

Service cover for use only on computer models equipped with an AMD processor
(includes rubber feet)

766679-001

128-GB, SATA-3, locked, solid-state drive for use only on computer models equipped with an
Intel processor

775247-001

180-GB, SATA-3, SED, Opal 1, solid-state drive for use only on computer models equipped with an
Intel processor

Sequential part number listing
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Spare part number

Description

775893-001

Display enclosure for use only on computer models equipped with an AMD processor

775894-001

Antenna Kit for use only on computer models equipped with an AMD processor (WLAN
antenna cables and transceivers and WWAN antenna cables and transceivers)

775895-001

Display Hinge Kit for use only on computer models equipped with an AMD processor (includes left
and right hinges and hinge brackets)

775896-001

Display bezel for use only on computer models equipped with an AMD processor

775897-001

Display Panel Support Kit for use only on computer models equipped with an AMD processor
(includes display enclosure, WLAN antenna cables and transceivers, and WWAN antenna cables
and transceivers)

776451-001

Keyboard with pointing stick for use only on computer models equipped with an AMD processor in
the United States (includes keyboard cable)

776451-031

Keyboard with pointing stick for use only on computer models equipped with an AMD processor in
the United Kingdom (includes keyboard cable)

776451-041

Keyboard with pointing stick for use only on computer models equipped with an AMD processor in
Germany (includes keyboard cable)

776451-051

Keyboard with pointing stick for use only on computer models equipped with an AMD processor in
France (includes keyboard cable)

776451-061

Keyboard with pointing stick for use only on computer models equipped with an AMD processor in
Italy (includes keyboard cable)

776451-071

Keyboard with pointing stick for use only on computer models equipped with an AMD processor in
Spain (includes keyboard cable)

776451-081

Keyboard with pointing stick for use only on computer models equipped with an AMD processor in
Denmark (includes keyboard cable)

776451-091

Keyboard with pointing stick for use only on computer models equipped with an AMD processor in
Norway (includes keyboard cable)

776451-131

Keyboard with pointing stick for use only on computer models equipped with an AMD processor in
Portugal (includes keyboard cable)

776451-141

Keyboard with pointing stick for use only on computer models equipped with an AMD processor in
Turkey (includes keyboard cable)

776451-151

Keyboard with pointing stick for use only on computer models equipped with an AMD processor in
Greece (includes keyboard cable)

776451-161

Keyboard with pointing stick for use only on computer models equipped with an AMD processor in
Latin America (includes keyboard cable)

776451-171

Keyboard with pointing stick for use only on computer models equipped with an AMD processor in
Saudi Arabia (includes keyboard cable)

776451-201

Keyboard with pointing stick for use only on computer models equipped with an AMD processor in
Brazil (includes keyboard cable)

776451-211

Keyboard with pointing stick for use only on computer models equipped with an AMD processor in
Hungary (includes keyboard cable)

776451-251

Keyboard with pointing stick for use only on computer models equipped with an AMD processor in
Russia (includes keyboard cable)
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Spare part number

Description

776451-261

Keyboard with pointing stick for use only on computer models equipped with an AMD processor in
Bulgaria (includes keyboard cable)

776451-271

Keyboard with pointing stick for use only on computer models equipped with an AMD processor in
Romania (includes keyboard cable)

776451-281

Keyboard with pointing stick for use only on computer models equipped with an AMD processor in
Thailand (includes keyboard cable)

776451-291

Keyboard with pointing stick for use only on computer models equipped with an AMD processor in
Japan (includes keyboard cable)

776451-A41

Keyboard with pointing stick for use only on computer models equipped with an AMD processor in
Belgium (includes keyboard cable)

776451-AB1

Keyboard with pointing stick for use only on computer models equipped with an AMD processor in
Taiwan (includes keyboard cable)

776451-AD1

Keyboard with pointing stick for use only on computer models equipped with an AMD processor in
South Korea (includes keyboard cable)

776451-B31

Keyboard with pointing stick for use only on computer models equipped with an AMD processor in
the Netherlands (includes keyboard cable)

776451-B71

Keyboard with pointing stick for use only on computer models equipped with an AMD processor in
Sweden and Finland (includes keyboard cable)

776451-BA1

Keyboard with pointing stick for use only on computer models equipped with an AMD processor in
Slovenia (includes keyboard cable)

776451-BB1

Keyboard with pointing stick for use only on computer models equipped with an AMD processor in
Israel (includes keyboard cable)

776451-BG1

Keyboard with pointing stick for use only on computer models equipped with an AMD processor in
Switzerland (includes keyboard cable)

776451-D61

Keyboard with pointing stick for use only on computer models equipped with an AMD processor in
India (includes keyboard cable)

776451-DB1

Keyboard with pointing stick for use only on computer models equipped with an AMD processor in
Canada (includes keyboard cable)

776451-DD1

Keyboard with pointing stick for use only on computer models equipped with an AMD processor in
Iceland (includes keyboard cable)

776451-FL1

Keyboard with pointing stick for use only on computer models equipped with an AMD processor in
the Czech Republic and Slovakia (includes keyboard cable)

776451-FP1

Keyboard with pointing stick for use only on computer models equipped with an AMD processor in
Northwest Africa (includes keyboard cable)

776452-001

Keyboard with backlight and pointing stick for use only on computer models equipped with an
AMD processor in the United States (includes backlight cable and keyboard cable)

776452-031

Keyboard with backlight and pointing stick for use only on computer models equipped with an
AMD processor in the United Kingdom (includes backlight cable and keyboard cable)

776452-041

Keyboard with backlight and pointing stick for use only on computer models equipped with an
AMD processor in Germany (includes backlight cable and keyboard cable)
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776452-051

Keyboard with backlight and pointing stick for use only on computer models equipped with an
AMD processor in France (includes backlight cable and keyboard cable)

776452-061

Keyboard with backlight and pointing stick for use only on computer models equipped with an
AMD processor in Italy (includes backlight cable and keyboard cable)

776452-071

Keyboard with backlight and pointing stick for use only on computer models equipped with an
AMD processor in Spain (includes backlight cable and keyboard cable)

776452-081

Keyboard with backlight and pointing stick for use only on computer models equipped with an
AMD processor in Denmark (includes backlight cable and keyboard cable)

776452-091

Keyboard with backlight and pointing stick for use only on computer models equipped with an
AMD processor in Norway (includes backlight cable and keyboard cable)

776452-131

Keyboard with backlight and pointing stick for use only on computer models equipped with an
AMD processor in Portugal (includes backlight cable and keyboard cable)

776452-141

Keyboard with backlight and pointing stick for use only on computer models equipped with an
AMD processor in Turkey (includes backlight cable and keyboard cable)

776452-151

Keyboard with backlight and pointing stick for use only on computer models equipped with an
AMD processor in Greece (includes backlight cable and keyboard cable)

776452-161

Keyboard with backlight and pointing stick for use only on computer models equipped with an
AMD processor in Latin America (includes backlight cable and keyboard cable)

776452-171

Keyboard with backlight and pointing stick for use only on computer models equipped with an
AMD processor in Saudi Arabia (includes backlight cable and keyboard cable)

776452-201

Keyboard with backlight and pointing stick for use only on computer models equipped with an
AMD processor in Brazil (includes backlight cable and keyboard cable)

776452-211

Keyboard with backlight and pointing stick for use only on computer models equipped with an
AMD processor in Hungary (includes backlight cable and keyboard cable)

776452-251

Keyboard with backlight and pointing stick for use only on computer models equipped with an
AMD processor in Russia (includes backlight cable and keyboard cable)

776452-271

Keyboard with backlight and pointing stick for use only on computer models equipped with an
AMD processor in Romania (includes backlight cable and keyboard cable)

776452-281

Keyboard with backlight and pointing stick for use only on computer models equipped with an
AMD processor in Thailand (includes backlight cable and keyboard cable)

776452-291

Keyboard with backlight and pointing stick for use only on computer models equipped with an
AMD processor in Japan (includes backlight cable and keyboard cable)

776452-A41

Keyboard with backlight and pointing stick for use only on computer models equipped with an
AMD processor in Belgium (includes backlight cable and keyboard cable)

776452-AB1

Keyboard with backlight and pointing stick for use only on computer models equipped with an
AMD processor in Taiwan (includes backlight cable and keyboard cable)

776452-AD1

Keyboard with backlight and pointing stick for use only on computer models equipped with an
AMD processor in South Korea (includes backlight cable and keyboard cable)

776452-BA1

Keyboard with backlight and pointing stick for use only on computer models equipped with an
AMD processor in Bulgaria (includes backlight cable and keyboard cable)
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Spare part number

Description

776452-B31

Keyboard with backlight and pointing stick for use only on computer models equipped with an
AMD processor in the Netherlands (includes backlight cable and keyboard cable)

776452-B71

Keyboard with backlight and pointing stick for use only on computer models equipped with an
AMD processor in Sweden and Finland (includes backlight cable and keyboard cable)

776452-BA1

Keyboard with backlight and pointing stick for use only on computer models equipped with an
AMD processor in Slovenia (includes backlight cable and keyboard cable)

776452-BB1

Keyboard with backlight and pointing stick for use only on computer models equipped with an
AMD processor in Israel (includes backlight cable and keyboard cable)

776452-BG1

Keyboard with backlight and pointing stick for use only on computer models equipped with an
AMD processor in Switzerland (includes backlight cable and keyboard cable)

776452-D61

Keyboard with backlight and pointing stick for use only on computer models equipped with an
AMD processor in India (includes backlight cable and keyboard cable)

776452-DB1

Keyboard with backlight and pointing stick for use only on computer models equipped with an
AMD processor in Canada (includes backlight cable and keyboard cable)

776452-DD1

Keyboard with backlight and pointing stick for use only on computer models equipped with an
AMD processor in Iceland (includes backlight cable and keyboard cable)

776452-FL1

Keyboard with backlight and pointing stick for use only on computer models equipped with an
AMD processor in the Czech Republic and Slovakia (includes backlight cable and keyboard cable)

776626-001

500-GB, 5400-rpm, SATA, locked, 7.0-mm hard drive for use only on computer models equipped
with an Intel processor (does not include hard drive bracket, hard drive connector adapter,
or screws)
NOTE: The hard drive bracket, hard drive connector adapter, and screws are included in
the Hard Drive Hardware Kit, spare part number 730539-001.
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776930-001

12.5-in, AG, FHD, LED, SVA TouchScreen display panel for use only on computer models equipped
with an AMD processor

777832-001

256-GB, SATA-3, SED, OPAL-2 solid-state drive for use only on computer models equipped with an
Intel processor

778828-001

System board equipped with an Intel Core i3-4030U 1.90-GHz processor (3.00-MB L3 cache,
15 W), a graphics subsystem with UMA memory, and a non-Windows 8 operating system
(includes replacement thermal material)

778828-501

System board equipped with an Intel Core i3-4030U 1.90-GHz processor (3.00-MB L3 cache,
15 W), a graphics subsystem with UMA memory, and the Windows 8 Standard operating system
(includes replacement thermal material)

778828-601

System board equipped with an Intel Core i3-4030U 1.90-GHz processor (3.00-MB L3 cache,
15 W), a graphics subsystem with UMA memory, and the Windows 8 Professional
operating system (includes replacement thermal material)

778829-001

System board equipped with an Intel Core i5-4210U 1.70-GHz (SC turbo up to 2.70GHz) processor (3.00-MB L3 cache, 15 W), a graphics subsystem with UMA memory, and a nonWindows 8 operating system (includes replacement thermal material)

778829-501

System board equipped with an Intel Core i5-4210U 1.70-GHz (SC turbo up to 2.70GHz) processor (3.00-MB L3 cache, 15 W), a graphics subsystem with UMA memory, and the
Windows 8 Standard operating system (includes replacement thermal material)
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Spare part number

Description

778829-601

System board equipped with an Intel Core i5-4210U 1.70-GHz (SC turbo up to 2.70GHz) processor (3.00-MB L3 cache, 15 W), a graphics subsystem with UMA memory, and the
Windows 8 Professional operating system (includes replacement thermal material)

778830-001

System board equipped with an Intel Core i5-4310U 2.00-GHz (SC turbo up to 3.00GHz) processor (3.00-MB L3 cache, 15 W), a graphics subsystem with UMA memory, and a nonWindows 8 operating system (includes replacement thermal material)

778830-501

System board equipped with an Intel Core i5-4310U 2.00-GHz (SC turbo up to 3.00GHz) processor (3.00-MB L3 cache, 15 W), a graphics subsystem with UMA memory, and the
Windows 8 Standard operating system (includes replacement thermal material)

778830-601

System board equipped with an Intel Core i5-4310U 2.00-GHz (SC turbo up to 3.00GHz) processor (3.00-MB L3 cache, 15 W), a graphics subsystem with UMA memory, and the
Windows 8 Professional operating system (includes replacement thermal material)

778831-001

System board equipped with an Intel Core i7-4510U 2.00-GHz (SC turbo up to 3.10GHz) processor (4.00-MB L3 cache, 15 W), a graphics subsystem with UMA memory, and a nonWindows 8 operating system (includes replacement thermal material)

778831-501

System board equipped with an Intel Core i7-4510U 2.00-GHz (SC turbo up to 3.10GHz) processor (4.00-MB L3 cache, 15 W), a graphics subsystem with UMA memory, and the
Windows 8 Standard operating system (includes replacement thermal material)

778831-601

System board equipped with an Intel Core i7-4510U 2.00-GHz (SC turbo up to 3.10GHz) processor (4.00-MB L3 cache, 15 W), a graphics subsystem with UMA memory, and the
Windows 8 Professional operating system (includes replacement thermal material)

780112-001

Webcam/microphone module for use only on computer models equipped with an AMD processor
(includes double-sided adhesive)

780895-001

Fan for use only on computer models equipped with an AMD processor (includes cable)

783215-001

Top cover for use only on computer models equipped with an AMD processor

783989-001

LTE antenna for use only in Japan
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Removal and replacement
preliminary requirements

Tools required
You will need the following tools to complete the removal and replacement procedures:
●

Flat-bladed screw driver

●

Magnetic screw driver

●

Phillips P0 screw driver

Service considerations
The following sections include some of the considerations that you must keep in mind during
disassembly and assembly procedures.
NOTE: As you remove each subassembly from the computer, place the subassembly (and all
accompanying screws) away from the work area to prevent damage.

Plastic parts
CAUTION: Using excessive force during disassembly and reassembly can damage plastic parts.
Use care when handling the plastic parts. Apply pressure only at the points designated in the
maintenance instructions.
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Cables and connectors
CAUTION: When servicing the computer, be sure that cables are placed in their proper locations
during the reassembly process. Improper cable placement can damage the computer.
Cables must be handled with extreme care to avoid damage. Apply only the tension required to unseat
or seat the cables during removal and insertion. Handle cables by the connector whenever possible. In
all cases, avoid bending, twisting, or tearing cables. Be sure that cables are routed in such a way that
they cannot be caught or snagged by parts being removed or replaced. Handle flex cables with
extreme care; these cables tear easily.

Drive handling
CAUTION: Drives are fragile components that must be handled with care. To prevent damage to the
computer, damage to a drive, or loss of information, observe these precautions:
Before removing or inserting a hard drive, shut down the computer. If you are unsure whether
the computer is off or in Hibernation, turn the computer on, and then shut it down through the
operating system.
Before handling a drive, be sure that you are discharged of static electricity. While handling a drive,
avoid touching the connector.
Before removing a diskette drive or optical drive, be sure that a diskette or disc is not in the drive and
be sure that the optical drive tray is closed.
Handle drives on surfaces covered with at least one inch of shock-proof foam.
Avoid dropping drives from any height onto any surface.
After removing a hard drive, an optical drive, or a diskette drive, place it in a static-proof bag.
Avoid exposing an internal hard drive to products that have magnetic fields, such as monitors
or speakers.
Avoid exposing a drive to temperature extremes or liquids.
If a drive must be mailed, place the drive in a bubble pack mailer or other suitable form of protective
packaging and label the package “FRAGILE.”
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Grounding guidelines
Electrostatic discharge damage
Electronic components are sensitive to electrostatic discharge (ESD). Circuitry design and structure
determine the degree of sensitivity. Networks built into many integrated circuits provide some
protection, but in many cases, ESD contains enough power to alter device parameters or melt
silicon junctions.
A discharge of static electricity from a finger or other conductor can destroy static-sensitive devices or
microcircuitry. Even if the spark is neither felt nor heard, damage may have occurred.
An electronic device exposed to ESD may not be affected at all and can work perfectly throughout a
normal cycle. Or the device may function normally for a while, then degrade in the internal layers,
reducing its life expectancy.
CAUTION: To prevent damage to the computer when you are removing or installing internal
components, observe these precautions:
Keep components in their electrostatic-safe containers until you are ready to install them.
Before touching an electronic component, discharge static electricity by using the guidelines described
in this section.
Avoid touching pins, leads, and circuitry. Handle electronic components as little as possible.
If you remove a component, place it in an electrostatic-safe container.
The following table shows how humidity affects the electrostatic voltage levels generated by
different activities.
CAUTION: A product can be degraded by as little as 700 V.
Typical electrostatic voltage levels
Relative humidity
Event
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10%

40%

55%

Walking across carpet

35,000 V

15,000 V

7,500 V

Walking across vinyl floor

12,000 V

5,000 V

3,000 V

Motions of bench worker

6,000 V

800 V

400 V

Removing DIPS from plastic tube

2,000 V

700 V

400 V

Removing DIPS from vinyl tray

11,500 V

4,000 V

2,000 V

Removing DIPS from Styrofoam

14,500 V

5,000 V

3,500 V

Removing bubble pack from PCB

26,500 V

20,000 V

7,000 V

Packing PCBs in foam-lined box

21,000 V

11,000 V

5,000 V

Grounding guidelines
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Packaging and transporting guidelines
Follow these grounding guidelines when packaging and transporting equipment:
●

To avoid hand contact, transport products in static-safe tubes, bags, or boxes.

●

Protect ESD-sensitive parts and assemblies with conductive or approved containers or packaging.

●

Keep ESD-sensitive parts in their containers until the parts arrive at static-free workstations.

●

Place items on a grounded surface before removing items from their containers.

●

Always be properly grounded when touching a component or assembly.

●

Store reusable ESD-sensitive parts from assemblies in protective packaging or
nonconductive foam.

●

Use transporters and conveyors made of antistatic belts and roller bushings. Be sure that
mechanized equipment used for moving materials is wired to ground and that proper materials
are selected to avoid static charging. When grounding is not possible, use an ionizer to dissipate
electric charges.

Workstation guidelines
Follow these grounding workstation guidelines:
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●

Cover the workstation with approved static-shielding material.

●

Use a wrist strap connected to a properly grounded work surface and use properly grounded tools
and equipment.

●

Use conductive field service tools, such as cutters, screw drivers, and vacuums.

●

When fixtures must directly contact dissipative surfaces, use fixtures made only of staticsafe materials.

●

Keep the work area free of nonconductive materials, such as ordinary plastic assembly aids
and Styrofoam.

●

Handle ESD-sensitive components, parts, and assemblies by the case or PCM laminate. Handle
these items only at static-free workstations.

●

Avoid contact with pins, leads, or circuitry.

●

Turn off power and input signals before inserting or removing connectors or test equipment.
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Equipment guidelines
Grounding equipment must include either a wrist strap or a foot strap at a grounded workstation.
●

When seated, wear a wrist strap connected to a grounded system. Wrist straps are flexible straps
with a minimum of one megohm ±10% resistance in the ground cords. To provide proper ground,
wear a strap snugly against the skin at all times. On grounded mats with banana-plug connectors,
use alligator clips to connect a wrist strap.

●

When standing, use foot straps and a grounded floor mat. Foot straps (heel, toe, or boot straps)
can be used at standing workstations and are compatible with most types of shoes or boots. On
conductive floors or dissipative floor mats, use foot straps on both feet with a minimum of one
megohm resistance between the operator and ground. To be effective, the conductive must be
worn in contact with the skin.

The following grounding equipment is recommended to prevent electrostatic damage:
●

Antistatic tape

●

Antistatic smocks, aprons, and sleeve protectors

●

Conductive bins and other assembly or soldering aids

●

Nonconductive foam

●

Conductive computerop workstations with ground cords of one megohm resistance

●

Static-dissipative tables or floor mats with hard ties to the ground

●

Field service kits

●

Static awareness labels

●

Material-handling packages

●

Nonconductive plastic bags, tubes, or boxes

●

Metal tote boxes

●

Electrostatic voltage levels and protective materials

The following table lists the shielding protection provided by antistatic bags and floor mats.
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Material

Use

Voltage protection level

Antistatic plastics

Bags

1,500 V

Carbon-loaded plastic

Floor mats

7,500 V

Metallized laminate

Floor mats

5,000 V

Grounding guidelines
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Removal and replacement
procedures for Customer SelfRepair parts

NOTE: The Customer Self-Repair program is not available in all locations. Installing a part not
supported by the Customer Self-Repair program may void your warranty. Check your warranty to
determine if Customer Self-Repair is supported in your location.
NOTE: HP continually improves and changes product parts. For complete and current information on
supported parts for your computer, go to http://partsurfer.hp.com, select your country or region, and
then follow the on-screen instructions.

Component replacement procedures
This chapter provides removal and replacement procedures for Authorized Service Provider only parts.
There are as many as 15 screws that must be removed, replaced, and/or loosened when servicing the
computer. Make special note of each screw size and location during removal and replacement.

Service cover
NOTE: The service cover spare part kit includes rubber feet.
Description

Spare part number

For use only on computer models equipped with an AMD processor

766018-001

For use only on computer models equipped with an Intel processor:
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For use only on computer models equipped with a TouchScreen display assembly

761780-001

For use only on computer models equipped with a non-TouchScreen display assembly with a
CCCO mark

730564-001

For use only on computer models equipped with a non-TouchScreen display assembly and with
RCTO

745308-001

Component replacement procedures
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Before removing the disassembling the computer, follow these steps:
1.

Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect the power from the computer by unplugging the power cord from the computer.

3.

Disconnect all external devices from the computer.

Remove the service cover:
1.

Turn the computer upside down, with the rear toward you.

2.

Slide the service cover release latch (1) to gain access to the service cover security screw.

3.

Remove the Phillips PM2.0×4.5 security screw (2) (if present).
NOTE: The service cover includes a threaded receptacle for storing the security screw.

4.

Slide the service cover release latch a second time (3) to release the service cover.

5.

Release the service cover (4) by sliding it forward.

6.

Remove the service cover (5).

Reverse this procedure to install the service cover.
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Battery
Description

Spare part number

3-cell, 46-WHr, 4.15-AHr, Li-ion battery

717378-001

3-cell, 26-WHr, 2.50-AHr, Li-ion battery

717377-001

Before removing the battery, follow these steps:
1.

Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect the power from the computer by unplugging the power cord from the computer.

3.

Disconnect all external devices from the computer.

4.

Remove the service cover (see Service cover on page 71).

WARNING! To reduce potential safety issues, use only the battery provided with the computer, a
replacement battery provided by HP, or a compatible battery purchased from HP.
CAUTION: Removing a battery that is the sole power source for the computer can cause loss of
information. To prevent loss of information, save your work or shut down the computer through
Windows before removing the battery.
Remove the battery:
1.
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Slide the battery lock latches (1) to unlock the battery.
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2.

Use the release tab (2) to lift the rear edge of the battery (3) until the battery rests at an angle.

3.

Remove the battery.

Reverse this procedure to install the battery.
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Hard drive
NOTE: The hard drive spare part kit does not include the hard drive bracket, hard drive
connector adapter, or screws. The hard drive bracket, hard drive connector adapter, and screws are
included in the Hard Drive Hardware Kit, spare part number 730539-001.
Description

Spare part number

For use on all computer models:
500-GB, 7200-rpm, SATA, 7.0-mm hard drive

703267-001

500-GB, 7200-rpm, SED, 7.0-mm hard drive

703268-001

500-GB, 5400-rpm, SATA, FIPS, 7.0-mm hard drive

730946-001

320-GB, 7200-rpm, SATA, 7.0-mm hard drive

634862-001

For use only on computer models equipped with an AMD processor:
1-TB, 5400-rpm, SATA, 7.0-mm hard drive

762990-001

For use only on computer models equipped with an Intel processor:
500-GB, 5400-rpm, SATA, 7.0-mm hard drive

683802-001

500-GB, 5400-rpm, SATA, locked, 7.0-mm hard drive

763522-001

500-GB, 5400-rpm, SATA, locked, 7.0-mm hard drive

776626-001

Before removing the battery, follow these steps:
1.

Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect the power from the computer by unplugging the power cord from the computer.

3.

Disconnect all external devices from the computer.

4.

Remove the service cover (see Service cover on page 71).

5.

Remove the battery (see Battery on page 73).

Remove the hard drive:
1.
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Loosen the four Phillips captive screws (1) that secure the hard drive to the computer.
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2.

Use the release tab (2) to remove the hard drive.

3.

If it is necessary to disassemble the hard drive, perform the following steps:
a.

Position the hard drive with the rear toward you.

b.

Remove the four Phillips PM2.75×3.5 screws (1) that secure the hard drive bracket to the
hard drive.

c.

Remove the hard drive bracket (2) from the hard drive.
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d.

Remove the hard drive connector adapter (3) from the hard drive.
The hard drive bracket, hard drive connector adapter, and screws are available in the Hard
Drive Hardware Kit, spare part number 730539-001.

Reverse this procedure to reassemble and install the hard drive.
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WWAN module
Description

Spare part number

For use only on computer models equipped with an AMD processor:
HP hs3110 HSPA+ Mobile Broadband Module

748599-001

HP lt4112 LTE/HPSA+ Mobile Broadband Module

740011-001

HP lt4111 LTE/EV-DO/HSPA+ Mobile Broadband Module

748021-001

For use only on computer models equipped with an Intel processor:
HP hs3110 HSPA+ Mobile Broadband Module

723895-001

HP lt4226 LTE/HSPA+4G Module

736675-001

HP lt4225 LTE/EV-DO 4G Module

736676-001

HP lt4112 LTE/HSPA+ Mobile Broadband Module

704031-001

HP lt4111 LTE/EV-DO/HSPA+ Mobile Broadband Module

704030-001

Before removing the WWAN module, follow these steps:
1.

Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect the power from the computer by unplugging the power cord from the computer.

3.

Disconnect all external devices from the computer.

4.

Remove the service cover (see Service cover on page 71).

5.

Remove the battery (see Battery on page 73).

Remove the WWAN module:
1.

Disconnect the WWAN antenna cables (1) from the terminals on the WWAN module.
NOTE: The WWAN antenna cable labeled “5” connects to the WWAN module “Main”
terminal labeled “5”. The WWAN antenna cable labeled “6” connects to the WWAN module
“Aux/GPS” terminal labeled “6”.

2.
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Remove the Phillips PM2.0×2.5 screw (2) that secures the WWAN module to the system board.
(The WWAN module tilts up.)
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3.

Remove the WWAN module (3) by pulling the module away from the slot at an angle.

NOTE: If the WWAN antenna cables are not connected to the terminals on the WWAN module,
protective sleeves should be installed on the antenna connectors, as shown in the following illustration.

Reverse this procedure to install the WWAN module.
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Solid-state drive
Description

Spare part number

For use only on computer models equipped with an AMD processor:
256-GB, SATA-3, SED, Opal 2, solid-state drive

765614-001

256-GB, SATA-3, SED, Opal 1, solid-state drive

765613-001

240-GB, SATA-3, solid-state drive

765612-001

180-GB, SATA-3, SED, Opal 1, solid-state drive

765611-001

180-GB, SATA-3, solid-state drive

765610-001

128-GB, SATA-3, solid-state drive

765609-001

For use only on computer models equipped with an Intel processor:
512-GB, SATA-3, solid-state drive

752103-001

256-GB, SATA-3, SED, Opal 2, solid-state drive

761906-001

256-GB, SATA-3, SATA-3, Opal 2, locked, solid-state drive

777832-001

256-GB, SATA-3, SED solid-state drive

730567-001

240-GB, SATA-3, solid-state drive

730566-001

180-GB, SATA-3, SED, Opal 1, solid-state drive

775247-001

180-GB, SATA-3, solid-state drive

730565-001

128-GB, SATA-3, locked, Opal 2, solid-state drive

764507-001

128-GB, SATA-3, locked, solid-state drive

766679-001

128-GB, SATA-3, solid-state drive

744716-001

120-GB, mSATA-3, SED solid-state drive

730568-001

32-GB, SATA-3, solid-state drive

743008-001

Before removing the solid-state drive, follow these steps:
1.

Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect the power from the computer by unplugging the power cord from the computer.

3.

Disconnect all external devices from the computer.

4.

Remove the service cover (see Service cover on page 71).

5.

Remove the battery (see Battery on page 73).

Remove the solid-state drive:
1.
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Remove the Phillips PM2.0×2.5 screw (1) that secures the solid-state drive to the system board.
(The solid-state drive tilts up.)
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2.

Remove the solid-state drive (2) by pulling the drive away from the slot at an angle.

Reverse this procedure to install the solid-state drive.
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WLAN module
Description

Spare part number

For use only on computer models equipped with an AMD processor:
Atheros AR9485 802.11 b/g/n WiFi Adapter

675794-001

Broadcom BCM943228HMB 802.11 abgn 2×2 Wi-Fi Adapter, Broadcom Bluetooth 4.0 Adapter

730668-001

Broadcom BCM4352 802.11 ac 2×2 Wi-Fi + Bluetooth 4.0 Combo Adapter

724935-001

For use only on computer models equipped with an Intel processor:
Broadcom BCM943228HMB 802.11 a/b/g/n 2×2 Wi-Fi + Bluetooth 4.0 Combo Adapter

697316-001

Intel Dual Band Wireless-AC 7260 802.11 ac 2×2 WiFi + Bluetooth 4.0 WLAN module

710661-001

Intel Dual Band Wireless-N 7260AN 802.11 a/b/g/n 2×2 WiFi + Bluetooth 4.0 Combo
Adapter

717381-001

Intel Dual Band Wireless-N 7260AN 802.11 a/b/g/n 2×2 WiFi + Bluetooth 4.0
Combo Adapter

747832-001

Intel Dual Band Wireless-N 7260NB 802.11 a/b/g/n 2×2 WiFi Adapter

717382-001

Before removing the WLAN module, follow these steps:
1.

Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect the power from the computer by unplugging the power cord from the computer.

3.

Disconnect all external devices from the computer.

4.

Remove the service cover (see Service cover on page 71).

5.

Remove the battery (see Battery on page 73).

Remove the WLAN module:
1.

Disconnect the WLAN antenna cables (1) from the terminals on the WLAN module.
NOTE: The WLAN antenna cable labeled “1” connects to the WLAN module “Main” terminal
labeled “1”. The WLAN antenna cable labeled “2” connects to the WLAN module “Aux” terminal
labeled “2”.

2.
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Remove the two Phillips PM2.0×2.5 screws (2) that secure the WLAN module to the system
board. (The WLAN module tilts up.)
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3.

Remove the WLAN module (3) by pulling the module away from the slot at an angle.

NOTE: If the WLAN antenna cables are not connected to the terminals on the WLAN module,
protective sleeves should be installed on the antenna connectors, as shown in the following illustration.

Reverse this procedure to install the WLAN module.
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Memory module
Description

Spare part number

8 GB (PCL3, 12800, 1600-MHz)

693374-001

4 GB (PCL3, 12800, 1600-MHz)

691740-001

Before removing the memory module, follow these steps:
1.

Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect the power from the computer by unplugging the power cord from the computer.

3.

Disconnect all external devices from the computer.

4.

Remove the service cover (see Service cover on page 71).

5.

Remove the battery (see Battery on page 73).

Remove the memory module:
1.

Spread the retaining tabs (1) on each side of the memory module slot to release the memory
module. (The memory module tilts up.)

2.

Remove the memory module (2) by pulling the module away from the slot at an angle.

Reverse this procedure to install a memory module.
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Keyboard
For use in country
or region

Spare part number

For use in country
or region

Spare part number

Keyboard with backlight (includes backlight cable and keyboard cable):
For use only on computer models equipped with an AMD
processor:

For use in the Netherlands

776452-B31

For use in Belgium

776452-A41

For use in Northwest Africa

776452-FP1

For use in Brazil

776452-201

For use in Norway

776452-091

For use in Bulgaria

776452-BA1

For use in Portugal

776452-131

For use in Canada

776452-DB1

For use in Romania

776452-271

For use in the Czech Republic
and Slovakia

776452-FL1

For use in the Russia

776452-251

For use in Denmark

776452-081

For use in Saudi Arabia

776452-171

For use in France

776452-051

For use in Slovenia

776452-BA1

For use in Germany

776452-041

For use in South Korea

776452-AD1

For use in Greece

776452-151

For use in Spain

776452-071

For use in Hungary

776452-211

For use in Sweden and
Finland

776452-B71

For use in Iceland

776452-DD1

For use in Switzerland

776452-BG1

For use in India

776452-D61

For use in Taiwan

776452-AB1

For use in Israel

776452-BB1

For use in Thailand

776452-281

For use in Italy

776452-061

For use in Turkey

776452-141

For use in Japan

776452-291

For use in the United
Kingdom

776452-031

For use in Latin America

776452-161

For use in the United States

776452-001

Keyboard with backlight (includes backlight cable and keyboard cable):
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For use only on computer models equipped with an Intel
processor:

For use in the Netherlands

730541-B31

For use in Belgium

730541-A41

For use in Northwest Africa

730541-FP1

For use in Brazil

730541-201

For use in Norway

730541-091

For use in Bulgaria

730541-261

For use in Portugal

730541-131

For use in Canada

730541-DB1

For use in Romania

730541-271

For use in the Czech Republic
and Slovakia

730541-FL1

For use in Russia

730541-251

For use in Denmark

730541-081

For use in Saudi Arabia

730541-171

For use in France

730541-051

For use in Slovenia

730541-BA1
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For use in country
or region

Spare part number

For use in country
or region

Spare part number

For use in Germany

730541-041

For use in South Korea

730541-AD1

For use in Greece

730541-151

For use in Spain

730541-071

For use in Hungary

730541-211

For use in Sweden
and Finland

730541-B71

For use in Iceland

730541-DD1

For use in Switzerland

730541-BG1

For use in India

730541-D61

For use in Taiwan

730541-AB1

For use in Israel

730541-BB1

For use in Thailand

730541-281

For use in Italy

730541-061

For use in Turkey

730541-141

For use in Japan

730541-291

For use in the United
Kingdom and Singapore

730541-031

For use in Latin America

730541-161

For use in the United States

730541-001

Keyboard without backlight (includes keyboard cable):
For use only on computer models equipped with an AMD
processor:

For use in the Netherlands

776451-B31

For use in Belgium

776451-A41

For use in Northwest Africa

776451-FP1

For use in Brazil

776451-201

For use in Norway

776451-091

For use in Bulgaria

776451-261

For use in Portugal

776451-131

For use in Canada

776451-DB1

For use in Romania

776451-271

For use in the Czech Republic
and Slovakia

776451-FL1

For use in the Russia

776451-251

For use in Denmark

776451-081

For use in Saudi Arabia

776451-171

For use in France

776451-051

For use in Slovenia

776451-BA1

For use in Germany

776451-041

For use in South Korea

776451-AD1

For use in Greece

776451-151

For use in Spain

776451-071

For use in Hungary

776451-211

For use in Sweden and
Finland

776451-B71

For use in Iceland

776451-DD1

For use in Switzerland

776451-BG1

For use in India

776451-D61

For use in Taiwan

776451-AB1

For use in Israel

776451-BB1

For use in Thailand

776451-281

For use in Italy

776451-061

For use in Turkey

776451-141

For use in Japan

776451-291

For use in the United
Kingdom

776451-031

For use in Latin America

776451-161

For use in the United States

776451-001

Keyboard without backlight (includes keyboard cable):
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For use in country
or region

Spare part number

For use in country
or region

Spare part number

For use only on computer models equipped with an Intel
processor:

For use in the Netherlands

730540-B31

For use in Belgium

730540-A41

For use in Northwest Africa

730540-FP1

For use in Brazil

730540-201

For use in Norway

730540-091

For use in Bulgaria

730540-261

For use in Portugal

730540-131

For use in Canada

730540-DB1

For use in Romania

730540-271

For use in the Czech Republic
and Slovakia

730540-FL1

For use in Russia

730540-251

For use in Denmark

730540-081

For use in Saudi Arabia

730540-171

For use in France

730540-051

For use in Slovenia

730540-BA1

For use in Germany

730540-041

For use in South Korea

730540-AD1

For use in Greece

730540-151

For use in Spain

730540-071

For use in Hungary

730540-211

For use in Sweden
and Finland

730540-B71

For use in Iceland

730540-DD1

For use in Switzerland

730540-BG1

For use in India

730540-D61

For use in Taiwan

730540-AB1

For use in Israel

730540-BB1

For use in Thailand

730540-281

For use in Italy

730540-061

For use in Turkey

730540-141

For use in Japan

730540-291

For use in the United
Kingdom and Singapore

730540-031

For use in Latin America

730540-161

For use in the United States

730540-001

Before removing the keyboard, follow these steps:
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1.

Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect the power from the computer by unplugging the power cord from the computer.

3.

Disconnect all external devices from the computer.

4.

Remove the service cover (see Service cover on page 71).

5.

Remove the battery (see Battery on page 73).
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Remove the keyboard:
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1.

Loosen the two captive screws that secure the keyboard to the computer.

2.

Partially open the computer.

3.

Rest and secure the computer on its left side.
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4.

Insert a thin, plastic tool into the keyboard release hole next to the fan, and then press on the back
of the keyboard until the keyboard disengages from the computer.

5.

Open the computer as far as it will open.

6.

Lift the rear edge of the keyboard (1) until it rests at an angle.

7.

Slide the keyboard (2) toward the display until the tabs on the front edge of the keyboard
disengage from the top cover.
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8.

Swing the rear edge of the keyboard (3) up and forward until it rests upside down on the
palm rest.

NOTE: Step 9 applies only to computer models equipped with a keyboard with backlight.
9.

Release the zero insertion force (ZIF) connector (1) to which the backlight cable is attached, and
then disconnect the backlight cable (2) from the system board.

10. Release the ZIF connector (3) to which the keyboard cable is attached, and then disconnect the
keyboard cable (4) from the system board.
11. Release the ZIF connector (5) to which the pointing stick cable is attached, and then disconnect
the pointing stick cable (6) from the system board.
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12. Remove the keyboard (7).

Reverse this procedure to install the keyboard.

ENWW

Component replacement procedures

91

92

Chapter 5 Removal and replacement procedures for Customer Self-Repair parts

ENWW

6

Removal and replacement
procedures for Authorized Service
Provider parts

NOTE: Components described in this chapter should only be accessed by an authorized service
provider. Accessing these parts can damage the computer or void the warranty.
NOTE: HP continually improves and changes product parts. For complete and current information on
supported parts for your computer, go to http://partsurfer.hp.com, select your country or region, and
then follow the on-screen instructions.

Component replacement procedures
This chapter provides removal and replacement procedures for Authorized Service Provider only parts.
There are as many as 54 screws that must be removed, replaced, and/or loosened when servicing the
computer. Make special note of each screw size and location during removal and replacement.

RTC battery
Description

Spare part number

RTC battery (includes cable and double-sided adhesive)

702853-001

Before removing the RTC battery, follow these steps:
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1.

Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect the power from the computer by unplugging the power cord from the computer.

3.

Disconnect all external devices from the computer.

4.

Remove the service cover (see Service cover on page 71).

5.

Remove the battery (see Battery on page 73).

6.

Remove the keyboard (see Keyboard on page 85).
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Remove the RTC battery:
1.

Disconnect the RTC battery cable (1) from the system board.

2.

Detach the RTC battery (2) from the top cover. (The RTC battery is attached to the top cover with
double-sided adhesive.)

3.

Remove the RTC battery and cable.

Reverse this procedure to install the RTC battery.

Top cover
Description

Spare part number

For use only on computer models equipped with an AMD processor

783215-001

For use only on computer models equipped with an Intel processor

730548-001

Before removing the top cover, follow these steps:
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1.

Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect the power from the computer by unplugging the power cord from the computer.
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3.

Disconnect all external devices from the computer.

4.

Remove the service cover (see Service cover on page 71), and then remove the following
components:
a.

Battery (see Battery on page 73)

b.

Hard drive (see Hard drive on page 75)

c.

Keyboard (see Keyboard on page 85)

NOTE: When replacing the top cover, be sure that the following components are removed from the
defective top cover and installed on the replacement top cover:
Remove the top cover:
1.

Close the computer.

2.

Turn the computer upside down with the front toward you.

3.

Remove the Phillips PM2.0×3.25 screw (1) that secures the display panel cable bracket and
display panel cable to the system board.

4.

Remove the display panel cable bracket (2).

5.

Disconnect the display panel cable (3) from the system board.

6.

Remove the following rubber screw covers:
(1) This screw cover has a “1” marking on the inside of the cover
(2) These screw covers have a “2” marking on the inside of the cover
(3) These screw covers have a “3” marking on the inside of the cover
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7.

Remove the card reader bezel (4) from the card reader slot.

8.

Remove the ten Torx T8M2.5×6.5 screws (1) that secure the top cover to the base enclosure.
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9.

Remove the following screws that secure the top cover to the base enclosure:
(1) One Phillips PM2.0×6.5 screw
(2) Three Phillips PM2.5×4.5 screws
(3) Two Phillips PM2.0×3.0 screws

10. Remove the two Phillips PM2.5×4.5 screws (1) that secure the top cover to the base enclosure.
11. Remove the top cover (2).

Reverse this procedure to install the top cover.
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Display assembly
NOTE: The TouchScreen display assembly is spared as a whole unit replacement. The nonTouchScreen display assembly is spared at the subcomponent level only. For more display assembly
spare part information, see the individual removal subsections.
Description

Spare part number

12.5-in, AntiGlare, FHD, LED, UWVA, TouchScreen display assembly for use only on computer
models equipped with an AMD processor

765606-001

12.5-in, AntiGlare, HD, LED, UWVA, TouchScreen display assembly for use only on computer
models equipped with an Intel processor

761781-001

Before removing the display assembly, follow these steps:
1.

Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect the power from the computer by unplugging the power cord from the computer.

3.

Disconnect all external devices from the computer.

4.

Remove the service cover (see Service cover on page 71), and then remove the following
components:
a.

Battery (see Battery on page 73)

b.

Hard drive (see Hard drive on page 75)

c.

Keyboard (see Keyboard on page 85)

d.

Top cover (see Top cover on page 94)

Remove the display assembly:
1.
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Release the display panel cable from the routing clips (1) and channel built into the
base enclosure.
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2.

Release the wireless antenna cables from the routing clips (2) and channel built into the
base enclosure.

3.

Remove the four Phillips PM2.5×4.5 screws (1) that secure the display assembly to the
base enclosure.
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4.

Remove the display assembly (2).

5.

If it is necessary to replace the display bezel or any of the display assembly subcomponents:
a.

Flex the inside edges of the top edge (1), the left and right sides (2), and the bottom
edge (3) of the display bezel until the bezel disengages from the display enclosure.

b.

Remove the display bezel (4).
The display bezel is available using the following spare part numbers:
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●

775896-001–For use only on computer models equipped with an AMD processor and
an AntiGlare, FHD, LED, UWVA display panel

●

766012-001–For use only on computer models equipped with an AMD processor and
an AntiGlare, HD, LED, SVA display panel

●

730544-001–For use only on computer models equipped with an Intel processor and
an AntiGlare, HD, LED, SVA display panel
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6.

If it is necessary to replace the display panel:
a.

Remove the six Phillips PM2.0×3.25 screws (1) that secure the display panel to the
display enclosure.
CAUTION: Before turning the display panel upside down, make sure the work surface is
clear of tools, screws, and any other foreign objects. Failure to follow this caution can result
in damage to the display panel.
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b.

Lift the top edge of the display panel (2) and swing it up and forward until it rests upside
down in front of the display enclosure.

c.

Release the adhesive strip (1) that secures the display panel cable connector to the
display panel.
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d.

Disconnect the display panel cable (2) from the display panel.

e.

Remove the display panel.
The display panel is available using the following spare part numbers:

7.
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●

776930-001–12.5-in, AG, FHD, LED, UWVA display panel for use only on computer
models equipped with an AMD processor

●

765607-001–12.5-in, AG, HD, LED, SVA display panel for use only on computer
models equipped with an AMD processor

●

730536-001–12.5-in, AG, HD, LED, UWVA display panel for use only on computer
models equipped with an Intel processor

●

730535-001–12.5-in, AG, HD, LED, SVA display panel for use only on computer
models equipped with an Intel processor

If it is necessary to replace the webcam/microphone module or the microphone module:
a.

Detach the webcam/microphone module (1) from the display enclosure. (The webcam/
microphone module is attached to the display enclosure with double-sided adhesive.)

b.

Disconnect the webcam/microphone module cable (2) from the webcam/
microphone module.
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c.

Remove the webcam/microphone module (3).
The webcam/microphone module is available using spare part numbers 780112-001 (for
use only on computer models equipped with an AMD processor) and 730542-001 (for use
only on computer models equipped with an Intel processor). The microphone module is
available using spare part number 730795-001.

8.

If it is necessary to replace the display panel cable:
a.

Detach the display panel cable (1) from the display enclosure. (The display panel cable is
attached to the display enclosure with double-sided adhesive.)

b.

Release the display panel cable from the clip (2) built into the display enclosure.

c.

Remove the display panel cable (3).
The display panel cable is included in the Display Cable Kit, spare part number
730537-001, and includes the webcam/microphone module cable.
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9.

If it is necessary to replace the display hinges:
a.

Release the grounding tape (1) that secures the display hinges to the display enclosure.

b.

Remove the six Phillips PM2.0×3.0 broad head screws (2) that secure the display hinges to
the display enclosure.

c.

Remove the display hinges (3).
The display hinges are included in the Display Hinge Kits, spare part numbers 775895-001
(for use only on computer models equipped with an AMD processor) and 730543-001 (for
use only on computer models equipped with an Intel processor).

10. If it is necessary to replace the WLAN antenna cables and transceivers:
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a.

Detach the WLAN antenna transceivers (1) from the display enclosure. (The WLAN antenna
transceivers are attached to the display enclosure with double-sided adhesive.)

b.

Release the WLAN antenna cables from the clips (2) built into the left and right sides of the
display enclosure.
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c.

Remove the WLAN antenna cables and transceivers (3).
The WLAN antenna cables and transceivers are included in the Antenna Kits, spare part
numbers 775894-001 (for use only on computer models equipped with an AMD processor)
and 730560-001 (for use only on computer models equipped with an Intel processor).

11. If it is necessary to replace the WWAN antenna cables and transceivers:
a.

Detach the WWAN antenna transceivers (1) from the display enclosure. (The WWAN
antenna transceivers are attached to the display enclosure with double-sided adhesive.)

b.

Release the WWAN antenna cables from the clips (2) built into the left and right sides of the
display enclosure.

c.

Remove the WWAN antenna cables and transceivers (3).
The WWAN antenna cables and transceivers are included in the Antenna Kits, spare part
numbers 775894-001 (for use only on computer models equipped with an AMD processor)
and 730560-001 (for use only on computer models equipped with an Intel processor).
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Reverse this procedure to reassemble install the display assembly.
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TouchPad
Description

Spare part number

TouchPad (includes cable)

730549-001

Before removing the TouchPad, follow these steps:
1.

Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect the power from the computer by unplugging the power cord from the computer.

3.

Disconnect all external devices from the computer.

4.

Remove the service cover (see Service cover on page 71), and then remove the following
components:
a.

Battery (see Battery on page 73)

b.

Hard drive (see Hard drive on page 75)

c.

Keyboard (see Keyboard on page 85)

d.

Top cover (see Top cover on page 94)

Remove the TouchPad:
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1.

Turn the top cover upside down with the front toward you.

2.

Release the ZIF connector (1) to which the TouchPad cable is attached, and then disconnect the
TouchPad cable from the card reader board.

3.

Remove the two Philllips PM2.0×3.25 screws (2) that secure the TouchPad to the top cover.

Component replacement procedures

107

4.

Remove the TouchPad and cable (3).

Reverse this procedure to install the TouchPad.

Card reader board
Description

Spare part number

Card reader board (includes cable)

730563-001

Before removing the card reader board, follow these steps:
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1.

Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect the power from the computer by unplugging the power cord from the computer.

3.

Disconnect all external devices from the computer.

4.

Remove the service cover (see Service cover on page 71), and then remove the following
components:
a.

Battery (see Battery on page 73)

b.

Hard drive (see Hard drive on page 75)

c.

Keyboard (see Keyboard on page 85)

d.

Top cover (see Top cover on page 94)
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Remove the card reader board:
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1.

Turn the top cover upside down with the front toward you.

2.

Release the ZIF connector (1) to which the card reader board cable is attached, and then
disconnect the card reader board cable (2) from the system board.

3.

Turn the top cover upside down with the front toward you.

4.

Release the ZIF connector (1) to which the TouchPad cable is attached, and then disconnect the
TouchPad cable from the card reader board.

5.

Release the card reader board cable (2) through the opening in the top cover.

6.

Remove the three Philllips PM2.0×2.0 broad head screws (3) that secure the card reader board to
the top cover.
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7.

Remove the card reader board and cable (4).

8.

Remove the card reader board and cable.

Reverse this procedure to install the card reader board.
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Heat sink
NOTE: The heat sink spare part kit includes replacement thermal material.
Description

Spare part number

For use only on computer models equipped with an AMD processor

765605-001

For use only on computer models equipped with an Intel processor

730556-001

Before removing the heat sink, follow these steps:
1.

Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect the power from the computer by unplugging the power cord from the computer.

3.

Disconnect all external devices from the computer.

4.

Remove the service cover (see Service cover on page 71), and then remove the following
components:
a.

Battery (see Battery on page 73)

b.

Hard drive (see Hard drive on page 75)

c.

Keyboard (see Keyboard on page 85)

d.

Top cover (see Top cover on page 94)

Remove the heat sink:
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1.

Turn the top cover upside down with the front toward you.

2.

Detach the heat sink shroud (1) from the fan. (The heat sink shroud is attached to the fan with
double-sided adhesive.)

3.

Following the 1 through 4 sequence stamped into the heat sink, loosen the four Phillips captive
screws (2) that secure the heat sink to the system board.
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4.

Remove the heat sink (3).
NOTE: Due to the adhesive quality of the thermal material located between the heat sink and
the system board components, it may be necessary to move the heat sink from side to side to
detach it.

NOTE: The thermal material must be thoroughly cleaned from the surfaces of the heat sink and the
system board components each time the heat sink is removed. Replacement thermal material is included
with the heat sink and system board spare part kits. Thermal paste is used on the processor (1) and the
heat sink section (2) that services it.

Reverse this procedure to install the heat sink.
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Fan
Description

Spare part number

For use only on computer models equipped with an AMD processor

780895-001

For use only on computer models equipped with an Intel processor

730547-001

Before removing the fan, follow these steps:
1.

Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect the power from the computer by unplugging the power cord from the computer.

3.

Disconnect all external devices from the computer.

4.

Remove the service cover (see Service cover on page 71), and then remove the following
components:
a.

Battery (see Battery on page 73)

b.

Hard drive (see Hard drive on page 75)

c.

Keyboard (see Keyboard on page 85)

d.

Top cover (see Top cover on page 94)

e.

Heat sink (see Heat sink on page 111)

Remove the fan:
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1.

Turn the top cover upside down with the front toward you.

2.

Disconnect the fan cable (1) from the system board.

3.

Loosen the two Phillips captive screws (2) that secure the fan to the system board.

Component replacement procedures

113

4.

Remove the fan (3).

NOTE: The thermal material must be thoroughly cleaned from the surfaces of the heat sink and the
system board components each time the heat sink is removed. Replacement thermal material is included
with the heat sink and system board spare part kits. Thermal paste is used on the processor (1) and the
heat sink section (2) that services it.

Reverse this procedure to install the fan.

114

Chapter 6 Removal and replacement procedures for Authorized Service Provider parts

ENWW

System board
NOTE: The system board spare part kit includes the battery connector bracket and replacement
thermal material.
Description

Spare part number

For use only on computer models equipped with an AMD processor:
Equipped with an AMD A10 Pro-7350B 2.10-GHz (SC turbo up to 3.30-GHz) quad
core processor (4.00-MB L2 cache, 19 W), a graphics subsystem with UMA memory, and the
Windows 8 Professional operating system

765617-601

Equipped with an AMD A10 Pro-7350B 2.10-GHz (SC turbo up to 3.30-GHz) quad
core processor (4.00-MB L2 cache, 19 W), a graphics subsystem with UMA memory, and the
Windows 8 Standard operating system

765617-501

Equipped with an AMD A10 Pro-7350B 2.10-GHz (SC turbo up to 3.30-GHz) quad
core processor (4.00-MB L2 cache, 19 W), a graphics subsystem with UMA memory, and a nonWindows 8 operating system

765617-001

Equipped with an AMD A8 Pro-7150B 2.00-GHz (SC turbo up to 3.20-GHz) quad core processor
(4.00-MB L2 cache, 19 W), a graphics subsystem with UMA memory, and the Windows 8
Professional operating system

765616-601

Equipped with an AMD A8 Pro-7150B 2.00-GHz (SC turbo up to 3.20-GHz) quad core processor
(4.00-MB L2 cache, 19 W), a graphics subsystem with UMA memory, and the Windows 8
Standard operating system

765616-501

Equipped with an AMD A8 Pro-7150B 2.00-GHz (SC turbo up to 3.20-GHz) quad core processor
(4.00-MB L2 cache, 19 W), a graphics subsystem with UMA memory, and a non-Windows 8
operating system

765616-001

Equipped with an AMD A6 Pro-7050B 2.20-GHz (SC turbo up to 3.00-GHz) dual core processor
(1.00-MB L2 cache, 17 W), a graphics subsystem with UMA memory, and the Windows 8
Professional operating system

765615-601

Equipped with an AMD A6 Pro-7050B 2.20-GHz (SC turbo up to 3.00-GHz) dual core processor
(1.00-MB L2 cache, 17 W), a graphics subsystem with UMA memory, and the Windows 8
Standard operating system

765615-501

Equipped with an AMD A6 Pro-7050B 2.20-GHz (SC turbo up to 3.00-GHz) dual core processor
(1.00-MB L2 cache, 17 W), a graphics subsystem with UMA memory, and a non-Windows 8
operating system

765615-001

For use only on computer models equipped with an Intel processor and a TouchScreen display assembly:
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Equipped with an Intel Core i7-4600U 2.10-GHz (SC turbo up to 3.10-GHz) processor (4.00-MB
L3 cache, 15 W) and the Windows 8 Professional operating system

761778-601

Equipped with an Intel Core i7-4600U 2.10-GHz (SC turbo up to 3.10-GHz) processor (4.00-MB
L3 cache, 15 W) and the Windows 8 Standard operating system

761778-501

Equipped with an Intel Core i7-4600U 2.10-GHz (SC turbo up to 3.10-GHz) processor (4.00-MB
L3 cache, 15 W) and a non-Windows 8 operating system

761778-001

Equipped with an Intel Core i7-4510U 2.00-GHz (SC turbo up to 3.10-GHz) processor (4.00-MB
L3 cache, 15 W), a graphics subsystem with UMA memory, and the Windows 8 Professional
operating system

778831-601
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Description

Spare part number

Equipped with an Intel Core i7-4510U 2.00-GHz (SC turbo up to 3.10-GHz) processor (4.00-MB
L3 cache, 15 W), a graphics subsystem with UMA memory, and the Windows 8 Standard
operating system

778831-501

Equipped with an Intel Core i7-4510U 2.00-GHz (SC turbo up to 3.10-GHz) processor (4.00-MB
L3 cache, 15 W), a graphics subsystem with UMA memory, and a non-Windows 8 operating
system

778831-001

Equipped with an Intel Core i7-4500U 1.80-GHz (SC turbo up to 3.00-GHz) processor (4.00-MB
L3 cache, 15 W) and the Windows 8 Professional operating system

761777-601

Equipped with an Intel Core i7-4500U 1.80-GHz (SC turbo up to 3.00-GHz) processor (4.00-MB
L3 cache, 15 W) and the Windows 8 Standard operating system

761777-501

Equipped with an Intel Core i7-4500U 1.80-GHz (SC turbo up to 3.00-GHz) processor (4.00-MB
L3 cache, 15 W) and a non-Windows 8 operating system

761777-001

Equipped with an Intel Core i5-4310U 2.00-GHz (SC turbo up to 3.00-GHz) processor (3.00-MB
L3 cache, 15 W), a graphics subsystem with UMA memory, and the Windows 8 Professional
operating system

778830-601

Equipped with an Intel Core i5-4310U 2.00-GHz (SC turbo up to 3.00-GHz) processor (3.00-MB
L3 cache, 15 W), a graphics subsystem with UMA memory, and the Windows 8 Standard
operating system

778830-501

Equipped with an Intel Core i5-4310U 2.00-GHz (SC turbo up to 3.00-GHz) processor (3.00-MB
L3 cache, 15 W), a graphics subsystem with UMA memory, and a non-Windows 8 operating
system

778830-001

Equipped with an Intel Core i5-4300U 1.90-GHz (SC turbo up to 2.90-GHz) processor (3.00-MB
L3 cache, 15 W) and the Windows 8 Professional operating system

761776-601

Equipped with an Intel Core i5-4300U 1.90-GHz (SC turbo up to 2.90-GHz) processor (3.00-MB
L3 cache, 15 W) and the Windows 8 Standard operating system

761776-501

Equipped with an Intel Core i5-4300U 1.90-GHz (SC turbo up to 2.90-GHz) processor (3.00-MB
L3 cache, 15 W) and a non-Windows 8 operating system

761776-001

Equipped with an Intel Core i5-4210U 1.70-GHz (SC turbo up to 2.70-GHz) processor (3.00-MB
L3 cache, 15 W), a graphics subsystem with UMA memory, and the Windows 8 Professional
operating system

778829-601

Equipped with an Intel Core i5-4210U 1.70-GHz (SC turbo up to 2.70-GHz) processor (3.00-MB
L3 cache, 15 W), a graphics subsystem with UMA memory, and the Windows 8 Standard
operating system

778829-501

Equipped with an Intel Core i5-4210U 1.70-GHz (SC turbo up to 2.70-GHz) processor (3.00-MB
L3 cache, 15 W), a graphics subsystem with UMA memory, and a non-Windows 8 operating
system

778829-001

Equipped with an Intel Core i5-4200U 1.60-GHz (SC turbo up to 2.60-GHz) processor (3.00-MB
L3 cache, 15 W) and the Windows 8 Professional operating system

761775-601

Equipped with an Intel Core i5-4200U 1.60-GHz (SC turbo up to 2.60-GHz) processor (3.00-MB
L3 cache, 15 W) and the Windows 8 Standard operating system

761775-501

Equipped with an Intel Core i5-4200U 1.60-GHz (SC turbo up to 2.60-GHz) processor (3.00-MB
L3 cache, 15 W) and a non-Windows 8 operating system

761775-001

Equipped with an Intel Core i3-4030U 1.90-GHz processor (3.00-MB L3 cache, 15 W), a
graphics subsystem with UMA memory, and the Windows 8 Professional operating system

778828-601
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Description

Spare part number

Equipped with an Intel Core i3-4030U 1.90-GHz processor (3.00-MB L3 cache, 15 W), a
graphics subsystem with UMA memory, and the Windows 8 Standard operating system

778828-501

Equipped with an Intel Core i3-4030U 1.90-GHz processor (3.00-MB L3 cache, 15 W), a
graphics subsystem with UMA memory, and a non-Windows 8 operating system

778828-001

For use only on computer models equipped with an Intel processor and a non-TouchScreen display assembly:
Equipped with an Intel Core i3-4010U 1.70-GHz processor (3.00-MB L3 cache, 15 W), a
graphics subsystem with UMA memory, and the Windows 8 Professional operating system

761774-601

Equipped with an Intel Core i3-4010U 1.70-GHz processor (3.00-MB L3 cache, 15 W), a
graphics subsystem with UMA memory, and the Windows 8 Standard operating system

761774-501

Equipped with an Intel Core i3-4010U 1.70-GHz processor (3.00-MB L3 cache, 15 W), a
graphics subsystem with UMA memory, and a non-Windows 8 operating system

761774-001

For use only on computer models equipped with a non-TouchScreen display assembly:
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Equipped with an Intel Core i7-4600U 2.10-GHz (SC turbo up to 3.30-GHz) processor (4.00-MB
L3 cache, 15 W) and the Windows 8 Professional operating system

730559-601

Equipped with an Intel Core i7-4600U 2.10-GHz (SC turbo up to 3.30-GHz) processor (4.00-MB
L3 cache, 15 W) and the Windows 8 Standard operating system

730559-501

Equipped with an Intel Core i7-4600U 2.10-GHz (SC turbo up to 3.30-GHz) processor (4.00-MB
L3 cache, 15 W) and a non-Windows 8 operating system

730559-001

Equipped with an Intel Core i7-4500U 1.80-GHz (SC turbo up to 3.00-GHz) processor (4.00-MB
L3 cache, 15 W) and the Windows 8 Professional operating system

753071-601

Equipped with an Intel Core i7-4500U 1.80-GHz (SC turbo up to 3.00-GHz) processor (4.00-MB
L3 cache, 15 W) and the Windows 8 Standard operating system

753071-501

Equipped with an Intel Core i7-4500U 1.80-GHz (SC turbo up to 3.00-GHz) processor (4.00-MB
L3 cache, 15 W) and a non-Windows 8 operating system

753071-001

Equipped with an Intel Core i5-4300U 1.90-GHz (SC turbo up to 2.90-GHz) processor (3.00-MB
L3 cache, 15 W) and the Windows 8 Professional operating system

731066-601

Equipped with an Intel Core i5-4300U 1.90-GHz (SC turbo up to 2.90-GHz) processor (3.00-MB
L3 cache, 15 W) and the Windows 8 Standard operating system

731066-501

Equipped with an Intel Core i5-4300U 1.90-GHz (SC turbo up to 2.90-GHz) processor (3.00-MB
L3 cache, 15 W) and a non-Windows 8 operating system

731066-001

Equipped with an Intel Core i5-4200U 1.60-GHz (SC turbo up to 2.60-GHz) processor (3.00-MB
L3 cache, 15 W) and the Windows 8 Professional operating system

730558-601

Equipped with an Intel Core i5-4200U 1.60-GHz (SC turbo up to 2.60-GHz) processor (3.00-MB
L3 cache, 15 W) and the Windows 8 Standard operating system

730558-501

Equipped with an Intel Core i5-4200U 1.60-GHz (SC turbo up to 2.60-GHz) processor (3.00-MB
L3 cache, 15 W) and a non-Windows 8 operating system

730558-001

Equipped with an Intel Core i3-4010U 1.70-GHz processor (3.00-MB L3 cache, 15 W) and
the Windows 8 Professional operating system

730557-601
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Description

Spare part number

Equipped with an Intel Core i3-4010U 1.70-GHz processor (3.00-MB L3 cache, 15 W) and
the Windows 8 Standard operating system

730557-501

Equipped with an Intel Core i3-4010U 1.70-GHz processor (3.00-MB L3 cache, 15 W) and a
non-Windows 8 operating system

730557-001

Before removing the system board, follow these steps:
1.

Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect the power from the computer by unplugging the power cord from the computer.

3.

Disconnect all external devices from the computer.

4.

Remove the service cover (see Service cover on page 71), and then remove the following
components:
a.

Battery (see Battery on page 73)

b.

Hard drive (see Hard drive on page 75)

c.

Keyboard (see Keyboard on page 85)

d.

RTC battery (see RTC battery on page 93)

e.

Top cover (see Top cover on page 94)

f.

Heat sink (see Heat sink on page 111)

g.

Fan (see Fan on page 113)

NOTE: When replacing the system board, be sure that the following components are removed from
the defective system board and installed on the replacement system board:
●

WWAN module (see WWAN module on page 78)

●

Solid-state drive (see Solid-state drive on page 80)

●

WLAN module (see WLAN module on page 82)

●

Memory modules (see Memory module on page 84)

Remove the system board:
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1.

Turn the top cover upside down with the front toward you.

2.

Release the ZIF connector (1) to which the power button board cable is attached, and then
disconnect the power button board cable from the system board.
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3.

Release the ZIF connector (2) to which the fingerprint reader board cable is attached, and then
disconnect the fingerprint reader board cable from the system board.

4.

Disconnect the speaker cable (1) from the system board.

5.

Remove the three Philllips PM2.0×3.0 screws (2) that secure the system board to the top cover.
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6.

Lift up on the right side of the system board (1) until it rests at an angle.

7.

Remove the system board (2) by sliding it up and to the right at an angle.

Reverse this procedure to install the system board.
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Fingerprint reader board
Description

Spare part number

Fingerprint reader board (includes bracket and cable)

730554-001

Before removing the fingerprint reader board, follow these steps:
1.

Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect the power from the computer by unplugging the power cord from the computer.

3.

Disconnect all external devices from the computer.

4.

Remove the service cover (see Service cover on page 71), and then remove the following
components:
a.

Battery (see Battery on page 73)

b.

Hard drive (see Hard drive on page 75)

c.

Keyboard (see Keyboard on page 85)

d.

Top cover (see Top cover on page 94)

Remove the fingerprint reader board:
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1.

Turn the top cover upside down with the front toward you.

2.

Detach the fingerprint reader board cable (1) from the top cover. (The fingerprint reader board
cable is attached to the top cover with double-sided adhesive.)

3.

Remove the three Phillips PM2.0×2.5 screws that secure the fingerprint reader board and bracket
to the top cover.

4.

Remove the fingerprint reader board bracket (3).
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5.

Remove the fingerprint reader board (4).

Reverse this procedure to install the fingerprint reader board.

Speaker assembly
Description

Spare part number

Speaker assembly (includes left and right speakers and cables)

730555-001

Before removing the speaker assembly, follow these steps:
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1.

Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect the power from the computer by unplugging the power cord from the computer.

3.

Disconnect all external devices from the computer.

4.

Remove the service cover (see Service cover on page 71), and then remove the following
components:
a.

Battery (see Battery on page 73)

b.

Hard drive (see Hard drive on page 75)

c.

Keyboard (see Keyboard on page 85)

d.

Top cover (see Top cover on page 94)

e.

System board (see System board on page 115)
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Remove the speaker assembly:
1.

Release the four clips (1) built into the top cover that secure the speaker assembly to the top cover.

2.

Remove the speaker assembly (2).

Reverse this procedure to install the speaker assembly.
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Power button board
Description

Spare part number

Power button board (includes cable)

730552-001

Before removing the power button board, follow these steps:
1.

Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect the power from the computer by unplugging the power cord from the computer.

3.

Disconnect all external devices from the computer.

4.

Remove the service cover (see Service cover on page 71), and then remove the following
components:
a.

Battery (see Battery on page 73)

b.

Hard drive (see Hard drive on page 75)

c.

Keyboard (see Keyboard on page 85)

d.

Top cover (see Top cover on page 94)

e.

System board (see System board on page 115)

Remove the power button board:
1.
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Remove the two Phillips PM2.0×3.25 screws (1) that secure the power button board to the
top cover.
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2.

Remove the power button board (2) and cable.

Reverse this procedure to install the power button board.
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7

Computer Setup (BIOS)

Windows 8 – Computer Setup (BIOS), MultiBoot, and
HP PC Hardware Diagnostics (UEFI)
Using Computer Setup
Computer Setup, or Basic Input/Output System (BIOS), controls communication between all the input
and output devices on the system (such as disk drives, display, keyboard, mouse, and printer).
Computer Setup includes settings for the types of devices installed, the startup sequence of
the computer, and the amount of system and extended memory.
NOTE: Use extreme care when making changes in Computer Setup. Errors can prevent the computer
from operating properly.

Starting Computer Setup
NOTE: An external keyboard or mouse connected to a USB port can be used with Computer Setup
only if USB legacy support is enabled.
To start Computer Setup, follow these steps:
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1.

Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

2.

Press f10 to enter Computer Setup.
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Navigating and selecting in Computer Setup
To navigate and select in Computer Setup, follow these steps:
1.

Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.
●

To select a menu or a menu item, use the tab key and the keyboard arrow keys and then
press enter, or use a pointing device to click the item.

●

To scroll up and down, click the up arrow or the down arrow in the upper-right corner of the
screen, or use the up arrow key or the down arrow key on the keyboard.

●

To close open dialog boxes and return to the main Computer Setup screen, press esc, and
then follow the on-screen instructions.

NOTE: You can use either a pointing device (TouchPad, pointing stick, or USB mouse) or the
keyboard to navigate and make selections in Computer Setup.
2.

Press f10 to enter Computer Setup.

To exit Computer Setup menus, choose one of the following methods:
●

To exit Computer Setup menus without saving your changes:
Click the Exit icon in the lower-right corner of the screen, and then follow the onscreen instructions.
– or –
Use the tab key and the arrow keys to select Main > Ignore Changes and Exit, and then
press enter.

●

To save your changes and exit Computer Setup menus:
Click the Save icon in the lower-right corner of the screen, and then follow the onscreen instructions.
– or –
Use the arrow keys to select Main > Save Changes and Exit, and then press enter.

Your changes go into effect when the computer restarts.

128

Chapter 7 Computer Setup (BIOS)

ENWW

Restoring factory settings in Computer Setup
NOTE: Restoring defaults will not change the hard drive mode.
To return all settings in Computer Setup to the values that were set at the factory, follow these steps:
1.

Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

2.

Press f10 to enter Computer Setup.

3.

Use a pointing device or the arrow keys to select Main > Restore Defaults.

4.

Follow the on-screen instructions.

5.

To save your changes and exit, click the Save icon in the lower-right corner of the screen, and
then follow the on-screen instructions.
– or –
Use the arrow keys to select Main > Save Changes and Exit, and then press enter.

Your changes go into effect when the computer restarts.
NOTE: Your password settings and security settings are not changed when you restore the
factory settings.

Updating the BIOS
Updated versions of the BIOS may be available on the HP website.
Most BIOS updates on the HP website are packaged in compressed files called SoftPaqs.
Some download packages contain a file named Readme.txt, which contains information regarding
installing and troubleshooting the file.
Determining a BIOS version
To determine whether available BIOS updates contain later BIOS versions than those currently installed
on the computer, you need to know the version of the system BIOS currently installed.
BIOS version information (also known as ROM date and System BIOS) can be displayed by pressing fn
+esc (if you are already in Windows) or by using Computer Setup.
1.

Start Computer Setup.

2.

Use a pointing device or the arrow keys to select Main > System Information.

3.

To exit Computer Setup without saving your changes, click the Exit icon in the lower-right corner
of the screen, and then follow the on-screen instructions.
– or –
Use the tab key and the arrow keys to select Main > Ignore Changes and Exit, and then
press enter.
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Downloading a BIOS update for Windows 8
CAUTION: To reduce the risk of damage to the computer or an unsuccessful installation, download
and install a BIOS update only when the computer is connected to reliable external power using the AC
adapter. Do not download or install a BIOS update while the computer is running on battery power,
docked in an optional docking device, or connected to an optional power source. During the
download and installation, follow these instructions:
Do not disconnect power on the computer by unplugging the power cord from the AC outlet.
Do not shut down the computer or initiate Sleep.
Do not insert, remove, connect, or disconnect any device, cable, or cord.
1.

From the Start screen, type support, and then select the HP Support Assistant app.

2.

Select Updates and tune-ups, and then select Check for HP updates now.

3.

Follow the on-screen instructions.
NOTE: If you connect your computer to a network, consult the network administrator before
installing any software updates, especially system BIOS updates.

4.

At the download area, follow these steps:
a.

Identify the most recent BIOS update and compare it to the BIOS version currently installed on
your computer. Make a note of the date, name, or other identifier. You may need this
information to locate the update later, after it has been downloaded to your hard drive.

b.

Follow the on-screen instructions to download your selection to the hard drive.
If the update is more recent than your BIOS, make a note of the path to the location on your
hard drive where the BIOS update is downloaded. You will need to access this path when
you are ready to install the update.

BIOS installation procedures vary. Follow any instructions that are displayed on the screen after the
download is complete. If no instructions are displayed, follow these steps:
1.

From the Start screen, type e, and then select File Explorer.

2.

Click your hard drive designation. The hard drive designation is typically Local Disk (C:).

3.

Using the hard drive path you recorded earlier, open the folder on your hard drive that contains
the update.

4.

Double-click the file that has an .exe extension (for example, filename.exe).
The BIOS installation begins.

5.

Complete the installation by following the on-screen instructions.

NOTE: After a message on the screen reports a successful installation, you can delete the
downloaded file from your hard drive.

130

Chapter 7 Computer Setup (BIOS)

ENWW

Using MultiBoot
About the boot device order
As the computer starts, the system attempts to boot from enabled devices. The MultiBoot utility, which is
enabled at the factory, controls the order in which the system selects a boot device. Boot devices can
include optical drives, diskette drives, a network interface card (NIC), hard drives, and USB devices.
Boot devices contain bootable media or files that the computer needs to start and operate properly.
NOTE: Some boot devices must be enabled in Computer Setup before they can be included in the
boot order.
You can change the order in which the computer searches for a boot device by changing the boot
order in Computer Setup. You can also press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen, and then press f9. Pressing f9 displays a menu that
shows the current boot devices and allows you to select a boot device. Or, you can use MultiBoot
Express to set the computer to prompt you for a boot location each time the computer turns on
or restarts.

Choosing MultiBoot preferences
You can use MultiBoot in the following ways:
●

To set a new boot order that the computer uses each time it is turned on, by changing the boot
order in Computer Setup.

●

To dynamically choose the boot device, by pressing esc while the “Press the ESC key for Startup
Menu” message is displayed at the bottom of the screen, and then pressing f9 to enter the Boot
Device Options menu.

●

To use MultiBoot Express to set variable boot orders. This feature prompts you for a boot device
each time the computer is turned on or restarted.

Setting a new boot order in Computer Setup
To start Computer Setup and set a boot device order that the computer uses each time it is turned on or
restarted, follow these steps:
1.

Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

2.

Press f10 to enter Computer Setup.

3.

Use a pointing device or the arrow keys to select Advanced > Boot Options > UEFI Boot
Order for UEFI Hybrid or UEFI Native Boot Mode, or select Advanced > Boot
Options > Legacy Boot Order for Legacy Boot Mode, and then press enter.

4.

To move the device up in the boot order, use a pointing device to click the up arrow, or
press the + key.
– or –
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To move the device down in the boot order, use a pointing device to click the down arrow, or
press the - key.
5.

To save your changes and exit Computer Setup, click the Save icon in the lower-left corner of the
screen, and then follow the on-screen instructions.
– or –
Use the arrow keys to select Main > Save Changes and Exit, and then press enter.

Dynamically choosing a boot device using the f9 prompt
To dynamically choose a boot device for the current startup sequence, follow these steps:
1.

Open the Select Boot Device menu by turning on or restarting the computer, and then pressing esc
while the “Press the ESC key for Startup Menu” message is displayed at the bottom of the screen.

2.

Press f9.

3.

Use a pointing device or the arrow keys to select a boot device, then press enter.

Setting a MultiBoot Express prompt
To start Computer Setup and set the computer to display the MultiBoot startup location menu each time
the computer is started or restarted, follow these steps:
1.

Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

2.

Press f10 to enter Computer Setup.

3.

Use a pointing device or the arrow keys to select Advanced > Boot Options> MultiBoot
Express Boot Popup Delay (Sec), and then press enter.

4.

In the MultiBoot Express Popup Delay (Sec) field, enter the length of time in seconds that
you want the computer to display the startup location menu before it defaults to the current
MultiBoot setting. (When 0 is selected, the Express Boot startup location menu is not displayed.)

5.

To save your changes and exit Computer Setup, click the Save icon in the lower-left corner of the
screen, and then follow the on-screen instructions.
– or –
Use the arrow keys to select Main > Save Changes and Exit, and then press enter.

Your changes go into effect when the computer restarts.
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Entering MultiBoot Express preferences
When the Express Boot menu is displayed during startup, you have the following choices:
●

To specify a boot device from the Express Boot menu, select your preference within the allotted
time, and then press enter.

●

To prevent the computer from defaulting to the current MultiBoot setting, press any key before the
allotted time expires. The computer will not start until you select a boot device and press enter.

●

To allow the computer to start according to the current MultiBoot settings, wait for the allotted time
to expire.

Using HP PC Hardware Diagnostics (UEFI) (select models only)
HP PC Hardware Diagnostics is a Unified Extensible Firmware Interface (UEFI) that allows you to run
diagnostic tests to determine if the computer hardware is functioning properly. The tool runs outside of
the operating system to isolate hardware failures from issues that may be caused by the
operating system or other software components.
To start HP PC Hardware Diagnostics UEFI:
1.

Turn on or restart the computer, quickly press esc, and then press f2.
After pressing f2, the BIOS searches three places for the HP PC Hardware Diagnostics (UEFI) tools
in the following order:
a.

Connected USB drive
NOTE: To download the HP PC Hardware Diagnostics (UEFI) tool to a USB drive, see
Downloading HP PC Hardware Diagnostics (UEFI) to a USB device on page 134.

2.

b.

Hard drive

c.

BIOS

Click the type of diagnostic test you want to run, and then follow the on-screen instructions.
NOTE: If you need to stop a diagnostic test while it is running, press esc.
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Downloading HP PC Hardware Diagnostics (UEFI) to a USB device
NOTE: The HP PC Hardware Diagnostics (UEFI) download instructions are provided in English only.
1.

Go to http://www.hp.com.

2.

Click Support & Drivers, and then click the Drivers & Software tab.

3.

Enter the product name in the text box, and then click Search.

4.

Select your computer model, and then select your operating system.

5.

In the Diagnostic section, click HP UEFI Support Environment.
– or –
Click Download, and then select Run.
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Windows 7 – Computer Setup (BIOS), MultiBoot, and
HP PC Hardware Diagnostics (UEFI)
Using Computer Setup
Computer Setup, or Basic Input/Output System (BIOS), controls communication between all the input
and output devices on the system (such as disk drives, display, keyboard, mouse, and printer).
Computer Setup includes settings for the types of devices installed, the startup sequence of
the computer, and the amount of system and extended memory.
NOTE: Use extreme care when making changes in Computer Setup. Errors can prevent the computer
from operating properly.

Starting Computer Setup
NOTE: An external keyboard or mouse connected to a USB port can be used with Computer Setup
only if USB legacy support is enabled.
To start Computer Setup, follow these steps:
1.

Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

2.

Press f10 to enter Computer Setup.

Navigating and selecting in Computer Setup
To navigate and select in Computer Setup, follow these steps:
1.

Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.
NOTE: You can use either a pointing device (TouchPad, pointing stick, or USB mouse) or the
keyboard to navigate and make selections in Computer Setup.

2.
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Press f10 to enter Computer Setup.
●

To select a menu or a menu item, use the tab key and the keyboard arrow keys and then
press enter, or use a pointing device to click the item.

●

To scroll up and down, click the up arrow or the down arrow in the upper-right corner of the
screen, or use the up arrow key or the down arrow key on the keyboard.

●

To close open dialog boxes and return to the main Computer Setup screen, press esc, and
then follow the on-screen instructions.
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To exit Computer Setup menus, choose one of the following methods:
●

To exit Computer Setup menus without saving your changes:
Click the Exit icon in the lower-right corner of the screen, and then follow the on-screen
instructions.
– or –
Use the tab key and the arrow keys to select File > Ignore Changes and Exit, and then
press enter.

●

To save your changes and exit Computer Setup menus:
Click the Save icon in the lower-right corner of the screen, and then follow the on-screen
instructions.
– or –
Use the tab key and the arrow keys to select File > Ignore Changes and Exit, and then
press enter.

Your changes go into effect when the computer restarts.

Restoring factory settings in Computer Setup
NOTE: Restoring defaults will not change the hard drive mode.
To return all settings in Computer Setup to the values that were set at the factory, follow these steps:
1.

Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

2.

Press f10 to enter Computer Setup.

3.

Use a pointing device or the arrow keys to select File > Restore Defaults.

4.

Follow the on-screen instructions.

5.

To save your changes and exit, click the Save icon in the lower-right corner of the screen, and
then follow the on-screen instructions.
– or –
Use the arrow keys to select File > Save Changes and Exit, and then press enter.

Your changes go into effect when the computer restarts.
NOTE: Your password settings and security settings are not changed when you restore the
factory settings.
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Updating the BIOS
Updated versions of the BIOS may be available on the HP website.
Most BIOS updates on the HP website are packaged in compressed files called SoftPaqs.
Some download packages contain a file named Readme.txt, which contains information regarding
installing and troubleshooting the file.
Determining a BIOS version
To determine whether available BIOS updates contain later BIOS versions than those currently installed
on the computer, you need to know the version of the system BIOS currently installed.
BIOS version information (also known as ROM date and System BIOS) can be displayed by pressing fn
+esc (if you are already in Windows) or by using Computer Setup.
1.

Start Computer Setup.

2.

Use a pointing device or the arrow keys to select File > System Information.

3.

To exit Computer Setup without saving your changes, click the Exit icon in the lower-right corner
of the screen, and then follow the on-screen instructions.
– or –
Use the tab key and the arrow keys to select File > Ignore Changes and Exit, and then
press enter.
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Downloading a BIOS update for Windows 7
CAUTION: To reduce the risk of damage to the computer or an unsuccessful installation, download
and install a BIOS update only when the computer is connected to reliable external power using the AC
adapter. Do not download or install a BIOS update while the computer is running on battery power,
docked in an optional docking device, or connected to an optional power source. During the
download and installation, follow these instructions:
Do not disconnect power on the computer by unplugging the power cord from the AC outlet.
Do not shut down the computer or initiate Sleep.
Do not insert, remove, connect, or disconnect any device, cable, or cord.
1.

Access Help and Support by selecting Start > Help and Support.

2.

Select Updates and tune-ups, and then select Check for HP updates now.

3.

At the download area, follow these steps:
a.

Identify the most recent BIOS update and compare it to the BIOS version currently installed on
your computer. Make a note of the date, name, or other identifier. You may need this
information to locate the update later, after it has been downloaded to your hard drive.

b.

Follow the on-screen instructions to download your selection to the hard drive.
If the update is more recent than your BIOS, make a note of the path to the location on your
hard drive where the BIOS update is downloaded. You will need to access this path when
you are ready to install the update.

NOTE: If you connect your computer to a network, consult the network administrator before
installing any software updates, especially system BIOS updates.
BIOS installation procedures vary. Follow any instructions that are displayed on the screen after the
download is complete. If no instructions are displayed, follow these steps:
1.

Select Start > Computer.

2.

Click your hard drive designation. The hard drive designation is typically Local Disk (C:).

3.

Using the hard drive path you recorded earlier, open the folder on your hard drive that contains
the update.

4.

Double-click the file that has an .exe extension (for example, filename.exe).
The BIOS installation begins.

5.

Complete the installation by following the on-screen instructions.

NOTE: After a message on the screen reports a successful installation, you can delete the
downloaded file from your hard drive.
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Using MultiBoot
About the boot device order
As the computer starts, the system attempts to boot from enabled devices. The MultiBoot utility, which is
enabled at the factory, controls the order in which the system selects a boot device. Boot devices can
include optical drives, diskette drives, a network interface card (NIC), hard drives, and USB devices.
Boot devices contain bootable media or files that the computer needs to start and operate properly.
NOTE: Some boot devices must be enabled in Computer Setup before they can be included in the
boot order.
You can change the order in which the computer searches for a boot device by changing the boot
order in Computer Setup. You can also press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen, and then press f9. Pressing f9 displays a menu that
shows the current boot devices and allows you to select a boot device. Or, you can use MultiBoot
Express to set the computer to prompt you for a boot location each time the computer turns on
or restarts.

Choosing MultiBoot preferences
You can use MultiBoot in the following ways:
●

To set a new boot order that the computer uses each time it is turned on, by changing the boot
order in Computer Setup.

●

To dynamically choose the boot device, by pressing esc while the “Press the ESC key for Startup
Menu” message is displayed at the bottom of the screen, and then pressing f9 to enter the Boot
Device Options menu.

●

To use MultiBoot Express to set variable boot orders. This feature prompts you for a boot device
each time the computer is turned on or restarted.

Setting a new boot order in Computer Setup
To start Computer Setup and set a boot device order that the computer uses each time it is turned on or
restarted, follow these steps:
1.

Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

2.

Press f10 to enter Computer Setup.

3.

Use a pointing device or the arrow keys to select the Legacy Boot Order list, and then
press enter.

4.

To move the device up in the boot order, use a pointing device to click the up arrow, or
press the + key.
– or –
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To move the device down in the boot order, use a pointing device to click the down arrow, or
press the - key.
5.

To save your changes and exit Computer Setup, click the Save icon in the lower-left corner of the
screen, and then follow the on-screen instructions.
– or –
Use the arrow keys to select File > Save Changes and Exit, and then press enter.

Dynamically choosing a boot device using the f9 prompt
To dynamically choose a boot device for the current startup sequence, follow these steps:
1.

Open the Select Boot Device menu by turning on or restarting the computer, and then pressing esc
while the “Press the ESC key for Startup Menu” message is displayed at the bottom of the screen.

2.

Press f9.

3.

Use a pointing device or the arrow keys to select a boot device, then press enter.

Setting a MultiBoot Express prompt
To start Computer Setup and set the computer to display the MultiBoot startup location menu each time
the computer is started or restarted, follow these steps:
1.

Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

2.

Press f10 to enter Computer Setup.

3.

Use a pointing device or the arrow keys to select System Configuration > Boot Options,
and then press enter.

4.

In the MultiBoot Express Popup Delay (Sec) field, enter the length of time in seconds that
you want the computer to display the startup location menu before it defaults to the current
MultiBoot setting. (When 0 is selected, the Express Boot startup location menu is not displayed.)

5.

To save your changes and exit Computer Setup, click the Save icon in the lower-left corner of the
screen, and then follow the on-screen instructions.
– or –
Use the arrow keys to select File > Save Changes and Exit, and then press enter.

Your changes go into effect when the computer restarts.
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Entering MultiBoot Express preferences
When the Express Boot menu is displayed during startup, you have the following choices:
●

To specify a boot device from the Express Boot menu, select your preference within the allotted
time, and then press enter.

●

To prevent the computer from defaulting to the current MultiBoot setting, press any key before the
allotted time expires. The computer will not start until you select a boot device and press enter.

●

To allow the computer to start according to the current MultiBoot settings, wait for the allotted time
to expire.

Using HP PC Hardware Diagnostics (UEFI) (select models only)
HP PC Hardware Diagnostics is a Unified Extensible Firmware Interface (UEFI) that allows you to run
diagnostic tests to determine if the computer hardware is functioning properly. The tool runs outside of
the operating system to isolate hardware failures from issues that may be caused by the
operating system or other software components.
To start HP PC Hardware Diagnostics UEFI:
1.

Turn on or restart the computer, quickly press esc, and then press f2.
After pressing f2, the BIOS searches three places for the HP PC Hardware Diagnostics (UEFI) tools
in the following order:
a.

Connected USB drive
NOTE: To download the HP PC Hardware Diagnostics (UEFI) tool to a USB drive, see
Downloading HP PC Hardware Diagnostics (UEFI) to a USB device on page 142.

2.

b.

Hard drive

c.

BIOS

Click the type of diagnostic test you want to run, and then follow the on-screen instructions.
NOTE: If you need to stop a diagnostic test while it is running, press esc.
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Downloading HP PC Hardware Diagnostics (UEFI) to a USB device
NOTE: The HP PC Hardware Diagnostics (UEFI) download instructions are provided in English only.
1.

Go to http://www.hp.com.

2.

Click Support & Drivers, and then click the Drivers & Software tab.

3.

Enter the product name in the text box, and then click Search.

4.

Select your computer model, and then select your operating system.

5.

In the Diagnostic section, click HP UEFI Support Environment.
– or –
Click Download, and then select Run.
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Linux – Computer Setup (BIOS) and Advanced
System Diagnostics
Computer Setup, or Basic Input/Output System (BIOS), controls communication between all the input
and output devices on the system (such as disk drives, display, keyboard, mouse, and printer).
Computer Setup includes settings for the types of peripherals installed, the startup sequence of
the computer, and the amount of system and extended memory.
NOTE: Use extreme care when making changes in Computer Setup. Errors can prevent the computer
from operating properly.

Starting Computer Setup
NOTE: An external keyboard or mouse connected to a USB port can be used with Computer Setup
only if USB legacy support is enabled.
To start Computer Setup, follow these steps:
1.

Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

2.

Press f10 to enter Computer Setup.

Using Computer Setup
Navigating and selecting in Computer Setup
To navigate and select in Computer Setup, follow these steps:
1.

Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.
●

To select a menu or a menu item, use the tab key and the keyboard arrow keys and then
press enter, or use a pointing device to click the item.

●

To scroll up and down, click the up arrow or the down arrow in the upper-right corner of the
screen, or use the up arrow key or the down arrow key.

●

To close open dialog boxes and return to the main Computer Setup screen, press esc, and
then follow the on-screen instructions.

NOTE: You can use either a pointing device (TouchPad, pointing stick, or USB mouse) or the
keyboard to navigate and make selections in Computer Setup.
2.

ENWW

Press f10 to enter Computer Setup.
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To exit Computer Setup menus, choose one of the following methods:
●

To exit Computer Setup menus without saving your changes, click the Exit icon in the lower-left
corner of the screen, and then follow the on-screen instructions.
– or –
Use the tab key and the arrow keys to select File > Ignore Changes and Exit, and then
press enter.
– or –

●

To save your changes and exit Computer Setup menus, click the Save icon in the lower-left corner
of the screen, and then follow the on-screen instructions.
– or –
Use the tab key and the arrow keys to select File > Save Changes and Exit, and then
press enter.

Your changes go into effect when the computer restarts.

Restoring factory settings in Computer Setup
NOTE: Restoring defaults will not change the hard drive mode.
To return all settings in Computer Setup to the values that were set at the factory, follow these steps:
1.

Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

2.

Press f10 to enter Computer Setup.

3.

Use a pointing device or the arrow keys to select File > Restore Defaults.

4.

Follow the on-screen instructions.

5.

To save your changes and exit, click the Save icon in the lower-left corner of the screen, and then
follow the on-screen instructions.
– or –
Use the arrow keys to select File > Save Changes and Exit, and then press enter.

Your changes go into effect when the computer restarts.
NOTE: Your password settings and security settings are not changed when you restore the
factory settings.
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Updating the BIOS
Updated versions of the BIOS may be available on the HP Web site.
Most BIOS updates on the HP Web site are packaged in compressed files called SoftPaqs.
Some download packages contain a file named Readme.txt, which contains information regarding
installing and troubleshooting the file.

Determining the BIOS version
To determine whether available BIOS updates contain later BIOS versions than those currently installed
on the computer, you need to know the version of the system BIOS currently installed.
BIOS version information (also known as ROM date and System BIOS) can be displayed as follows:
1.

Start Computer Setup.

2.

Use a pointing device or the arrow keys to select File > System Information.

3.

To exit Computer Setup without saving your changes, click the Exit icon in the lower-left corner of
the screen, and then follow the on-screen instructions.
– or –
Use the tab key and the arrow keys to select File > Ignore Changes and Exit, and then
press enter.

NOTE: You can also determine the BIOS version by turning on or restarting the computer, pressing
the esc key while the “Press the ESC key for Startup Menu” message is displayed at the bottom of the
screen, and then pressing the f1 key. Follow the on-screen instructions to exit this screen.

Downloading a BIOS update
CAUTION: To reduce the risk of damage to the computer or an unsuccessful installation, download
and install a BIOS update only when the computer is connected to reliable external power using the AC
adapter. Do not download or install a BIOS update while the computer is running on battery power,
docked in an optional docking device, or connected to an optional power source. During the
download and installation, follow these instructions:
Do not disconnect power from the computer by unplugging the power cord from the AC outlet.
Do not shut down the computer or initiate Suspend or Hibernation.
Do not insert, remove, connect, or disconnect any device, cable, or cord.
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1.

Open your web browser. For U.S. support, go to http://www.hp.com/go/contactHP. For
worldwide support, go to http://welcome.hp.com/country/us/en/wwcontact_us.html.

2.

Follow the on-screen instructions to identify your computer and access the BIOS update you want
to download.

3.

Click the option for software and driver downloads, type your computer model number in the
product box, and then press enter. Follow the on-screen instructions to identify your computer and
access the BIOS update you want to download.
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4.

Click your specific product from the models listed.

5.

Click the appropriate operating system.

6.

Go to the BIOS section and download the BIOS software package.

7.

Follow the installation instructions as provided with the downloaded BIOS software package.

NOTE: After a message on the screen reports a successful installation, you can delete the
downloaded file from your hard drive.

Using Advanced System Diagnostics
Advanced System Diagnostics allows you to run diagnostic tests to determine if the computer hardware
is functioning properly. The following diagnostic tests are available in Advanced System Diagnostics:
●

Start-up test—This test analyzes the main computer components that are required to start
the computer.

●

Run-in test—This test repeats the start-up test and checks for intermittent problems that the startup
test does not detect.

●

Hard disk test—This test analyzes the physical condition of the hard drive, and then checks all
data in every sector of the hard drive. If the test detects a damaged sector, it attempts to move the
data to a good sector.

●

Memory test—This test analyzes the physical condition of the memory modules. If it reports an
error, replace the memory modules immediately.

●

Battery test—This test analyzes the condition of the battery and calibrates the battery if necessary.
If the battery fails the test, contact support to report the issue and purchase a replacement battery.

●

System Tune-Up—This group of additional tests checks your computer to make sure that the main
components are functioning correctly. System Tune-Up runs longer and more comprehensive tests
on memory modules, hard drive SMART attributes, the hard drive surface, the battery (and battery
calibration), video memory, and the WLAN module status.

You can view system information and error logs in the Advanced System Diagnostics window.
To start Advanced System Diagnostics:
1.

Turn on or restart the computer. While the “Press the ESC key for Startup Menu” message is
displayed in the lower-left corner of the screen, press esc. When the Startup Menu is displayed,
press f2.

2.

Click the diagnostic test you want to run, and then follow the on-screen instructions.

NOTE: If you need to stop a diagnostics test while it is running, press esc.
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8

Specifications

Metric

U.S.

Width

21.0 cm

12.2 in

Depth

21.5 cm

8.5 in

Height

2.1 cm

0.83 in

Equipped with 3-cell, 26-WHr battery, 1 memory
module, WLAN module, lightest solid-state module, but
without fingerprint reader, webcam, or WWAN module

1.33 kg

2.93 lb

Equipped with 3-cell, 46-WHr battery, 1 memory
module, WLAN module, lightest solid-state module, but
without fingerprint reader, webcam, or WWAN module

1.42 kg

3.13 lb

Operating voltage and current

19.5 V dc @ 2.31 A - 45 W

Dimensions

19.5 V dc @ 3.33 A - 65 W
Temperature
Operating

5°C to 35°C

41°F to 95°F

Nonoperating

-20°C to 60°C

-4°F to 140°F

Relative humidity (non-condensing)
Operating

10% to 90%

Nonoperating

5% to 95%

Maximum altitude (unpressurized)
Operating

-15 m to 3,048 m

-50 ft to 10,000 ft

Nonoperating

-15 m to 12,192 m

-50 ft to 40,000 ft

NOTE: Applicable product safety standards specify thermal limits for plastic surfaces. The device operates well within this
range of temperatures.
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Backup and recovery

Windows 8
To protect your information, use Windows backup and restore utilities to back up individual files and
folders, back up your entire hard drive, create system repair media (select models only) by using the
installed optical drive (select models only) or an optional external optical drive, or create system restore
points. In case of system failure, you can use the backup files to restore the contents of your computer.
From the Start screen, type restore, click Settings, and then select from the list of displayed options.
NOTE: For detailed instructions on various backup and restore options, perform a search for these
topics in HP Support Assistant. To access HP Support Assistant on the Start screen, select the HP
Support Assistant app.
In case of system instability, HP recommends that you print the recovery procedures and save them for
later use.
NOTE: Windows includes the User Account Control feature to improve the security of your computer.
You may be prompted for your permission or password for tasks such as installing software, running
utilities, or changing Windows settings. Refer to HP Support Assistant. To access HP Support Assistant
on the Start screen, select the HP Support Assistant app.

Backing up your information
Recovery after a system failure is as good as your most recent backup. You should create system repair
media and your initial backup immediately after initial system setup. As you add new software and
data files, you should continue to back up your system on a regular basis to maintain a reasonably
current backup. The system repair media (select models only) are used to start up (boot) the computer
and repair the operating system in case of system instability or failure. Your initial and subsequent
backups allow you to restore your data and settings if a failure occurs.
On the Start screen, type backup, click Settings, and then select Save backup copies of your
files with File History.
You can back up your information to an optional external hard drive or a network drive.
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Note the following when backing up:
●

Store personal files in the Documents library, and back it up regularly.

●

Back up templates that are stored in their associated programs.

●

Save customized settings that appear in a window, toolbar, or menu bar by taking a screen shot
of your settings. The screen shot can be a time-saver if you have to reset your preferences.

To create a backup using Backup and Restore:
NOTE: Be sure that the computer is connected to AC power before you start the backup process.
NOTE: The backup process may take over an hour, depending on file size and the speed of
the computer.
1.

From the Start screen, type backup, click Settings, and then select from the list of
displayed options.

2.

Follow the on-screen instructions to set up your backup, create a system image (select models
only), or create system repair media (select models only).

Performing a system recovery
In case of system failure or instability, the computer provides the following tools to recover your files:
●

Windows recovery tools: You can use Windows Backup and Restore to recover information you
have previously backed up. You can also use Windows Automatic Repair to fix problems that
might prevent Windows from starting correctly.

●

f11 recovery tools: You can use the f11 recovery tools to recover your original hard drive image.
The image includes the Windows operating system and software programs installed at the factory.

NOTE: If you are unable to boot (start up) your computer and you cannot use the system repair
media you previously created (select models only), you must purchase Windows 8 operating system
media to reboot the computer and repair the operating system. For additional information, see Using
Using Windows 8 operating system media (purchased separately) on page 152.

150

Chapter 9 Backup and recovery

ENWW

Using the Windows recovery tools
To recover information you previously backed up:
▲

Access HP Support Assistant. To access HP Support Assistant on the Start screen, select the HP
Support Assistant app.

To recover your information using Automatic Repair, follow these steps:
CAUTION: Some Automatic Repair options will completely erase and reformat the hard drive. All
files you have created and any software installed on the computer are permanently removed. When
reformatting is complete, the recovery process restores the operating system, as well as the drivers,
software, and utilities from the backup used for recovery.
1.

If possible, back up all personal files.

2.

If possible, check for the presence of the Recovery Image partition and the Windows partition.
From the Start screen, type e, and then click File Explorer.
– or –
From the Start screen, type c, and then select Computer.
NOTE: If the Windows partition and the Recovery Image partition are not listed, you must
recover your operating system and programs using the Windows 8 operating system DVD and the
Driver Recovery media (both purchased separately). For additional information, see Using
Windows 8 operating system media (purchased separately) on page 152.

3.

If the Windows partition and the Recovery Image partition are listed, restart the computer. After
Windows has loaded, press and hold the shift key while clicking Restart.

4.

Select Troubleshoot, then select Advanced Options, and then select Automatic Repair.

5.

Follow the on-screen instructions.

NOTE: For additional information on recovering information using the Windows tools, perform a
search for these topics in HP Support Assistant. To access HP Support Assistant on the Start screen,
select the HP Support Assistant app.
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Using f11 recovery tools
CAUTION: Using f11 completely erases hard drive contents and reformats the hard drive. All files
that you have created and any software that you have installed on the computer are permanently
removed. The f11 recovery tool reinstalls the operating system and HP programs and drivers that were
installed at the factory. Software not installed at the factory must be reinstalled.
To recover the original hard drive image using f11:
1.

If possible, back up all personal files.

2.

If possible, check for the presence of the HP Recovery partition: From the Start screen, type C, and
then select Computer.
NOTE: If the Recovery Image partition is not listed, you must recover your operating system and
programs using the Windows 8 operating system media and the Driver Recovery media (both
purchased separately). For additional information, see Using Windows 8 operating system media
(purchased separately) on page 152.

3.

If the Recovery Image partition is listed, restart the computer, and then press esc while the “Press
the ESC key for Startup Menu” message is displayed at the bottom of the screen.

4.

Press f11 while the “Press <F11> for recovery” message is displayed on the screen.

5.

Follow the on-screen instructions.

Using Windows 8 operating system media (purchased separately)
NOTE: Your computer may not come equipped with an internal optical drive. In order to use the
operating system DVD, you may need to plug in an external optical drive.
To order a Windows 8 operating system DVD, go to http://www.hp.com/support, select your country
or region, and follow the on-screen instructions. You can also order the DVD by calling support. For
contact information, see the Worldwide Telephone Numbers booklet included with the computer.
CAUTION: Using a Windows 8 operating system media completely erases hard drive contents and
reformats the hard drive. All files that you have created and any software that you have installed on the
computer are permanently removed. When reformatting is complete, the recovery process helps you
restore the operating system, as well as drivers, software, and utilities.
To initiate recovery using a Windows 8 operating system DVD:
NOTE: This process takes several minutes.
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1.

If possible, back up all personal files.

2.

Restart the computer, and then insert the Windows 8 operating system DVD into the optical drive
before the Windows operating system loads.

3.

When prompted, press any keyboard key.

4.

Follow the on-screen instructions.
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After the installation is completed:
1.

Eject the Windows 8 operating system media and then insert the Driver Recovery media.

2.

Install the Hardware Enabling Drivers first, and then install Recommended Applications.

Using Windows Refresh for quick and easy recovery
When your computer is not working properly and you need to regain system stability, the Windows
Refresh option allows you to start fresh and keep what is important to you.
IMPORTANT: Refresh removes any traditional applications that were not originally installed on the
system at the factory.
NOTE: During Refresh, a list of removed traditional applications will be saved so that you have a
quick way to see what you might need to reinstall. See HP Support Assistant for instructions on
reinstalling traditional applications. To access HP Support Assistant on the Start screen, select the HP
Support Assistant app.
NOTE: You may be prompted for your permission or password when using Refresh. See HP Support
Assistant for more information. To access HP Support Assistant on the Start screen, select the HP
Support Assistant app.
To start Refresh:
1.

On the Start screen, point to the far-right upper or lower corner of the screen to display
the charms.

2.

Click Settings.

Remove everything and reinstall Windows
Sometimes you want to perform detailed reformatting of your computer, or you want to remove
personal information before you give away or recycle your computer. The process described in this
section provides a speedy, simple way to return the computer to its original state. This option removes
all personal data, apps, and settings from your computer, and reinstalls Windows.
IMPORTANT: This option does not provide backups of your information. Before using this option,
back up any personal information you wish to retain.
You can initiate this option by using the f11 key or from the Start screen.
To use the f11 key:
1.

Press f11 while the computer boots.
– or –
Press and hold f11 as you press the power button.
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2.

Choose your language.

3.

Choose your keyboard layout.
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4.

Select Troubleshoot from the boot options menu.

5.

Select Reset your PC, and follow the on-screen instructions.

To use the Start screen:
1.

On the Start screen, point to the far-right upper or lower corner of the screen to display
the charms.

2.

Click Settings.

3.

Click Change PC settings in the bottom-right corner of the screen, and then select General
from the PC settings screen.

4.

Scroll the right-side choices down to display Remove everything and reinstall Windows.

5.

Under Remove everything and reinstall Windows, select Get started, and follow the
onscreen instructions.

Using HP Software Setup
HP Software Setup can be used to reinstall drivers or select software that has been corrupted or deleted
from the system.
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1.

From the Start screen, type HP Software Setup, and select Apps.

2.

Open HP Software Setup.

3.

Follow the on-screen directions to reinstall drivers or select software.
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Windows 7
To protect your information, use Windows Backup and Restore to back up individual files and folders,
back up your entire hard drive (select models only), create system repair discs (select models only)with
the installed optical drive (select models only) or an optional external optical drive, or create system
restore points. In case of system failure, you can use the backup files to restore the contents of your
computer.
Windows Backup and Restore provides the following options:
●

Creating a system repair disc (select models only) by using the installed optical drive (select
models only) or an optional external optical drive

●

Backing up your information

●

Creating a system image (select models only)

●

Scheduling automatic backups (select models only)

●

Creating system restore points

●

Recovering individual files

●

Restoring the computer to a previous state

●

information using recovery tools

NOTE: For detailed instructions, perform a search for these topics in Help and Support.
In case of system instability, HP recommends that you print the recovery procedures and save them for
later use.
NOTE: Windows includes the User Account Control feature to improve the security of your computer.
You may be prompted for your permission or password for tasks such as installing software, running
utilities, or changing Windows settings. See Help and Support for more information.
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Creating recovery media with HP Recovery Disc Creator
NOTE: Your computer may not come equipped with an internal optical drive. In order to create the
recovery DVD, you may need to plug in an external optical drive.
HP Recovery Disc Creator is a software program that offers an alternative way to create recovery
media. After you successfully set up the computer, you can create recovery media using HP Recovery
Disc Creator. This recovery media performs a system recovery if the hard drive becomes corrupted. A
system recovery reinstalls the original operating system and the software programs installed at the
factory, and then configures the settings for the programs.
HP Recovery Disc Creator can create two kinds of recovery DVDs as follows:
●

Windows DVD—Installs the operating system without additional drivers or applications. Choosing
this selection creates a DVD that restores the original operating system and the software programs
installed at the factory.

●

Driver DVD—Installs specific drivers and applications only, in the same way that the HP Software
Setup utility installs drivers and applications.

Creating recovery media
NOTE: Operating system recovery media can be created only once. Thereafter, the option to create
that media will not be available.
1.

Select Start > All Programs > Security and Protection > HP Recovery Disc Creator.

2.

Select Driver DVD or Windows DVD.

3.

From the drop-down menu, select the drive for burning the recovery media.

4.

Click the Burn button to start the burning process.

Backing up your information
Recovery after a system failure is as good as your most recent backup. Immediately after software
setup, you should create system repair discs (select models only) using HP Recovery Disc Creator using
the installed optical drive (select models only) or an optional external optical drive and back up your
system. As you add new software and data files, you should continue to back up your system on a
regular basis to maintain a reasonably current backup. The system repair discs (select models only) are
used to start up (boot) the computer and repair the operating system in case of system instability or
failure. Your initial and subsequent backups allow you to restore your data and settings if a failure
occurs.
You can back up your information to an optional external hard drive, a network drive, or discs.
Note the following when backing up:
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●

Store personal files in the Documents library, and back it up regularly.

●

Back up templates that are stored in their associated programs.

●

Save customized settings that appear in a window, toolbar, or menu bar by taking a screen shot
of your settings. The screen shot can be a time-saver if you have to reset your preferences.
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●

When backing up to discs, use any of the following types of discs (purchased separately): CD-R,
CD-RW, DVD+R, DVD+R DL, DVD-R, DVD-R DL, or DVD±RW. The discs you use will depend on the
type of optical drive you are using.
NOTE: Your computer may not come equipped with an internal optical drive. In order to create
back up discs, you may need to plug in an external optical drive.
NOTE: DVDs and DVDs with double-layer (DL) support store more information than CDs, so
using them for backup reduces the number of recovery discs required.

●

When backing up to discs, number each disc before inserting it into the external drive.

To create a backup using Backup and Restore:
NOTE: Be sure that the computer is connected to AC power before you start the backup process.
NOTE: The backup process may take over an hour, depending on file size and the speed of the
computer.
1.

Select Start > All Programs > Maintenance > Backup and Restore.

2.

Follow the on-screen instructions to set up your backup, create a system image (select models
only), or create a system repair disc (select models only).

Performing a system recovery
In case of system failure or instability, the computer provides the following tools to recover your files:
●

Windows recovery tools: You can use Windows Backup and Restore to recover information you
have previously backed up. You can also use Windows Startup Repair to fix problems that might
prevent Windows from starting correctly.

●

f11 recovery tools: You can use the f11 recovery tools to recover your original hard drive image.
The image includes the Windows operating system and software programs installed at the factory.

NOTE: If you are unable to boot (start up) your computer and you cannot use the system repair discs
you previously created (select models only), you must purchase a Windows 7 operating system DVD to
reboot the computer and repair the operating system. For additional information, see Using a Windows
7 operating system DVD (purchased separately) on page 160.
NOTE: Your computer may not come equipped with an internal optical drive. In order to use the
operating system DVD, you may need to plug in an external optical drive.
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Using the Windows recovery tools
To recover information you previously backed up:
1.

Select Start > All Programs > Maintenance > Backup and Restore.

2.

Follow the on-screen instructions to recover your system settings, your computer (select models
only), or your files.

To recover your information using Startup Repair, follow these steps:
CAUTION: Using Startup Repair completely erases hard drive contents and reformats the hard drive.
All files you have created and any software installed on the computer are permanently removed. When
reformatting is complete, the recovery process restores the operating system, as well as the drivers,
software, and utilities from the backup used for recovery.
1.

If possible, back up all personal files.

2.

If possible, check for the presence of the Windows partition and the HP Recovery partition.
To check for the Windows partition, select Start > Computer.
To check for the HP Recovery partition, click Start, right-click Computer, click Manage, and
then click Disk Management.
NOTE: If the HP Recovery partition has been deleted, the f11 restore option will not function.
You must recover your operating system and programs using the Windows 7 operating system
DVD and the Driver Recovery disc (both purchased separately) if the Windows partition and the
HP Recovery partition are not listed. For additional information, see Using a Windows 7
operating system DVD (purchased separately) on page 160.

3.

If the Windows partition and the HP Recovery partition are listed, restart the computer, and then
press f8 before the Windows operating system loads.

4.

Select Startup Repair.

5.

Follow the on-screen instructions.

NOTE: For additional information on recovering information using the Windows tools, perform a
search for these topics in Help and Support.
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Using f11 recovery tools
CAUTION: Using f11 recovery tools completely erases hard drive contents and reformats the hard
drive. All files you have created and any software installed on the computer are permanently removed.
The f11 recovery tool reinstalls the operating system and HP programs and drivers that were installed at
the factory. Software not installed at the factory must be reinstalled.
To recover the original hard drive image using f11:
1.

If possible, back up all personal files.

2.

If possible, check for the presence of the HP Recovery partition: click Start, right-click Computer,
click Manage, and then click Disk Management.
NOTE: If the HP Recovery partition is not listed, you must recover your operating system and
programs using the Windows 7 operating system DVD and the Driver Recovery disc (both
purchased separately). For additional information, see Using a Windows 7 operating system DVD
(purchased separately) on page 160.
NOTE: Your computer may not come equipped with an internal optical drive. In order to use the
operating system DVD, you may need to plug in an external optical drive.
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3.

If the HP Recovery partition is listed, restart the computer, and then press esc while the “Press the
ESC key for Startup Menu” message is displayed at the bottom of the screen.

4.

Press f11 while the “Press <F11> for recovery” message is displayed on the screen.

5.

Follow the on-screen instructions.
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Using a Windows 7 operating system DVD (purchased separately)
To order a Windows 7 operating system DVD, go to the HP website. For U.S. support, go to
http:// www.hp.com/go/contactHP. For worldwide support, go to http://welcome.hp.com/country/
us/en/ wwcontact_us.html. You can also order the DVD by calling support. For contact information,
see the Worldwide Telephone Numbers booklet included with the computer.
CAUTION: Using a Windows 7 operating system DVD completely erases hard drive contents and
reformats the hard drive. All files you have created and any software installed on the computer are
permanently removed. When reformatting is complete, the recovery process helps you restore the
operating system, as well as drivers, software, and utilities.
To initiate recovery using a Windows 7 operating system DVD:
NOTE: This process takes several minutes.
NOTE: Your computer may not come equipped with an internal optical drive. In order to use the
operating system DVD, you may need to plug in an external optical drive.
1.

If possible, back up all personal files.

2.

Restart the computer, and then insert the Windows 7 operating system DVD into the optical drive
before the Windows operating system loads.

3.

When prompted, press any keyboard key.

4.

Follow the on-screen instructions.

5.

Click Next.

6.

Select Repair your computer.

7.

Follow the on-screen instructions.

After the repair is completed:
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1.

Eject the Windows 7 operating system DVD, and then insert the Driver Recovery disc.

2.

Install the Hardware Enabling Drivers first, and then install Recommended Applications.
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Linux
Recovery after a system failure is as good as your most recent backup. As you add new software and
data files, you should continue to back up your system on a regular basis to maintain a reasonably
current backup.needed.
Your computer includes tools provided by HP to help you safeguard your information and retrieve it if
ever needed.

Creating backups
1.

Create restore media immediately after you set up the computer. For more information, see
Performing a system recovery on page 162.

2.

As you add files, routinely create a backup of your system and personal information.

Backing up your information
You should back up your computer files on a regular schedule to maintain a current backup. You can
manually back up your information to an optional external drive, a network drive, or discs. Back up
your system at the following times:
●

At regularly scheduled times

●

Before the computer is repaired or restored

●

Before you add or modify hardware or software

To back up your home directory files using Backup Manager Settings:
1.

Select Computer > More Applications > Tools > Backup Manager Settings, and click
Backup my home directory.

2.

Click Storage Destination Location, and then select a location to back up your information.

3.

Click Schedule, and then select a time schedule to perform backups at a regularly
scheduled time.
To immediately back up your information, click the Backup Now check box.
NOTE: Before you back up your information, be sure you have designated a location to save
the backup files.

4.

Click Save and Backup to start the backup and to save the backup settings.

To restore backup files:
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1.

Select Computer > More Applications > Tools > Backup Manager Restore.

2.

Click Backup Source, and then select the location of the backup files.

3.

Click Restore Destination, and then select the destination to restore the files.
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4.

To restore all files from the selected location, click Restore all files. To restore select files only,
click Restore selected files, click Select Files and then select the files to be restored.

5.

Under Restore Point, click the time and date of the backup.
NOTE: If multiple backups have been performed, click Use the latest version to restore the
latest version.

6.

Click Restore to start restoring the files, or click Cancel to cancel the operation.

Performing a system recovery
Recovery allows you to repair or restore the computer to its original factory state. You can create an HP
Factory Image, using an installed or an external DVD±RW optical drive.
NOTE: Your computer may not come equipped with an internal optical drive. In order to create the
HP Factory Image, you may need to plug in an external optical drive.
CAUTION: Using Recovery completely erases hard drive contents and reformats the hard drive. All
files you have created and any software installed on the computer are permanently removed. The
recovery tool reinstalls the original operating system and HP programs and drivers that were installed at
the factory. Software, drivers, and updates not installed by HP must be manually reinstalled. Personal
files must be restored from a backup.
To restore the computer using the HP Factory Image, you must first create the recovery ISO file and then
burn it to an optical disc.
NOTE: HP recommends that you create the HP Factory Image in the event of a system failure.
1.

Select Computer > More Applications.

2.

In the left pane, click Tools, and then click Create HP Factory Image in the right pane.

3.

Enter the root password when prompted.

4.

Right-click on the HP_Recovery.iso file and select Open with Brasero.

5.

Insert a blank DVD disc and select Burn. This creates the HP Factory Image Restore DVD.

To restore the computer from the recovery disc, follow these steps:
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1.

If possible, back up all personal files.

2.

Insert the HP Factory Image Restore DVD into the optical drive and restart the computer.

3.

As the computer is restarting, press f9 to open the Computer Setup boot option menu.

4.

Select Optical Disk Drive from the Boot Options menu and press enter.

5.

Press enter to select Restore System from Media.

6.

At both of the System Recovery prompts, select Yes.
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Remove everything and reinstall SLED
Sometimes you want to perform detailed reformatting of your computer, or you want to remove
personal information before you give away or recycle your computer. The process described in this
section provides a speedy, simple way to return the computer to its original state. This option removes
all personal data, applications, and settings from your computer, and reinstalls the Linux
operating system.
IMPORTANT: This option does not provide backups of your information. Before using this option,
back up any personal information you wish to retain.
You can initiate this option by using the f11 key.
To use the f11 key:
Press f11 while the computer boots.
– or –
Press and hold f11 as you press the power button.
To reinstall SLED, follow the steps below.
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1.

Select System Recovery from the boot menu after pressing f11.

2.

A prompt will appear, reading, “This utility will wipe out your hard drive contents and restore your
PC to factory state. Are you sure you want to continue?” Select Yes.

3.

A prompt will appear, reading, “Please confirm you want to restore your system to factory state
and lose all your current data.” Select Yes.

Linux
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10 Statement of Volatility

The purpose of this document is to provide general information regarding non-volatile memory in
industry-standards based HP Business Notebook PC systems and provide general instructions for
restoring nonvolatile memory that can contain personal data after the system has been powered off and
the hard drive has been removed.
HP Business Notebook PC products that use Intel-based or AMD®-based system boards contain volatile
DDR memory. The amount of nonvolatile memory present in the system depends upon the system
configuration. Intel-based and AMD-based system boards contain nonvolatile memory subcomponents
as originally shipped from HP assuming that no subsequent modifications have been made to the
system and assuming that no applications, features, or functionality have been added to or installed on
the system.
Following system shutdown and removal of all power sources from an HP Business Notebook PC
system, personal data can remain on volatile system memory (DIMMs) for a finite period of time and
will also remain in nonvolatile memory. The steps below will remove personal data from the notebook
PC, including the nonvolatile memory found in Intel-based and AMD-based system boards. Some of
these steps are disclosed in the Maintenance and Service Guides available for HP PC products
available on the product support pages at www.hp.com.
1.
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Follow steps (a) through (I) below to restore the nonvolatile memory that can contain personal
data. Restoring or re-programming nonvolatile memory that does not store personal data is neither
necessary nor recommended.
a.

Enter BIOS (F10) Setup by powering on the system and pressing F10 when prompted near
the bottom of the display, or press the ESC key to display the start up menu, then press F10 .
If the system has a BIOS administrator password, enter the password at the prompt.

b.

Select the Main menu, then Restore Defaults.

c.

Select the System Configuration menu, then Restore Security Defaults.

d.

If an asset or ownership tag is set, select the Security menu and scroll down to the Utilities
menu. Select System IDs, and then select the tag that has been set. Press the spacebar
once to clear the tag, then press Enter to return to the prior menu.

e.

If a DriveLock password is set, select the Security menu, scroll down to DriveLock, then
select DriveLock password. Select the desired hard drive. Click Disable protection,
enter the existing master DriveLock password, then press Enter to confirm and return to the
prior menu. Repeat this procedure if more than one hard drive has a DriveLock password.
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f.

If an Automatic DriveLock password is set, select the Security menu, scroll down to
Automatic DriveLock, then select the desired hard drive and disable protection. Repeat
this procedure if more than one hard drive has an Automatic DriveLock password.

g.

Select the File menu, then Reset BIOS Security to factory default. Click yes at the
warning message.

h.

Select the Main menu, then Save Changes and Exit.

i.

Reboot the system. If the system has a Trusted Platform Module and/or fingerprint sensor, one
or two prompts will appear: one to clear the TPM and the other to reset fingerprint sensor.
Press F1 to accept or F2 to reject.
If the HP notebook model number ends in a ‘p’ or ‘w’ and includes Intel Centrino with
VProTM, reboot the PC and enter BIOS Setup by pressing F10 when prompted. Select
System Configuration, then AMT Options. Then select Un-configure AMT on next
boot. Select Save, then Yes. Select the File menu, and then select Save Changes and
Exit. Reboot the system and confirm that you want to un-configure AMT.

2.

j.

If the optional Intel Anti-Theft Technology (AT) was activated, contact the provider to
deactivate it.

k.

If the optional Absolute® Software Computrace® management and tracking service was
activated on the notebook PC, contact the provider to deactivate it.

l.

Remove all power and system batteries for at least 24 hours.

Remove and retain the storage drive or clear the contents of the drive.
a.

Hard Disk Drive (HDD)
Clear the HDD contents by using the HP Disk Sanitizer® utility or a third party application
that, ideally, is U.S. Department of Defense (DOD) 5220.22-M approved.
To run HP Disk Sanitizer, enter BIOS Setup by powering on the system and pressing F10
when prompted near the bottom of the display, or press ESC to display the start up menu,
then press F10. Select the Security menu and scroll down to the Utilities menu. Select
Disk Sanitizer and select the desired drive. For a higher level of protection, select
Optimum.
NOTE: This process will take a long time, and the amount of time varies based on the hard
drive capacity.

b.

Solid State Drive (SSD)
Clear the SSD contents by using the BIOS Setup Secure Erase command option, or by using a
third party utility designed to erase data from an SSD. To run Secure Erase, enter BIOS Setup
by powering on the system and pressing F10 when prompted near the bottom of the display.
Select the Security menu and scroll down to the Utilities menu. Select Secure Erase and
select the desired hard drive.
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Non-volatile memory usage
Non Volatile
Memory
Type

Amount
(Size)

Does this
memory
store
customer
data?

Does this
memory
retain data
when power
is removed?

What is the
purpose of
this
memory?

How is data
input into
this
memory?

How is this
memory
write
protected?

HP Sure Start
flash (select
models only)

2 MB

No

Yes

Provides
protected
backup of
critical System
BIOS code, EC
firmware, and
critical PC
configuration
data for select
platforms that
support HP Sure
Start.

Data cannot be
written to this
device via the
host processor.
The content is
managed solely
by the HP Sure
Start Embedded
Controller.

This memory is
protected by the
HP Sure Start
Embedded
Controller.

For more
information, see
Using HP Sure
Start (select
models only)
on page 172.

ENWW

Real Time Clock
(RTC) battery
backed-up
CMOS
configuration
memory
(CMOS)

256 Bytes

No

Yes

Stores system
date and time
and limited
keyboard
controller data.

Using the F10
Setup utility or
changing the
Microsoft
Windows date
and time.

This memory is
not writeprotected. HP
recommends
password
protecting the
F10 Setup
utility.

Controller (NIC)
EEPROM

64 KBytes (not
customer
accessible)

No

Yes

Store NIC
configuration
and NIC
firmware.

Using a utility
from the NIC
vendor that can
be run from
DOS.

A utility is
required to
write data to
this memory
and is available
from NIC
vendor. Writing
data to this
ROM in an
inappropriate
manner will
render the NIC
nonfunctional.
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Non Volatile
Memory
Type

Amount
(Size)

Does this
memory
store
customer
data?

Does this
memory
retain data
when power
is removed?

What is the
purpose of
this
memory?

How is data
input into
this
memory?

How is this
memory
write
protected?

Keyboard ROM

64 KBytes (not
customer
accessible)

No

Yes

Stores firmware
code
(keyboard,
mouse, &
battery
management).

Programmed at
the factory.
Code is
updated when
the system BIOS
is updated.

A utility is
required for
writing data to
this memory
and is available
on the HP
website.
Writing data to
this ROM in an
inappropriate
manner can
render the PC
nonfunctional.

DIMM Serial
Presence Detect
(SPD)
configuration
data

256 Bytes per
memory
module, 128
Bytes
programmable
(not customer
accessible)

No

Yes

Stores memory
module
information.

Programmed by
the memory
vendor.

Data cannot be
written to this
memory when
the module is
installed in a
PC. The specific
write protection
method varies
by memory
vendor.

System BIOS

4 to 5 MBytes

Yes

Yes

Store system
BIOS code and
PC
configuration
data.

System BIOS
code is
programmed at
the factory.
Code is
updated when
the system BIOS
is updated.
Configuration
data and
settings are
input using the
F10 setup utility
or a custom
utility.

A utility is
required for
writing data to
this memory
and is available
on the HP
website.
Writing data to
this ROM in an
inappropriate
manner can
render the PC
nonfunctional.
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Non Volatile
Memory
Type

ENWW

Amount
(Size)

Does this
memory
store
customer
data?

Does this
memory
retain data
when power
is removed?

What is the
purpose of
this
memory?

How is data
input into
this
memory?

How is this
memory
write
protected?

Intel
1.5 or 5
Management
MBytes
Engine
Firmware
(present only in
specific ZBook
and EliteBook
models. For
more
information, go
to
http://www.hp.com/
support, and
select your
country. Select
Drivers &
Downloads,
and then follow
the on-screen
instructions.)

Yes

Yes

Stores
Management
Engine Code,
Settings,
Provisioning
Data and iAMT
third party data
store.

Management
Engine Code is
programmed at
the factory.
Code is
updated via
Intel secure
firmware
update utility.
Unique
Provisioning
Data can be
entered at the
factory or by an
administrator
using the
Management
Engine (MEBx)
setup utility. The
third party data
store contents
can populated
by a remote
management
console or local
applications
registered by
an
administrator to
have access to
the space.

The Intel chipset
is configured to
enforce
hardware
protection to
block all direct
read/write
access to this
area. An Intel
utility is
required for
updating the
firmware. Only
firmware
updates
digitally signed
by Intel can be
applied using
this utility.

Bluetooth flash

No

Yes

Stores Bluetooth
configuration
and firmware.

Programmed at
the factory.
Tools for writing
data to this
memory are not
publicly
available but
can be
obtained from
the silicon
vendor.

A utility is
required for
writing data to
this memory
and is made
available
through newer
versions of the
driver if the
flash requires
an upgrade.

2 MBits
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Non Volatile
Memory
Type

Amount
(Size)

Does this
memory
store
customer
data?

Does this
memory
retain data
when power
is removed?

What is the
purpose of
this
memory?

How is data
input into
this
memory?

How is this
memory
write
protected?

802.11 WLAN
EEPROM

4 KBytes to 8
KBytes

No

Yes

Stores
configuration
and calibration
data.

Programmed at
the factory.
Tools for writing
data to this
memory are not
made public.

A utility is
required for
writing data to
this memory
and is typically
not made
available to the
public unless a
firmware
upgrade is
necessary to
address a
unique issue.

Webcam

64 KBits

No

Yes

Store webcam
configuration
and firmware.

Using a utility
from the device
manufacturer
that can be run
from Windows.

A utility is
required for
writing data to
this memory
and is typically
not made
available to the
public unless a
firmware
upgrade is
necessary to
address a
unique issue.

Fingerprint
reader

512 KBytes
flash

Yes

Yes

Stores
fingerprint
templates.

By enrolling in
HP ProtectTools
Security
Manager.

Only a digitally
signed
application can
make the call to
write to the
flash.
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Questions and answers
1.

2.

How can the BIOS settings be restored (returned to default settings)?
a.

Turn on or restart the computer and press F10 when prompted near the bottom of the display.

b.

Select File, then select Restore defaults.

c.

Follow the on-screen instructions.

d.

Select File, save changes and exit, then press Enter.

What kind of configuration data is stored on the DIMM Serial Presence Detect
(SPD) memory module? How would this data be written?
The DIMM SPD memory contains information about the memory module such as size, serial
number, data width, speed/timing, voltage and thermal information. This information is written by
the module manufacturer and stored on an EEPROM. This EEPROM cannot be written to when the
memory module is installed in a PC. Third party tools do exist that can write to the EEPROM when
the memory module is not installed in a PC. There are various third party tools available to read
SPD memory.

3.

Does the “Firmware Hub for System BIOS” contain the BIOS program? Is this chip
writable, and if so how?
The Firmware Hub does contain the BIOS program and is writable. A utility is required to perform
the write function.

4.

In some PC systems, the Firmware Hub for System BIOS is a flash memory chip
so that updates can be written by the customer. Is this true for these BIOS chips?
Yes, they are flash memory chips.

5.

What is meant by “Restore the nonvolatile memory found in Intel-based
system boards?”
This relates to clearing the Real Time Clock (RTC) CMOS memory that contains PC
configuration data.

6.

Does resetting the CMOS configuration memory return the PC back to
factory defaults?
The process of resetting the CMOS will return certain system settings to factory default but will not
reset many of the system data and configuration defaults to their default settings. To return these
system data and configuration defaults to default settings, refer to question and answer 1 and
follow the instructions for returning the BIOS settings to factory defaults.
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Using HP Sure Start (select models only)
Select computer models are configured with HP Sure Start, a technology that continuously monitors your
computer's BIOS for attacks or corruption. If the BIOS becomes corrupted or is attacked, HP Sure Start
restores the BIOS to its previously safe state automatically, with user intervention. Those select computer
models ship with HP Sure Start configured and enabled. Most users can use HP Sure Start with the
default configuration.
To access the latest documentation on HP Sure Start, go to http://www.hp.com/support, and select
your country. Select Driver & and Downloads, and then follow the on-screen instructions.
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11 Power cord set requirements

The wide-range input feature of the computer permits it to operate from any line voltage from 100 to
120 volts AC, or from 220 to 240 volts AC.
The 3-conductor power cord set included with the computer meets the requirements for use in the
country or region where the equipment is purchased.
Power cord sets for use in other countries and regions must meet the requirements of the country or
region where the computer is used.

Requirements for all countries
The following requirements are applicable to all countries and regions:
●

The length of the power cord set must be at least 1.0 m (3.3 ft) and no more than 2.0 m (6.5 ft).

●

All power cord sets must be approved by an acceptable accredited agency responsible for
evaluation in the country or region where the power cord set will be used.

●

The power cord sets must have a minimum current capacity of 10 amps and a nominal voltage
rating of 125 or 250 V AC, as required by the power system of each country or region.

●

The appliance coupler must meet the mechanical configuration of an EN 60 320/IEC 320
Standard Sheet C13 connector for mating with the appliance inlet on the back of the computer.
Requirements for all countries 113

Requirements for specific countries and regions
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Country/region

Accredited agency

Applicable note number

Australia

EANSW

1

Austria

OVE

1

Belgium

CEBC

1

Canada

CSA

2

Denmark

DEMKO

1

Finland

FIMKO

1

Requirements for all countries
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Country/region

Accredited agency

Applicable note number

France

UTE

1

Germany

VDE

1

Italy

IMQ

1

Japan

METI

3

The Netherlands

KEMA

1

Norway

NEMKO

1

The People's Republic of China

COC

5

South Korea

EK

4

Sweden

CEMKO

1

Switzerland

SEV

1

Taiwan

BSMI

4

The United Kingdom

BSI

1

The United States

UL

2

1.

The flexible cord must be Type HO5VV-F, 3-conductor, 1.0-mm² conductor size. Power cord set fittings (appliance coupler
and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it
will be used.

2.

The flexible cord must be Type SPT-3 or equivalent, No. 18 AWG, 3-conductor. The wall plug must be a two-pole
grounding type with a NEMA 5-15P (15 A, 125 V) or NEMA 6-15P (15 A, 250 V) configuration.

3.

The appliance coupler, flexible cord, and wall plug must bear a “T” mark and registration number in accordance with the
Japanese Dentori Law. The flexible cord must be Type VCT or VCTF, 3-conductor, 1.00-mm² conductor size. The wall plug
must be a two-pole grounding type with a Japanese Industrial Standard C8303 (7 A, 125 V) configuration.

4.

The flexible cord must be Type RVV, 3-conductor, 0.75-mm² conductor size. Power cord set fittings (appliance coupler
and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it
will be used.

5.

The flexible cord must be Type VCTF, 3-conductor, 0.75-mm² conductor size. Power cord set fittings (appliance coupler
and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it
will be used.
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12 Recycling

When a non-rechargeable or rechargeable battery has reached the end of its useful life, do not dispose
of the battery in general household waste. Follow the local laws and regulations in your area for
battery disposal.
HP encourages customers to recycle used electronic hardware, HP original print cartridges, and
rechargeable batteries. For more information about recycling programs, see the HP Web site at
http://www.hp.com/recycle.
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Index

A
AC adapter light 23
AC adapter, spare part numbers
45, 49, 50, 55, 56
antenna
location 17
removal 104, 105
spare part numbers 42, 55,
60, 64, 105
Antenna Kit, spare part numbers
42, 55, 60, 105
audio, product description 6
audio-in jack 25
audio-out jack 25
B
base enclosure, spare part
numbers 38, 54, 58
battery
removal 73
spare part numbers 38, 49,
73
battery light 23
bottom components 26
button components 19
buttons
pointing stick 22
power 19
TouchPad 22
TouchPad on/off 22
volume mute 19
wireless 19
C
cables, service considerations 66
caps lock light 21
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card reader board
removal 108
spare part number 34, 55,
108
carrying case, spare part
numbers 46, 48, 49, 50
chipset, product description 1
components
bottom 26
buttons 19
display 17
fingerprint reader 19
front 23
keys 20
left side 24
lights 21
right side 25
TouchPad 22
computer
major components 29
specifications 147
connectors, service
considerations 66
D
DC cable, spare part number 46,
48
display assembly
removal 98
spare part numbers 30, 41,
58, 98
display bezel
removal 100
spare part numbers 41, 53,
59, 60, 100
display components 17
display enclosure, spare part
numbers 42, 55, 60

Display Hinge Kit, spare part
numbers 42, 53, 60, 104
display panel
product description 3
removal 101
spare part numbers 42, 50,
58, 63, 102
display panel cable
removal 103
spare part number 42, 50,
103
Display Panel Support Kit, spare
part numbers 42, 50, 60
DisplayPort 25
DisplayPort-to-HDMI cable, spare
part number 46, 48
docking port 25
docking station, spare part
number 46, 55
docking, product description 9
drives, preventing damage 66
E
electrostatic discharge 67
embedded numeric keypad 20
equipment guidelines 69
esc key 20
Ethernet, product description 7
external expansion, product
description 8
external VGA monitor port 24
F
fan

removal 113
spare part numbers 38, 53,
64, 113

Index

177

fingerprint reader
component 19
location 19
fingerprint reader board
removal 121
spare part number 34, 54,
121
flash cache, product description 4
fn key 20
front components 23
function keys 20
G
graphics, product description
grounding guidelines 67
guidelines
equipment 69
grounding 67
packaging 68
transporting 68
workstation 68

3

H
hard drive
precautions 66
product description 5
removal 75
spare part numbers 38, 44,
48, 49, 55, 58, 63, 75
hard drive bracket
illustrated 45
removal 76
hard drive connector adapter
illustrated 45
removal 77
Hard Drive Hardware Kit
contents 45
spare part number 45, 50
hard drive light 23
headphone jack 25
heat sink
removal 111
spare part numbers 38, 54,
58, 111
hinge
removal 104
spare part numbers 42, 53,
60, 104
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Index

HP DisplayPort-to-HDMI 1.4
adapter, spare part number 46,
56
I
internal display switch 18
J
jacks
audio-in 25
audio-out 25
headphone 25
microphone 25
network 25
RJ-45 25
K
key components 20
keyboard
product description 9
removal 85
spare part numbers 30, 31,
32, 33, 50, 51, 52, 53, 60,
61, 62, 63, 85
keys
esc 20
fn 20
function 20
num lk 20
Windows logo 20
L
left-side components 24
light components 21
lights
AC adapter 23
battery 23
caps lock 21
hard drive 23
microphone mute 21
mute 21
num lock 21
power 21, 23
webcama 17
wireless 21, 23
lock, spare part numbers 46, 48,
49
LTE antenna, spare part number
64

M
mass storage devices
illustrated 44
precautions 66
spare part numbers 44
memory card reader 25
memory module
product description 4
removal 84
spare part numbers 39, 49,
84
microphone
location 17
product description 6
microphone jack 25
microphone module
removal 102
spare part number 42, 55,
103
microphone mute light 21
MiniCard solid-state drive, product
description 4
model name 1
mouse, spare part numbers 46,
48, 49
mute light 21
N
network jack 25
num lk key 20
num lock light 21
numeric keypad 20
O
operating system, product
description 11
P
packaging guidelines 68
plastic parts, service
considerations 65
Plastics Kit
components 43
spare part number 43, 55
pointing device, product
description 9
pointing stick 22
pointing stick button 22
ports
DisplayPort 25
docking 25
ENWW

external VGA monitor 24
product description 9
USB 3.0 25
USB 3.0 charging 24
power button 19
power button board
removal 124
spare part number 34, 54,
124
power connector 25
power cord
set requirements 173
spare part numbers 46, 47,
48, 56, 57, 58
power light 21, 23
power requirements, product
description 10
processor, product description 2
product description
audio 6
chipset 1
display panel 3
docking 9
Ethernet 7
external expansion 8
flash cache 4
graphics 3
hard drive 5
keyboard 9
memory module 4
microphone 6
MiniCard solid-state drive 4
operating system 11
pointing device 9
ports 9
power requirements 10
primary storage 5
processor 2
product name 1
security 10
serviceability 15
solid-state drive 5
video 6
wireless networking 7
product name 1
R
removal/replacement
procedures 71, 93
right-side components 25
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RJ-45 jack 25
RTC battery
removal 93
spare part number 34, 49, 93
Rubber Kit, spare part number
38, 53
S
Screw Kit, spare part number 47,
54
security cable slot 24
security, product description 10
service considerations
cables 66
connectors 66
plastic parts 65
service cover
location 26
removal 71
spare part numbers 40, 55,
56, 58, 59, 71
service cover release latch 26
serviceability, product description
15
SIM, spare part number 46, 49
smart card reader 24
solid-state drive
precautions 66
product description 5
removal 80
spare part numbers 39, 45,
55, 56, 58, 59, 63, 80
speaker assembly
removal 122
spare part number 34, 54,
122
speakers, location 19
specifications 147
system board
removal 115
spare part numbers 34, 54,
55, 56, 57, 58, 59, 63, 64,
115
T
tools required 65
top cover
removal 94
spare part numbers 34, 53,
64, 94

TouchPad
removal 107
spare part number 37, 53,
107
TouchPad button 22
TouchPad components 22
TouchPad on/off button 22
TouchPad zone 22
transporting guidelines 68
U
USB 3.0 charging port 24
USB 3.0 port 25
USB 3.0 port replicator, spare part
number 47, 49
USB 3.0 type A connector to type B
connector cable, spare part
number 49
V
vents 24, 26
video, product description 6
volume mute button 19
W
webcam light 17
webcam, location 18
webcam/microphone module
removal 102
spare part numbers 42, 53,
64, 103
Windows logo key 20
wireless antenna
location 17
removal 104, 105
spare part numbers 42, 55,
60, 105
wireless button 19
wireless light 21, 23
wireless networking, product
description 7
WLAN module
removal 82
spare part numbers 39, 48,
49, 50, 55, 56, 82
workstation guidelines 68
WWAN module
removal 78
spare part numbers 38, 49,
50, 56, 78
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